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Цифровая фотография как хобби

В ГОМ, ЧТО НА РЫНКЕ ЛЮБИТЕЛЬСКОЙ ФОТОТЕХНИКИ ПР

ВРЕМЕНИ СТАНУТ ПОЛНОСТЬЮ ЦИФРОВЫМИ, НИКАКИХ С

ТЕХНИЧЕСКИМИ, ТАК И ЭКОНОМИЧЕСКИМИ ПРИЧИНАМИ

Экономика
пленочная
и цифровая

Технология
пленочная
и цифровая

Диспозиция
цифровых
камер

в магазин фототехники:
одних стендах богатый выбор

пленочных фотокамер, на других —
обширная коллекция цифровых аппа-
ратов. Сегодня производители готовы
удовлетворить любые запросы фото-
любителя. Проблема выбора «цифры
или пленки» встает перед каждым
человеком, решившим посвятить часть
свободного времени фотографии. Как
сформулировать свои потребности и
подобрать камеру, отвечающую им
наилучшим образом? Прежде всего,
надо понимать, что выбор пленочной
или цифровой аппаратуры опреде-
ляет методы работы с фотографией с
того момента, как вы нажали кнопку
спуска затвора. До этого существен-
ной разницы в съемке на пленку и
«цифру» нет.

Принципиальные различия начина-
ются после того, как свет из объектива
попал внутрь фотокамеры. Пленочная
фотография опирается в основном
на химические процессы, а цифро-
вая — на физические. Химическими
процессами невозможно управлять с
высокой точностью, поэтому резуль-

тат плохо предсказуем. А самое глав-
ное — качество фотографии нельзя
оценить до завершения длительного
химического процесса.

Изображение, представленное
на пленке кристаллами галогенида
серебра, проходит длинную цепоч-
ку обработки. Сначала пленку про-
являют в сложных растворах, затем
кадры экспонируют на фотобумагу.
Экспонированное изображение про-
являют и закрепляют. Наконец высу-
шенный отпечаток предстает перед
глазами заказчика. Глядя на снимок,
фотограф понимает, что следовало
бы изменить при съемке, но поздно:
«иных уж нет, а те далече».

Цифровое изображение экспониру-
ется, «проявляется» и «закрепляется»
мгновенно. Физические параметры
цифрового изображения регулируют-
ся с высокой точностью, удобны для
формализации и обработки. Фотограф
сразу оценивает результат съемки и
тут же вносит изменения. Обратная
связь в реальном масштабе времени
способствует быстрому накоплению
опыта и повышению мастерства.

Аналоговый фотопроцесс

Съемка Проявление пленки Экспонирование,
проявление,закрепление



Экономика пленочная и цифровая

Стоимость фотоаппарата
Пока разница в цене между пленочными

и цифровыми камерами одного класса очень
весома. Яркий тому пример — модели, постро-
енные на базе одного корпуса (Body). Средняя
цена комплекта зеркальной пленочной камеры
Canon EOS 300 Kit около 500$. Средняя цена
цифрового комплекта Canon EOS 300D Kit —
около 900$. Казалось бы, такой ценовый разрыв
однозначно перевесит любые преимущества
цифровой камеры. Но так думают далеко не
все. Многие люди ценят свой комфорт и удоб-
ства очень высоко.

Два представителя одной линии

Пленочная камера Canon EOS 300X

шшшшшшшшшт
Цифровая камера Canon EOS 300D

Например, владелец цифровой камеры уже на
пути из магазина может отснять целый репор-
таж, а по приходу домой сразу увидеть резуль-
тат своих трудов. И в любых других рабочих
ситуациях оперативность работы с цифровой
камерой будет несравнимо выше. Стоит ли это
преимущество денег, запрашиваемых произ-
водителем, решать покупателю. Пока запишем
400$ как дополнительную плату за оператив-
ность процесса цифровой съемки.

Стоимость пленки (носителя)
Цена кассеты универсальной цветной

обратимой пленки — около 2$ за 36 кадров
(6 центов за кадр). Качество отпечатка с такой
пленки при типовом проявочном процессе (про-
явка в экспресс-лаборатории) — весьма среднее.
Чтобы получить качество не хуже цифрового
снимка в «сыром» формате RAW, потребуется
профессиональная пленка стоимостью в сред-
нем 8$ за 36 кадров (22 цента за кадр).

Цифровые снимки тоже надо куда-то запи-
сывать. Если рассчитывать на носитель, вме-
щающий 35~40 кадров формата RAW, его сто-
имость окажется равной примерно 40$. Но
такой носитель используется многократно, и
в итоге цена в расчете на один кадр пренебре-
жимо мала. Стоимость CD-R емкостью свыше

Обратимая цветная пленка —основной и постоянный расходный
материал аналоговой фотографии



100 кадров формата RAW (для хранения архи-
ва, аналогично хранению пленки) составляет
1$ (в среднем 1 цент на кадр). Заметим, что, в
отличие от пленки, снимки на CD не выцветают,
не пылятся, не боятся царапин. Сколько стоит
такое преимущество? Каждый пользователь
может оценить его по-своему. Мы считаем,
что стоимость записи и хранения цифровых
снимков практически нулевая.

Эмпирически можно вывести примерно такое
соотношение: каждый кадр, снятый пленочной
камерой, увеличивает расходы владельца на
10 центов. И наоборот, каждый кадр, снятый
цифровой камерой, экономит для владельца
примерно те же 10 центов. Отсюда простой
вывод: чем больше вы снимаете, тем убеди-
тельней выглядят экономические преиму-
щества цифровой камеры. Реально ощущать
экономию пользователь начинает при объемах
съемки около 1000 кадров в год.

Стоимость обработки и печати
«Пленочники» в массе своей вынуждены

сдавать пленку в пункты приема для проявки
и печати ВСЕХ получившихся кадров, чтобы
иметь возможность отобрать действительно
нужные. Если же со снимком надо проделать
даже простейшую операцию, вроде кадрирова-
ния, работу приходится заказывать отдельно,
причем зачастую специально ехать для этого
в фотосалоны (фотолаборатории), оказываю-

Типовое место массового паломничества фотолюбителей

щие такие услуги. Заверяем читателей, что
стоимость всего пяти-шести работ професси-
онального уровня для отпечатков выставоч-
ного размера (30x40 см) перекроет разницу
в цене между пленочным и цифровым фото-
аппаратами.

Отбор — основа творчества
«Цифровик» позволяет избежать сплош-

ной проявки и распечатки. Владелец комплек-
та «компьютер + цифровая камера» может сам
проделать со снимком что угодно. Но главное
преимущество — это интерактивная выбор-
ка снимков. Как показывает практика, дей-
ствительно достоин распечатки один снимок
из сотни.

Поэтому у «пленочника» при прочих равных
условиях фотоальбом забит большей частью
мусором, у «цифровика» — сравнительно при-
личными снимками. Запишем цифровой фото-
графии в плюс примерно 15$, сэкономленных
на каждой сотне снимков за счет исключения
ВЫНУЖДЕННОЙ проявки пленки и сплош-
ной распечатки. Между прочим, при годовом
объеме 1000 снимков это дает экономию при-
мерно 150$.

В сухом остатке наших рассуждений и рас-
четов остаются следующие выводы.
1. Тот, кто снимает мало, в основном типо-

вые сюжеты, распечатывает снимки
совсем редко и только «домашнего» фор-
мата 10x15, тот, кому не нужно выставоч-
ное качество отпечатков, может не торо-
питься с переходом на цифровые
технологии.

2. Тот, кто снимает много, иногда заказыва-
ет печать большого формата, стремится к
высокому качеству, кому важна опера-
тивность съемки, упорядоченность фото-
архива, кто не чужд компьютерных тех-
нологий, готов платить за комфорт и
удобства, тот альтернативы цифровым
технологиям не найдет.

3. Тот, кто зарабатывает деньги фотографи-
ей, занимается разными жанрами съемки,
тому нужна и пленочная, и цифровая
камеры — ничего не попишешь, этого тре-
бует профессиональный подход к делу.



Технология пленочная и цифровая

Для человека, владеющего методами обра-
ботки цифрового изображения, не важно,

каким способом оно получено: сканировани-
ем негатива или непосредственно с матрицы
цифровой камеры. В любом случае он сможет
работать с таким изображением с эффектив-
ностью, которая и не снилась в аналоговую
эпоху. А главное — работать сам, не прибегая
к услугам профессионалов.

Полный контроль над содержимым домаш-
него фотоархива, его наглядное представление,
полное управление параметрами снимков —
вот основные преимущества цифровой фото-
графии. Если нет желания иметь собствен-
ный принтер, можно заказать печать снимков
в мини-фотолаборатории (минилабе). Кстати,
и свой фотоархив можно хранить на сервере
фотосалона.

Развитие технологий массовой цветной фото-
графии, автоматизация процессов проявки
пленки и печати снимков практически свели к
нулю ранее широко развитое фотолюбитель-
ство, то есть возможность собственноручной
коррекции и печати фотографий. Эта пробле-
ма хорошо знакома всем, кто ставит целью не
только простую регистрацию действительно-
сти, а творчество.

Поэтому энтузиасты фотодела вынуждены
использовать альтернативный процесс: скани-
ровать снимки и обрабатывать их на домашнем
компьютере. Но цена комплекта из пленочной
камеры Nikon F80, сканера Nikon CoolScan
4000ED и нескольких десятков роликов плен-
ки вполне сопоставима по цене с зеркальной
цифровой камерой Nikon D100.

Сравнение «пленочных» и цифровых техно-
логий по основным техническим параметрам
показывает нарастающее преимущество циф-
ровых методов регистрации изображений.

Детализация
При одинаковой площади цифровой матри-

цы и пленочного кадра однозначное превосход-
ство по детализации будет у снимков, полу-
ченных с помощью цифровой камеры. По мере
внедрения матриц большой емкости (22 мил-

лиона пикселов и более) это преимущество
становится подавляющим. При этом шумы,
вызванные зернистостью пленки, многократно
превосходят шумы матрицы, что также отри-
цательно сказывается на детализации.

В некоторых достаточно редких случаях
пленочные снимки действительно содержат
детали, которые не может передать цифро-
вая камера. Однако по большей части пле-
ночные кадры дают лишь иллюзию наличия
дополнительных деталей за счет шумов гра-
нулярности.

И наконец, не следует забывать, что хими-
ческие пленочные технологии принципиально
не развиваются уже много лет. Цифровые тех-
нологии регистрации изображений находят-
ся в начале технологического пути развития.
Недалек день, когда цифровая матрица пре-
взойдет пленку многократно.

Фотоширота
Фотоширота универсальных пленочных

материалов на практике меньше, чем у совре-
менных цифровых камер. Однако у негативной
пленки есть достаточно протяженный нелиней-
ный участок в светлых тонах, что позволяет ей
более правдоподобно передавать яркие участ-
ки сцены. По цветопередаче однозначно лиди-
руют цифровые камеры благодаря линейности
характеристической кривой во всех каналах,
что позволяет более точно передать цвет как
в светах, так и в тенях.

Функциональность
Одно их главных достоинств цифрово-

го аппарата заключается в том, что он пере-
крывает полный диапазон чувствительности
любой пленки. В цифровой фотографии при
обработке можно получить изображение прак-
тически не хуже, чем на любой фотопленке.
Проблемы пыли, грязи, царапин на пленке
неведомы владельцу цифровой камеры. Кроме
того, негативы и слайды требуют бережно-
го хранения и существуют в единственном
экземпляре. Цифровой фотоархив избавлен
от этих недостатков.



Диспозиция цифровых камер

Та рынке цифровых камер покупателям
.X предлагаются сотни моделей. Чтобы не

потеряться в этом изобилии, приходится как-
то различать фотокамеры, то есть каким-то
образом определять их позиции в ряду дру-
гих моделей. Эта задача необычайно сложна
в силу того, что в фотографии, объединяю-
щей искусство и технику, существует множе-
ство неформализованных критериев оценки,
многозначность понятий и суждений. Кроме
того, фотография удовлетворяет творческие
потребности людей.

Первое
Чрезвычайно многогранны объекты съем-

ки: портрет, пейзаж, архитектура, животные,
микрообъекты, интерьер, промзона, закат и так
далее. Насколько удивителен и непредсказу-
ем реальный мир, настолько непредсказуемы
возможные объекты съемки.

Второе
Весьма заметно различаются требова-

ния к видам фотографии. Для художественной
съемки очень важно как снято. Для репортаж-
ной съемки на первый план выходит критерий
что и когда снято. Для массового любительского
фото главное — запечатлеть ситуацию («здесь
был Вася»), то есть важно что (кто) и где сфо-
тографировано. Для макросъемки успех ком-
позиции определяется тем, что и как зафик-
сировал аппарат.

Третье
Требования к техническому качеству у

каждого человека свои. Один фотограф обра-
щает внимание на детализацию, чтобы были
четко видны «каждая травинка, каждый воло-
сок». Другой фотограф во главу угла ставит
правильный цвет. Третий не терпит геометри-
ческих искажений и хроматических аберра-
ций. Четвертый сосредоточен на управлении
глубиной резкости. Удовлетворить все требо-
вания ОДНОВРЕМЕННО не способен ни один
фотоаппарат. Конечно, «лучше быть богатым
и здоровым», но в жизни так не получается.

Четвертое
Представление об удобстве и функци-

ональности камеры формируется на основе
личных предпочтений и опыта работы, и лишь
затем принимаются во внимание ее технические
возможности. Список требований к основным
функциям фотоаппарата достаточно широк:
• оперативный контроль результата съем-

ки;
• кадрирование за счет оптики (масштаби-

рование);
• скорость работы системы автоматической

фокусировки;
• запись изображения в различных форма-

тах, в том числе RAW;
• точность замера системы автоматическо-

го определения экспозиции;
• наличие средств коррекции баланса бело-

го цвета, контраста, резкости, цветового
пространства;

• средства управления диафрагмой,
выдержкой, фокусом вручную;

• скорость съемки нескольких кадров под-
ряд;

• удобство ношения и применения;
• возможность смены оптики, карт памяти,

программного обеспечения;
• длительность работы от аккумуляторов;
• надежность, пылевлагозащищенность.

Пятое
Цена или соотношение цена/качество

не только аппарата, но и всех сопутствующих
товаров, обеспечивающих полный цикл от
съемки до печати. Нередко здесь играет весо-
мую роль имидж производителя.

Среди критериев оценки фотокамер можно
выделить формализуемые, частично форма-
лизуемые и не формализуемые в принципе.
Например, резкость фотокамеры достаточ-
но точно оценивается по частотно-контраст-
ной характеристике. Но точность цветопере-
дачи — понятие субъективное, лежащее на
безразмерной шкале «лучше — хуже». Такой
параметр, как глубина резкости, вообще невоз-
можно оценить формально. В одних случаях
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(например, при макросъемке) большая глубина
резкости — благо. В других случаях (напри-
мер, в портретной съемке) требуется малая
глубина резкости.

Вывод из наших рассуждений таков: не
стоит искать лучший фотоаппарат, следует
выбирать камеру, оптимальную для решения
своих задач.

Анализ потребительских и технических
характеристик современных цифровых камер
показывает, что все камеры неявно распреде-
ляются по следующим группам:
1. ультракомпакты (цифровые мыльницы);
2. «классические» компакты;
3. полупрофессиональные (для энтузиа-

стов);
4. профессиональные.

Надо понимать, что границы между груп-
пами весьма относительны. Самые «вкусные»
для потребителя модели надо искать именно на
пограничных рубежах. Есть камеры с прекрас-
ной оптикой и многими функциями полупро-

фессиональных моделей, по цене попадающие
скорее в любительскую, чем в полупрофесси-
ональную группу.

Ситуация в области технических параме-
тров цифровых фотокамер и диапазона цен
непрерывно меняется. То, что сегодня счита-
ется передовым техническим решением, зав-
тра станет достоянием большинства моделей
в данном классе. Или будет найдено лучшее
техническое решение.

В представленной ниже таблице зафик-
сированы характерные параметры цифро-
вых камер (по классам) на момент написа-
ния книги. Не исключено, что завтра границы
некоторых параметров изменятся. Обычно
происходит миграция самых передовых техни-
ческих решений из старшего класса в младший.
Например, постепенно растет емкость цифро-
вых матриц как в младших, так и в старших
классах. Возможно, что вскоре даже встроен-
ные в мобильники фотокамеры будут иметь
емкость 4~5 мегапикселов.

Классификация цифровых камер

Параметры 1 группа 2 группа 3 группа 4 группа

Явные, рекламируемые

Цена, $

Матрица

Типичные
представители

До 300

До 3 мегапикселов

Canon PowerShot A60
Casio EXILIM EX-S20
Nikon Coolpix 2100
Minolta Dimage X20

До 600

3-6 мегапикселов

Canon PowerShot S50
Casio EXILIM EX-Z340
Nikon Coolpix 4300
Minolta Dimage F300

До 1300

5-8 мегапикселов

Canon EOS 300D
Casio Pro EX-P600
Nikon Coolpix D70
Sony DCS-F828

Свыше 1500

6-22 мегапиксела

Canon EOS 1D Mark II
Nikon D100
Kodak DCS 14
Pentax *ist D

Технические

Оптика

Типоразмер сенсора

Размер пиксела

Чувствительность, ISO

Видоискатель

Формат файлов

Режимы съемки

Постоянный фокус
и Zoom Зх

1/3,6-1/2,7

2-4 мкм

До 400

Оптический

JPEG

Автоматический
и программный

Zoom 3x-8x

1/2,7-1/1,8

2-4 мкм

До 800

Оптический
параллаксный

JPEG, TIFF

+ расширенные
программы, ручной
фокус, приоритет
выдержки, диафрагмы,
предустановка белого

Zoom Зх-12х или
сменная оптика

1/1,8-2/3-4/3

2-8 мкм

До 1600

Оптический
параллаксный,
электронно-оптический,
зеркальный

JPEG, TIFF, RAW

+ ручной баланс белого,
выбор цветового
пространства

Сменная

24x36
(аналог 35 мм пленки)

6-13 мкм

До 3200

Зеркальный,
электронно-оптический

JPEG, TIFF, RAW

+ цветовая
температура,
управление вспышкой,
дистанционное
управление,
программная съемка



Основные параметры цифровой камеры

ЦИФР >А1 ОТ ПЛЕНОЧНОГО ПРИНЦИПИАЛЬНО ОТЛИЧАЕТСЯ ТОЛЬКО ОДНИМ

СПОСОБОМ РЕГИСТРАЦИИ ОПТИЧЕСКОГО ИЗОБРАЖЕНИЯ, СФОРМИРОВАННОГО ОБЪЕКТИВОВ .

ПОЭТОМУ КЛЮЧЕ:ВЫМ I I I ЦИФРОВОЙ КАМЕРЫ СЧИТАЕТСЯ МАТРИЦА

Матрица

Форматы
записи
изображения

Носители
данных

Объективы

Диафрагма

Системы
фокусировки

ифровой фотоаппарат от пленоч-
Л-Д ного принципиально отличается
только одним — способом регистрации
оптического изображения, сформи-
рованного объективом. В пленке свет
воздействует на кристаллы галоид-
ного серебра. В цифровой фотокаме-
ре (ЦФК) свет попадает на фотоди-
оды сенсора.

Вся остальная «обвязка» (фильтры,
процессор, шины, память и тому подоб-
ное) обслуживает матрицу светочув-
ствительных элементов. Важнейшие
параметры пленки (в частности, раз-
мер и чувствительность) стандарти-
зированы. В цифровой фототехнике
процесс стандартизации далек от
завершения, поэтому каждый про-
изводитель волен делать матрицу
по-своему.

Среди разработчиков и произ-
водителей матриц разворачивается
острая конкурентная борьба. Поэтому
параметры матрицы (разрешение,
размер, чувствительность) произ-
водители фотокамер сознательно
выдвигают на первый план.

Фотографы пленочного поколе-
ния хорошо знают выражение «сни-
мает объектив». В нем подчеркива-
ется решающая роль объектива в
получении качественного снимка.
Поскольку цифровая фотокамера
по способу формирования изобра-
жения ничем не отличается от пле-
ночной, логично предположить, что
параметры объектива не менее важ-
ны, чем характеристики матрицы.
Обычно оценивают светосилу, диа-

пазон фокусных расстояний, режи-
мы фокусировки объектива.

Остальные параметры фотоап-
парата вторичны и во многом обу-
словлены характеристиками двух
важнейших компонентов: матрицы
и объектива. К числу давно извест-
ных и обязательно указываемых в
описании параметров относятся спо-
собы замера и управления экспози-
цией, варианты установки цветового
баланса, характеристики видоиска-
теля, фотоспышки, элементов пита-
ния и прочие.

Цифровые камеры имеют особые
элементы конструкции, по которым
их легко опознает любой человек.
Самым заметным компонентом слу-
жит монитор. Его наличие позволяет
видеть картинку, получаемую сенсо-
ром. Модуль памяти необходим для
записи файлов изображений. Во всех
моделях предусмотрен интерфейс
для связи с компьютером.

Если взглянуть на электронную
начинку ЦФК, заметна аналогия с
персональным компьютером: про-
цессор, шины, оперативная и дол-
говременная память, возможность
апгрейда (модернизации) компонен-
тов. В компьютерной технике глав-
ное — сбалансированность всех эле-
ментов. В цифровой фототехнике
правомерен такой же подход: каме-
ра должна быть сбалансирована по
ключевым параметрам. В этом слу-
чае гарантируется высокая эффек-
тивность работы и быстрая окупае-
мость затраченных средств.
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Матрица

Т\ /Гиллионы палочек и колбочек (3,3~7 млн.
XVXколбочек, 75-170 млн. палочек) в орга-
нах зрения человека непрерывно фиксируют
картину окружающего мира. В мозг отправ-
ляется растровое изображение, состоящее
из точек. Такие точки называют пикселами
(Pixel, Picture Cell). Аналогичным способом,
из множества точек, формируют изображе-
ния технические устройства воспроизведе-
ния, в том числе мониторы и принтеры. Общее
число точек в изображении характеризует его
информационную емкость.

Каждая растровая точка имеет свой цвет.
Теоретически возможный диапазон цвета в изо-
бражении принято называть глубиной цвета.

Разрешение, емкость, плотность
Сенсор цифровой фотокамеры состо-

ит из светочувствительных ячеек, образую-
щих прямоугольную матрицу. Каждая ячей-
ка регистрирует один пиксел изображения.
Главный параметр цифрового изображения —
его информационная емкость, определяемая

перемножением числа пикселов, расположен-
ных в строках и столбцах, например 2560x1920.
Информационная емкость такого изображе-
ния около 5 000 000 пикселов. Чтобы не писать
длинные числа, принято указывать емкость в
мегапикселах — 5 Мп.

Зарегистрированное матрицей и записан-
ное в цифровом виде изображение обрабаты-
вается, хранится и передается в безразмерном
виде. Запись содержит сведения о числе пик-
селов, координатах и цвете каждого пиксела.
Физические размеры как важный параметр
изображения появляются только в момент его
воспроизведения: на мониторе, на носителе
(печать) или любым иным способом.

При воспроизведении изображения всегда
встает вопрос: каков его реальный, физический
размер? Ответ зависит от целей публикации.
Если предполагается рассматривать изобра-
жение из космоса, можно каждый пиксел пред-
ставить полотнищем со стороной 100 метров.
В таком случае портрет, сделанный встро-
енной камерой мобильника, будет отлично
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Плотность пикселов

Снимок сделан камерой Canon PowerShot Pro90 IS, емкость
сенсора 2,6 Мп. Изображение слева имеет плотность 300 ppi,
что считается стандартом для «полиграфического» качества.

Изображение справа имеет плотность 72 ppi, что совершенно
недостаточно для печати. Но такая картинка великолепно
смотрится на экране монитора.

смотреться с околоземной орбиты. Для про-
смотра с близкого расстояния пиксел должен
быть поменьше, например для фотографии в
паспорт — совсем миниатюрным.

Очевидно, что при одинаковом числе пик-
селов их размер и плотность на единицу дли-
ны (измеряется в пикселах на дюйм — Pixel
per inch, ppi) напрямую зависят от размера,
выбранного для воспроизведения изображе-
ния. Соответственно, физический размер изо-
бражения прямо пропорционален выбранной
плотности. Увеличивая изображение, мы сни-
жаем плотность пикселов.

На оптимальной для просмотра дистан-
ции (25-30 см), человек различает на бумаге
до 10 отдельных точек на миллиметре, или,
округленно, 250 точек на дюйм. Эмпирическим
путем установлено, что номинальная плот-
ность изображения при печати должна быть
около 300 ppi.

Главным параметром технических устройств
для воспроизведения изображений является
разрешение — способность создать опреде-

ленное число точек на единицу длины. Обычно
разрешение печатающих устройств измеряют
в точках на дюйм (Dots per inch, dpi). Например,
лазерный принтер может иметь разрешение
1200 dpi, а струйный — 2880 dpi.

Зачем увеличивают разрешение устройств
печати свыше 300 dpi? Возьмем принтер с раз-
решением 1200 dpi. При печати каждый пиксел
изображения с плотностью 300 ppi будет вос-
произведен четырьмя точками по горизонтали
и четырьмя по вертикали (то есть, представлен
шестнадцатью точками). Учитывая, что каждая
точка может быть напечатана одним из четы-
рех, шести или даже восьми цветов, появля-
ется возможность очень точно повторить цвет
пиксела исходного изображения.

На экране монитора воспроизведение изо-
бражений происходит иначе. Там фильтром
выступает видеоадаптер компьютера, форми-
рующий информационное поле экрана с задан-
ным размером, например 1600x1200 пикселов,
что дает плотность 96 ppi на типовом 21-дюй-
мовом мониторе. Передавая на экран изобра-
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В технической литературе термин «разрешение»
применяется настолько широко, что требуется дать некоторые
пояснения.

В первоначальном техническом значении разрешение —
это сокращенный термин РАЗРЕШАЮЩАЯ СПОСОБНОСТЬ, то
есть способность органов зрения или оптических устройств
различать два расположенных рядом объекта. Обычно эту
способность измеряют в линиях на миллиметр или в парах
линий на миллиметр.

В компьютерной технике термин часто используют
для характеристики ПЛОТНОСТИ пикселов цифрового
изображения. Например, разрешение 300 ppi означает, что в
одном дюйме линейного размера изображения расположено
300 пикселов.

Другое значение термина «разрешение» (в принципе
верное) — плотность расстановки точек при воспроизведении
изображения устройствами. Например, разрешение лазерного
принтера 1200 dpi.

Принципиально неверно использовать термин для
характеристики размеров. Тем не менее, в литературе часто
используют выражения вроде «разрешение экрана».

Свои значения термина «изобрели» продавцы цифровой
фототехники. Они под разрешением понимают:

а) общее количество пикселов в матрице;
б) число пикселов в матрице по горизонтали и вертикали.
На самом деле это:
а) информационная емкость;
б) способ представления информационной емкости.

жение, адаптер преобразует пикселы снимка в
пикселы экрана с плотностью, которую имеет
информационное поле.

В некоторых моделях дешевых цифровых
фотокамер для увеличения емкости изобра-
жения используют метод интерполяции, когда
каждый пиксел обретает соседа-клона (такой
метод называют «цифровым зумом»). При этом
сенсор никакой новой информации не регистри-
рует, объективность и достоверность изображе-
ния ухудшаются. Это противоречит основной
цели фотографии — регистрировать объек-
тивную реальность, поэтому применять эту
технологию не рекомендуется.

Чем больше информационная емкость матри-
цы, тем лучше детализация изображения. Чем
выше плотность изображения, тем лучше его
восприятие. Чем больше разрешение устрой-
ства, тем более качественную картинку оно
способно воспроизвести.

(С ПЛОТНОСТЬ ВАЖНА ДЛЯ ГЕОМЕТРИИ СНИМКА. |

I РАЗРЕШЕНИЕ — ДЛЯ ТОНОВОГО ДИАПАЗОНА

Размер имеет значение
Известно, что чем больше площадь при-

емника светового излучения, тем больше света
он собирает, тем больше информации попадет
в кадр. В пленочной фотографии необходимым
и достаточным традиционно считается размер
кадра 35-мм пленки (36x24 мм). Информации,
собранной с такой площади, хватает для вос-
произведения изображения с шестнадцати-
кратным увеличением. В цифровой фотографии
матрицы аналогичного размера пока редки.

Типоразмер
Среди цифровых фотоаппаратов есть

модели, размер матрицы которых аналоги-
чен кадру 35-мм пленки. Однако пока такие
образцы дороги и применяются в профессио-
нальной сфере. Более дешевые матрицы име-
ют меньшую площадь и устанавливаются в
камеры полупрофессионального и компакт-
ного класса.

С размером матрицы тесно связано фокусное
расстояние объектива. Поэтому потребовалось
как-то стандартизировать размеры сенсоров,
чтобы не конструировать свой объектив для
каждой матрицы. Для этого воспользовались
довольно запутанной системой типоразме-
ров, пришедшей из видеотехники. Подробно
разбирать ее не имеет смысла, но оценивать
соотношение площадей различных сенсоров
необходимо. Принцип оценки очень прост: чем
больше площадь сенсора, тем лучше.

Параметры типовых матриц

Типоразмер

1/3,6"

1/3,2"

1/2,7"

1/2"

1/1,8"

2/3"

1"

4/3"

APS-C

35 мм

Ширина, мм

4

4,536

5,27

6,4

7,176

8,8

12,8

18

25,1

36

Высота, мм

3

3,416

3,96

4,8

5,319

6,6

9,6

13,5

16,7

24

Площадь, мм2

12

15,5

20,9

30,7

38,2

58,1

122,9

243

419,2

864
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Размер ячейки
Размер матрицы, ее емкость и размер

ячейки тесно связаны между собой. Очевидно,
что увеличение емкости при неизменном раз-
мере матрицы приведет к уменьшению разме-
ра одной ячейки. Казалось бы, что в этом нет
ничего страшного, наоборот, маленькие ячей-
ки обеспечат лучшую резкость изображения.
Но не все так просто.

На маленькую ячейку попадает меньше све-
та, ее способность преобразовывать световую
энергию в электрическую падает, растут шумы,
что не лучшим образом сказывается на чув-
ствительности. Эмпирически установлено, что
оптимальный размер ячейки находится в диа-
пазоне 6-9 микрон. Если ячейка меньше, воз-
никают проблемы с чувствительностью, если
больше — становится заметной ступенчатость
контрастных границ в изображении.

Примеры типовых матриц

Модель ЦФК

Canon PowerShot A70

Olympus C-5000 Zoom

Nikon Coolpix 5700

SonyDCS-F828

Olympus E-1

Pentax *istD

Kodak DCS Pro 14n

Типоразмер
матрицы

1/2,7"

1/1,8"

2/3"

2/3"

4/3"

APS-C

35 мм

Емкость,
Mn

3,2

5

4,92

8

5

6

13,7

Размер
ячейки, мкм

2,6

2,8

3,4

2,3

6,8

7,8

7,9

Маленькие (меньше 5 микрон) ячейки боль-
шинства матриц фотокамер ультракомпактного
и компактного класса не позволяют получить
высокую чувствительность, поэтому возника-
ют проблемы со съемкой в сумерках, в лесу, в
помещениях. Обычно недостаток чувствитель-
ности компенсируется использованием встро-
енной вспышки.

| Q | Соотношение сторон
Стандартным в фотографии считается

соотношение сторон кадра по ширине и высоте
4:3. Большинство матриц отвечают этому тре-
бованию, но встречаются образцы с соотноше-
нием сторон 3:2 (в камерах компактного класса)
и 16:9 (в специализированных камерах).

Чувствительность и шумы
Теоретически, светочувствительный эле-

мент матрицы способен регистрировать еди-
ничный фотон света. На практике это далеко
не так, поскольку в ячейках всегда присут-
ствуют собственные электрические шумы.
Для каждой матрицы существует некий порог
чувствительности, ниже которого информа-
цию выделить из шума нельзя. Повышение
чувствительности неизбежно приводит к уве-
личению доли шума в регистрируемом опти-
ческом изображении.

В общем случае, чем меньше размер ячейки
матрицы, тем больше уровень шумов и ниже
чувствительность. Однако применение одной и
той же модели матрицы в разных фотокамерах
совершенно не гарантирует одинаковую чув-
ствительность. Дело в том, что уровень шумов
на реальном снимке также зависит от мето-
дов обработки изображения внутри камеры.
Если усреднить типичные значения реальных
шумов для разных аппаратов и привести их
к приемлемому уровню (любительское каче-
ство), можно получить ориентировочные зна-
чения «стандартной» чувствительности матриц
одного типоразмера. В конкретных моделях
ЦФК чувствительность может отличаться от
стандартной на 20-30%, как в большую, так и
в меньшую сторону.

Измерение чувствительности в единицах
ISO цифровая фотография унаследовала от
химической. В цифровой фототехнике исполь-
зуют индекс ISO (ISO Speed Rating), который
можно выбрать в меню. Надо понимать, что
если выбранное значение чувствительности
превышает стандартное значение для данно-
го типоразмера матрицы, на снимке появятся

Чувствительность типовых матриц

Типоразмер матрицы

1/2,7" и менее

1/1,8"

2/3"

4/3"

APS-C

35 мм

Чувствительность при
сопоставимом уровне шумов

50 ISO

100 ISO

150 ISO

400 ISO

600 ISO

800 ISO
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Сравнение уровня шумов

Снимок сделан фотокамерой
Olympus C40Z. Установка ISO 100

паразитные шумы. Только от совести произ-
водителя зависит, при каком уровне шума он
посчитал чувствительность приемлемой. Одна
камера на установке ISO 100 может «шуметь»
так же, как другая камера на ISO 400. При про-
чих равных условиях меньше предрасположе-
ны к шумам большие матрицы (по геометри-
ческим размерам, а не мегапикселам).

Фотографическая широта
Фотографическая широта (Ev) характе-

ризует способность фотоприемника регистри-
ровать с одинаковой степенью контраста раз-
личия в яркостях объекта. Фотографическая
широта описывается диапазоном экспозиций,
в котором достигается пропорциональное вос-
произведение тонов. В общем случае счита-
ется, что фотоприемники тем качественнее,
чем большей фотографической широтой они
обладают.

В цифровой технике принято измерять диа-
пазон значений в логарифмическом масштабе,
где двукратная разница в яркости имеет одну и
ту же линейную величину, независимо от абсо-
лютного уровня сигнала. Разница между мак-
симальным и минимальным регистрируемым
значением яркости называется динамическим
диапазоном (Dm a x - D m i n = D). Динамический
диапазон связан с фотографической широтой
следующими соотношениями:

Ev = 3,32D\ D = 0,301Ev.

Например, сенсор камеры Kodak 14n обла-
дает динамическим диапазоном D = 3,26. При
пересчете в экспозиционные зоны фотографи-
ческая широта матрицы составляет 10,8 Ev. Это
выдающийся, но далеко не лучший результат
среди цифровых камер. В частности, матрица
камеры Canon D60 имеет фотографическую
широту 11,5 Ev (D = 3,5). Матрицы камер ком-
пактного класса по фотографической широте
примерно соответствуют цветной пленке.

Для сравнения приведем параметры материа-
лов химического фотопроцесса. Фотографическая
широта цветной негативной пленки составляет
около б экспозиционных зон (D = 1,8), черно-
белой негативной пленки — до 8 Ev (D = 2,5).
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Форматы записи изображения

Важность выбора формата записи снимков и
подходящего носителя для хранения фай-

лов обычно познается на практике. Особенно
когда на третий день отпуска оказываешься
один на один с заполненной карточкой памяти,
а снимки сбросить некуда. Или по возвраще-
нии домой сталкиваешься с проблемой печати
сильно «пожатых» JPEG-фотографий.

Для большинства владельцев цифровых
камер свойства носителя и поддерживаемые
форматы файлов — второй по значимости пара-
метр после емкости матрицы. Ведь возможность
выбора оптики появляется только у счастли-
вых обладателей цифровых зеркальных камер,
а снимающие «цифрокомпактом» вынуждены
работать с тем объективом, который устано-
вил производитель.

Три кита: JPEG, TIFF, RAW
Практически все цифровые камеры име-

ют возможность записи изображения в фор-
мате JPEG, многие модели — в формате TIFF,
а «продвинутые» компакты и камеры более
высокого класса позволяют записывать в фор-
мате RAW. Зачем использовать в цифровой
фотографии три формата записи изображе-
ний? Это обусловлено как историческими, так
и техническими причинами.

ВСЕ ЦИФРОВЫЕ КАМЕРЫ СНИМАЮТ В ФОРМАТЕ

RAW. НО НЕ ВСЕ «ВЫДАЮТ» РЕЗУЛЬТАТ НАРУЖУ

L°J Формат JPEG
Формат JPEG (Joint Photographic Expert

Group) был разработан задолго до появления
первых цифровых фотокамер. Он оптимизи-
рован для передачи изображений по каналам
связи и публикации их в Интернете. Поэтому
основное внимание уделяется компактности
файлов, пусть даже за счет потери некоторой
части исходной информации. Формат преду-
сматривает такие алгоритмы обработки, что-
бы сохранялась львиная доля информации о
яркости пикселов. Цвет вычисляется на основе
урезанных (цветоразностных) данных. Поэтому

в формате JPEG изображение записывает-
ся с существенными потерями цвета и менее
заметными потерями яркости и контраста.
Критичность таких потерь зависит от многих
факторов, в том числе:

• задач фотосъемки;
• выбранной степени сжатия;
• личных предпочтений зрителя.
Как известно, задачи фотосъемки могут

варьироваться в очень широких пределах.
Грубо говоря: от увековечивания себя, люби-
мого, на фоне достопримечательности (совре-
менный, экологически чистый вариант над-
писи «здесь был Вася»), до студийной съемки
на обложку глянцевого журнала. Понятно, что
в здравом уме никто не пишет файлы JPEG
в студийной сессии. Но и «Вася» отнюдь не
идиот, чтобы записывать отпускные кадры в
формате RAW. В целом формат JPEG обеспе-
чивает достаточное качество («любительского»
уровня) для просмотра снимков на мониторе,
публикации в Интернете, распечатки до раз-
мера А4 включительно. На отпечатках боль-
шего размера становятся заметны артефакты
(погрешности), обусловленные сжатием. Как
бороться с такими артефактами, рассказано
в нашей книге «Секреты цифрового фото».

Блочность

Типичные проблемы JPEG

Искажение цвета Потеря деталей

Ореолы

Диетологи утверждают, что «петербургер» (на
снимке) вкуснее и полезнее «гамбургера»
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Если применение формата JPEG оправда-
но задачами съемки, следует подобрать опти-
мальные параметры упаковки изображения.
Как правило, в меню фотокамеры предлага-
ется несколько вариантов сжатия. Примеры
соотношения степени сжатия и размера фай-
ла приведены в таблице.

Типичные параметры записи снимка в формате JPEG

Режим записи

Высокое качество
(Fine)

Стандартное
качество (Standard)

Экономическое
качество (Economy)

Примерная
степень
сжатия

1:4-1:5

1:8-1:13

1:16-1:26

Емкость
матрицы,
Мп

4

6

4

6

4

6

Примерный
размер файла,
Мбайт

2-2,4

2,1-2,6

1-1,5

1,2-1,6

0,5-0,7

0,6-0,8

Оценка качества JPEG-снимков опирает-
ся на весьма субъективные критерии. Одному
человеку нравятся резкие, контрастные, насы-
щенные изображения, которые «удобны» для
кодирования в JPEG. Другие, наоборот, ценят в
фотографии мягкость, плавность тоновых пере-
ходов, верную цветопередачу. К сожалению,
алгоритм JPEG плохо справляется с такими
изображениями, внося цветовые искажения
и загрубляя тоновые переходы.

Формат TIFF
Формат TIFF (Tagged linage File Format)

широко используется в компьютерной графике.
Он позволяет сохранять изображения с боль-
шой глубиной цвета (до 48 бит), без потерь дан-
ных о яркости и цвете. Внутри файла данные
упаковываются широко известными обрати-
мыми алгоритмами сжатия, что позволяет пол-
ностью сохранять графическую информацию.
Такой «щепетильный» подход к адекватности
данных имеет и негативные стороны, в первую
очередь сравнительно большой размер фай-
лов TIFF. С позиции цифровой фотографии это
существенный недостаток, поскольку емкость
сменных носителей пока на два порядка мень-
ше, чем жестких дисков компьютера.

В цифровой камере запись в формат TIFF
отличается от записи в формате JPEG лишь

I ФОРМАТ TIFF НУЖЕН ЦИФРОВОЙ ФОТОГРАФИИ

НЕ БОЛЬШЕ, ЧЕМ ПОВАР «МАКДОНАЛДСУ»

последним этапом, когда обработанное про-
цессором изображение кодируется в файл. До
этого данные проходят абсолютно одинаковый
путь, включающий интерполяцию цвета, цве-
токоррекцию, повышение резкости, преобра-
зование в 24-битный формат представления
цвета. Поэтому на реальных задачах в 99%
случаев разницу в качестве снимка, записан-
ного в форматах TIFF и JPEG (при невысокой
степени сжатия), можно не принимать во вни-
мание. Скажем больше: на фотографиях, сде-
ланных компактной камерой, такую разницу
вряд ли заметит даже эксперт.

Определите формат

Попробуйте определить, в каком формате

записаны снимки

(ipg>i 9UZ) ddll :мо1лмнэ иинжин
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Формат RAW
Формат RAW («сырой», в переводе с англий-

ского) является родным для цифровой фото-
техники. Запись в этом формате представляет
собой массив данных о яркости, зарегистриро-
ванных элементами матрицы. Пиксельная карта
яркостей формируется в любой цифровой каме-
ре — от ультракомпакта до профессионально-
го аппарата. Ключевыми параметрами такого
массива служат размер (в пикселах) и глуби-
на оцифровки (в битах), которые определяют
информационную емкость изображения.

ФОТОГРАФИИ ВЫСОКОГО КАЧЕСТВА

ЗАПИСЫВАЙТЕ В ФОРМАТЕ RAW И

ОБРАБАТЫВАЙТЕ НА КОМПЬЮТЕРЕ

Глубина оцифровки зависит от параметров
установленного в камере аналого-цифрово-
го преобразователя (АЦП). В массиве RAW
уровень тона пиксела прямо пропорционален
интенсивности светового потока. Изменение
экспозиции на одну ступень изменяет вдвое
уровень тона пиксела. Поэтому половина всех
зарегистрированных уровней находится в самой
яркой зоне, четверть находится во второй зоне,
одна четверть находится в третьей зоне и т. д.
Массив с глубиной оцифровки 8 бит (256 дис-
кретных уровней) содержит 128 уровней в пер-
вой зоне, 64 уровня во второй и так далее. Для
теневых зон остается относительно немного
уровней: восемь в пятой зоне и только четы-
ре в шестой.

С технической точки зрения полноценный
охват обеспечивает 16-битное кодирование.
Однако с учетом возможностей зрения чело-
века достаточно 12-битного кодирования для
адекватного перекрытия зон экспозиции с
различимыми уровнями. Ультракомпактные
камеры обычно имеют АЦП с разрядностью 8
или 10 бит. В большинстве компактных ЦФК
используют аналого-цифровые преобразова-
тели с разрядностью 12 бит, в полупрофесси-
ональной и профессиональной технике — с
разрядностью 14 или 16 бит. В таблице пока-
зано значение фотографической широты при
разной глубине кодирования яркости.

Сравнение возможностей АЦП

Зона
экспозиции

1

2

3

4

5

6

7

8

9

10

11

12

Уровней в каждой зоне при глубине
кодирования

8 бит

128

64

32

16

8

4

2

12 бит

2048

1024

512

256

128

64

32

16

8

4

2

16 бит

32768

16384

8192

4096

2048

1024

512

256

128

64

32

16

Некоторыми параметрами обработки мас-
сива данных RAW в процессоре камеры поль-
зователь управляет через меню (установка
резкости, контраста, насыщенности цвета, цве-
товой модели, баланса белого цвета и другие).
Однако он не знает, какие алгоритмы «заши-
ты» в процессор производителем камеры, и не
может гибко их настраивать.

Поэтому массив RAW лучше передать на
компьютер и загрузить в графический редак-
тор (через RAW-конвертер). В этом случае под-
даются настройке любые параметры изобра-
жения. Результат зачастую получается лучше,
чем выдает камера, поскольку ее процессор
рассчитан на некие средние условия и не может
учесть всех нюансов.

По объему файлы RAW занимают промежу-
точное положение: при прочих равных усло-
виях они больше файлов JPEG, но существен-
но меньше файлов TIFF. Сравнительно малый
объем файлов RAW объясняется тем, что коди-
руется черно-белый вариант изображения.
К тому же массив данных обычно упаковыва-
ется обратимыми алгоритмами сжатия.

ЧЕМ БОЛЬШЕ ГЛУБИНА ОЦИФРОВКИ СНИМКА,

ТЕМ ШИРЕ ДИНАМИЧЕСКИЙ ДИАПАЗОН, ТЕМ

ЛУЧШЕ ВОСПРОИЗВЕДЕНИЕ ЦВЕТА
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Носители данных

менные носители данных служат уни-
версальным средством хранения и пере-

носа графической информации в цифровой
фотографии. Главные требования к ним: ком-
пактность, малое энергопотребление, большая
емкость, высокая скорость записи и чтения
информации. По различным причинам в сфере
компактных носителей сложилось разнообра-
зие корпоративных и отраслевых стандартов,
конкурирующих друг с другом.

По принципам хранения информации ком-
пактные сменные носители подразделяются на
три основные категории: твердотельные нако-
пители, жесткие диски и оптические накопи-
тели. Носители первых двух категорий полу-
чили наибольшее распространение.

Твердотельные накопители
Устройством хранения информации в

твердотельных накопителях является энер-
гонезависимая флэш-память. Она обладает
сравнительно большой емкостью, малым энер-
гопотреблением, удовлетворительной скорос-
тью работы. Отсутствие подвижных элементов
обусловило высокую надежность твердотель-
ных накопителей.

В настоящее время десятки фирм выпу-
скают несколько типов твердотельных носи-
телей: CompactFlash (CF), Smart Media (SM),
Multimedia Card (MMC), Secure Digital (SD),
mini Secure Digital (mSD), MemoryStick (MS),
Memory Stick Duo (MSD), MemoryStick Pro (MSP),
xD Picture Card (xD).

Большую популярность в мире компьютеров
и цифровой техники получили носители стан-
дарта CompactFlash, разработанного в 1994 году
фирмой SanDisk. Преимущества этих носите-
лей заключаются в универсальности и боль-
шой емкости, которая наращивается каждый
год. Носители CF тип I и тип II используют в
цифровой фототехнике, ноутбуках, карман-
ных ПК и других малогабаритных устройствах.
Конструкцией CompactFlash предусмотрено
размещение контроллера памяти на носите-
ле. Это обеспечивает применение новейших
носителей повышенной емкости в устаревшей

аппаратуре, но повышает стоимость носителя.
С развитием технологии производства флэш-
памяти и увеличением емкости модулей стои-
мость встроенного контроллера стала прене-
брежимо малой и практически не влияет на
ценовые характеристики носителя.

SarDisk/Э

GBCompactFlash®
Носитель CompactFlash
емкостью 4 Гбайт в
натуральную величину

Носители стандарта SmartMedia появились
в 1997 году. За счет переноса контроллера памя-
ти в фотокамеру удалось уменьшить габари-
ты носителя. Однако аппараты ранних выпус-
ков не могут работать с носителями объемом
более 32 Мбайт, поскольку изменилась система
адресации. К тому же максимальная емкость
носителей ограничена 128 Мбайт. В настоящее
время стандарт SM считается устаревшим.

Параметры носителей

Тип носителя

CFI

CFII

SM

ММС

SD

mSD

MS

MSD

MSP

xD

Microdrive

Габариты, мм

36,4x42,8x5

36,4x42,8x3,3

45x37x0,76

24x32x1,4

24x32x1,4

20x21,5x1,4

50x21,5x2,8

20x31x1,6

50x21,5x2,8

20x25x1,7

36,4x42,8x3,3

Емкость

12 Гбайт**

16 Гбайт**

до 128 Мбайт

до 128 Мбайт

до 2 Гбайт

до 256 Мбайт

до 128 Мбайт

до 1 Гбайт

до 4 Гбайт

до 8 Гбайт

4 Гбайт**

Стоимость* за
1 Мбайт, $

0,16

0,16

0,19

0,18

0,17

0,31

0,25

0,39

0,37

0,31

0,12

* Расчет сделан для модулей 128 Мбайт твердотельных носителей
и винчестеров Microdrive емкостью 2 Гбайт.

к* Дана емкость, достигнутая в рыночных образцах к началу 2005 г.
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Накопители в цифровой фотографии

Носитель SmartMedia
емкостью 128 Мбайт в
натуральную величину

Носитель MultiMedia Card емкостью
128 Мбайт в натуральную величину

Носители Secure Digital и mini
Secure Digital емкостью 256 Мбайт
в натуральную величину

Носители стандарта MultiMedia Card, раз-
работанные в 1998 году, сегодня также счита-
ются устаревшими. Это обусловлено порогом
емкости 128 Мбайт и сравнительно низкой ско-
ростью чтения/записи данных.

Стандарт Secure Digital стал расширенной
версией ММС. Увеличение числа адресных
линий способствовало повышению максималь-
ной емкости до 2 Гбайт. Развитием стандарта
стали карты mini SD.

Компания Sony разработала собствен-
ный стандарт твердотельных накопителей
Memory Stick с пределом емкости 128 Мбайт.
Вскоре появился более компактный носитель
MS Duo. В модификации Memory Stick Pro порог
емкости повышен до 2 Гбайт. Носители MS при-
меняются только в технике Sony.

Носители Memory Stick Pro
емкостью 2 Гбайт и Memory
Stick Duo емкостью 64 Мбайт в
натуральную величину

Носитель xD Picture Card
емкостью 256 Мбайт в
натуральную величину

Накопитель IBM Microdrive
емкостью 1 Гбайт

Самым свежим стандартом твердотельных
накопителей стал xD Picture Card, появившийся
в 2002 году. Носители xD отличаются малыми
габаритами, высокой скоростью работы и срав-
нительно большой пороговой емкостью.

Миниатюрные жесткие диски
К преимуществам жестких дисков отно-

сятся высокая скорость работы и низкая стои-
мость за единицу емкости. В сравнении с твердо-
тельными накопителями жесткие диски имеют
меньшую надежность и большее энергопотре-
бление. В корпусах, по габаритам и разъемам
соответствующих стандарту CompactFlash
тип II, миниатюрные жесткие диски емкос-
тью до 4 Гбайт в настоящее время выпускает
компания Hitachi.
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Объективы
^Чр^отография призвана запечатлеть, «оста-

'новить мгновение», сохранив световую
картину кусочка окружающего мира. Прежде
чем зафиксировать свет каким-либо способом,
его надо собрать так, чтобы миниатюрное изоб-
ражение, попадающее на пленку или сенсор, в
точности соответствовало реальной картине в
поле зрения камеры.

С оптического устройства — объектива —
начинается любая фотокамера, будь то профес-
сиональный аппарат или встроенная в мобильник
забавная «фича». Профессиональные фотогра-
фы любят выражение «снимает объектив», и
они во многом правы. От качества объектива
качество снимка зависит в той же мере, что и
от параметров матрицы.

Фокусное расстояние
Объектив имеет несколько ключевых

параметров, которые определяют его прин-
ципиальные возможности. С большинством
из них читатели сталкиваются в повседнев-
ной жизни. Например, принципиально важ-
ным является значение фокусного расстояния
объектива. Почти все мы в детстве наверня-
ка исследовали свойства лупы путем поджи-
гания листа бумаги. Изменяя расстояние от
лупы до листа, можно собрать солнечные лучи
в точку, в которой бумага быстро воспламе-

нялась. Аналогично объектив фотоаппарата
собирает световые лучи на пленке или сенсо-
ре. Дистанция от плоскости линзы объекти-
ва до плоскости фотоприемника называется
фокусным расстоянием.

В цифровых фотокамерах применяют сен-
соры многих типоразмеров: от миниатюрных, с
диагональю 5~8 мм, до полноформатных ана-
логов кадра 35-мм пленки. Очевидно, что для
каждого размера матрицы приходится изго-
тавливать собственный объектив с оптималь-
ным фокусным расстоянием.

Увеличение фокусного расстояния объек-
тива приводит к проецированию более круп-
ного изображения и сужению поля зрения.
При уменьшении фокусного расстояния поле
зрения расширяется, объекты съемки стано-
вятся менее крупными.

Поскольку угол зрения объектива зависит
как от фокусного расстояния, так и от раз-
меров кадра пленки (или матрицы), один и
тот же объектив, установленный на камеры
с разным размером кадра, будет иметь раз-
ный угол зрения. Например, если объектив с
фокусным расстоянием 50 мм использовать в
обычной 35 мм пленочной камере, то угол его
зрения составит 46°, а при установке на цифро-
вую камеру с размером матрицы 23,7X15,6 мм
угол зрения уменьшится до 34°.

Фокусное расстояние и поле зрения
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Чтобы не путать потребителей, принято
указывать фокусное расстояние объективов
в эквиваленте для 35-мм пленки. Объективы
обычно классифицируют по величине фокус-
ного расстояния следующим образом (приме-
нительно к 35-мм пленке):
• широкоугольный — менее 35 мм;
• стандартный — 45-50 мм;
• портретный — 60—80 мм;
• длиннофокусный — 80—200 мм;
• телеобъектив — более 200 мм.

Представленная классификация весьма
условна и опирается скорее на традиции, чем
на строго научный фундамент. Например, неко-
торые эксперты к группе портретных относят
объективы с фокусным расстоянием 85-135 мм,
а телеобъективами считают все устройства с
фокусным расстоянием более 135 мм.

Вариообъективы
Современные объективы для цифровых

камер имеют много оптических элементов,
позволяющих за счет изменения их взаим-
ного положения увеличивать или уменьшать
фокусное расстояние. В отечественной лите-
ратуре такие устройства получили название
вариообъективов. В англоязычной литературе
функция масштабирования именуется зумом
(Zoom), и термин зум, благодаря краткости, все
шире используется в русском языке.

Массовое производство доступных по цене
вариообъективов началось в 80-х годах два-
дцатого века, с внедрением систем компьютер-
ного моделирования оптических конструкций.
В настоящее время точность расчета и техно-
логия производства вариообъективов достиг-
ли таких высот, что они практически вытес-
нили объективы с фиксированным фокусным
расстоянием в качестве штатных систем для
камер всех классов.

Основное достоинство вариообъективов в
том, что они перекрывают диапазон применения
сразу нескольких объективов с фиксирован-
ным фокусным расстоянием. Возьмем объек-
тив фирмы Carl Zeiss, которым комплектуется
камера Sony CyberShot DCS-F828. Его диапазон
фокусных расстояний 28-200 мм перекрыва-
ет: широкоугольный (24-28 мм), стандартный

Оптическая система вариообъектива

Фокусирующая Диафрагма, Асферическая Фокальная
группа % I линза \ плоскость

(45-50 мм), портретный (80-130 мм) и длинно-
фокусный (свыше 130 мм) объективы.

Если суммировать цены на сменную опти-
ку указанных типов, то вариообъектив ста-
новится абсолютным чемпионом по критерию
стоимость — эффективность. Несомненным
достоинством вариообъектива является воз-
можность плавного изменения фокусного рас-
стояния, что позволяет снимать в промежу-
точных режимах.

Конечно, вариообъективы не свободны от
недостатков. Оптике с фиксированным фокус-
ным расстоянием они проигрывают по несколь-
ким параметрам. В частности, значение све-
тосилы зум-объективов в среднем уступает
показателям объективов с фиксированным
фокусом. В оптической системе вариообъек-
тивов практически невозможно избавиться от
геометрических искажений во всем диапазоне
фокусных расстояний, поэтому их стараются
свести к минимуму лишь для какого-то одно-
го фокусного расстояния.

Нельзя изготовить вариообъектив, одновре-
менно имеющий большой диапазон фокусных
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расстояний, высокую светосилу, компактные
размеры, высокое качество изображения и
небольшую стоимость. Поэтому вариообъек-
тивы — всегда плоды компромиссов.

В общем случае, чем дешевле камера, тем
на большие компромиссы идут разработчики
при создании объектива. Однако вариообъек-
тивы любительского уровня, установленные в
цифровые компакты, вовсе не заслуживают
пренебрежительного отношения. В рамках
требований своего класса они работают впол-
не удовлетворительно.

Светосила
Светосила объектива характеризует-

ся значением его относительного отверстия.
Относительное отверстие объектива записы-
вается в виде дроби и показывает отношение
диаметра действующего отверстия объектива
к его фокусному расстоянию. К примеру, объ-
ектив с относительным отверстием 1:4 (может
быть маркирован как F/4) имеет диаметр дей-
ствующего отверстия в четыре раза меньше
значения фокусного расстояния. Чем больше
значение относительного отверстия объекти-
ва (чем меньше знаменатель), тем более яркое
изображение он проецирует.

Пример маркировки объектива

Искажения
Большая часть принимаемых объек-

тивом световых лучей проходит вдали от его
оптической оси. Световое излучение содержит
волны разной длины, поэтому лучи фокуси-
руются по центру и краям изображения с раз-
ной точностью. Такие искажения называют
аберрацией.

К примеру, хроматическая аберрация «отве-
чает» за появление у мелких деталей и конту-
ров изображения цветных окантовок и ореолов.
Сферическая аберрация приводит к ухудше-
нию резкости по всему полю изображения.

Сочетание в объективе линз из разных мате-
риалов и с разной формой поверхности позволяет
компенсировать геометрические и хроматиче-
ские аберрации. Для вариообъективов задача
борьбы с аберрациями усложняется измене-
нием фокусного расстояния. Проектирование
и производство объективов с минимальными
искажениями — мероприятие чрезвычайно
дорогое. В итоге качественный объектив может
стоить в несколько раз больше, чем цифровая
камера полупрофессионального класса.

Пример хроматической аберрации

Появление
цветных ореолов
особенно
заметно на краях
кадра

Диапазон
фокусных

расстояний

Светосила на ближней
и дальней границах
диапазона

НЕ СУЩЕСТВУЕТ ОБЪЕКТИВА С ВЫСОКОЙ

КРАТНОСТЬЮ МАСШТАБИРОВАНИЯ, БОЛЬШОЙ

СВЕТОСИЛОЙ, МИНИМАЛЬНЫМИ ИСКАЖЕНИЯМИ,

ЛЕГКОГО И ДЕШЕВОГО ОДНОВРЕМЕННО
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Диафрагма

Влюбом объективе апертура (отверстие для
прохождения света) регулируется специ-

альным устройством — диафрагмой. Часто
ее изготавливают в виде перекрывающихся
лепестков. Диафрагма действует подобно мыш-
це радужной оболочки глаза, регулирующей
размер зрачка.

Диафрагма

Лепестки диафрагмы Значение максимально
открытой диафрагмы

Численно значение диафрагмы равно отно-
шению величины фокусного расстояния к диа-
метру отверстия, через который проходит свет.
Значение диафрагмы принято записывать раз-
ными способами: f/8, F8, 1:8.

Чем меньше отношение фокусного расстояния
к диаметру отверстия диафрагмы (чем больше
цифра в знаменателе), тем меньше света попа-
дает на светочувствительный элемент каме-
ры. Таким образом, установив диафрагму 1:2
(f/2, F2) мы пропустим через объектив больше
света, нежели установив значение диафрагмы
1:16 (f/16, F16). Каждый шаг стандартного диа-
пазона значений диафрагмы изменяет ровно в
два раза количество пропускаемого света: F2.0,
F2.8, F4.0, F5.6, F8.0 и так далее. Дроби принято
записывать с разделителем точкой.

Диафрагма также прямо влияет на глубину
резкости (чем больше отверстие, тем меньше

глубина резкости). При установке экспозиции
величина диафрагмы связана с выдержкой
обратно пропорциональной зависимостью:
• больше диафрагма — меньше выдержка;
• меньше диафрагма — больше выдержка.

На всех объективах указано значение мак-
симально открытой диафрагмы (максималь-
ной светосилы), а на объективах с переменным
фокусным расстоянием обычно указывают два
значения максимально открытой диафрагмы,
относящихся к границам допустимого фокус-
ного расстояния. При этом объектив, настро-
енный на длинный фокус, всегда пропускает
меньше света, нежели в положении коротко-
го фокуса. Объективы с большой максималь-
ной диафрагмой (обычно f/2 и больше) также
называют скоростными, поскольку они при
одинаковой освещенности позволяют устанав-
ливать более короткую выдержку, чем обыч-
ные объективы.

Оборотная сторона медали — минимальная
диафрагма, при которой еще возможна съемка.
Эта величина зависит не только от параметров
объектива. На нее влияют и характеристики
матрицы. Во многих цифровых фотоаппаратах
компактного класса значение минимальной
диафрагмы составляет всего f/П, что обуслов-
лено малыми размерами матрицы. В камерах
более высокого класса минимальное значение
диафрагмы доходит до f/22, хотя типичной
границей является значение f/16.

Типовые значения диафрагмы

f/16 f/11 f/8 f/5.6 f/4 f/2.8 f/2 f/1.2
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Системы фокусировки

Ушли в прошлое времена, когда фотограф
бегал с рулеткой, вычислял фокусное рас-

стояние и вручную крутил кольцо на объективе,
чтобы получить резкое изображение. Сейчас
подавляющее большинство фотокамер, как
пленочных, так и цифровых, оснащено систе-
мами автоматической фокусировки (обычно
обозначаются аббревиатурой AF).

Технически реализовать автофокус доволь-
но просто: надо послать в сторону снимаемого
объекта направленный луч, принять отражен-
ный сигнал и по времени прохождения опреде-
лить расстояние до объекта съемки. Обычно
для оценки расстояния используют электро-
магнитное излучение инфракрасного диапазо-
на, но иногда задействуют ультразвук.

Главная проблема систем автофокуса состоит
в правильном определении объекта и сюжета
съемки. В современных системах ее пытают-
ся решить применением нескольких режимов
автоматической фокусировки. Фотограф дол-
жен самостоятельно выбрать режим, наиболее
подходящий в данных условиях.

Система автофокуса нуждается в опреде-
ленном минимальном уровне освещения сце-
ны и способна выделять только достаточно
контрастные объекты. Часто в системах авто-
фокуса используют вспомогательный луч для
подсветки объектов в условиях недостаточной
освещенности.

Индикация зон автофокуса на дисплее цифровой фотокамеры

Маркировка автофокуса на объективе цифровой камеры

^* Режимы автофокуса
Система активного автофокуса {Active

AF) измеряет дистанцию до объекта методом
посыла активных сигналов. Важной характе-
ристикой активного автофокуса является диа-
пазон измеряемых расстояний. Простые каме-
ры обычно имеют трехступенчатый автофокус,
например: 0,6-1,2 м; 1,2-3 м; бесконечность
(более 3 метров). В более сложных камерах
число диапазонов AF может доходить до 300.
Высококачественный автофокус имеет мини-
мальное измеряемое расстояние около 5 см и
обладает высокой избирательностью даже в
условиях плохого освещения.

В некоторых моделях для повышения точ-
ности фокусировки на нужном объекте исполь-
зуется многоточечный автофокус. Измерением
расстояния занимаются несколько датчиков,
что снижает вероятность ошибки. Количество
точек автофокуса служит важной характери-
стикой фотоаппарата, но ничего не говорит о
качестве реализации системы. Зачастую одно-
точечный автофокус, разработанный известной
фирмой, работает точнее и надежнее, нежели
многоточечный сенсор, сделанный второсорт-
ной компанией.

Точечный замер производится по центру
кадра (в поле зрения видоискателя появляется
узкая рамка). Этот режим дает возможность
сделать снимок в сложных условиях фокуси-
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Ошибки и успехи

Матрица системы автоматической
фокусировки камеры Canon EOS-1D Mark II

ровки, например, когда главный объект съемки
располагается на дальнем плане, а второсте-
пенный объект — на переднем плане.

В следящем режиме автофокус пытается
поймать движущийся объект и удержать на
нем точку фокусировки. Недавно появились
системы предикативного слежения, умею-
щие предсказывать направление движения
объекта.

Пассивный автофокус
Принцип действия пассивного автофо-

куса основан на сравнении освещенности све-
точувствительных элементов, для чего в аппа-
рат устанавливается специальная матрица
автофокуса. На матрицу автофокуса переда-
ется изображение, прошедшее через объек-
тив. Если объект не в фокусе, то изображение
размыто и соседние элементы матрицы осве-
щаются почти одинаково. Если объект в фоку-
се, то изображение четкое и разница в осве-
щенности соседних элементов значительная.
Микропроцессор фотоаппарата анализиру-
ет полученную информацию и подстраивает
фокусное расстояние объектива до получения
контрастного изображения.

Таким образом, пассивный автофокус уста-
навливает резкость непосредственно по кон-
трастному объекту, попавшему в рамку автофо-
кусировки. Для нормальной работы пассивного
автофокуса требуется более высокий порог
минимального уровня освещенности.

Функция захвата точки фокуса
Ни одна автоматическая система не может

определить, что фотограф считает важным в
данном сюжете. Многозонные системы авто-

Ошибка автофокуса: резким получился задний план, а цветок на
переднем плане оказался не в фокусе

Ювелирная работа автофокуса: несмотря на минимальную
дистанцию и сложный объект, автоматика сработала четко

матической фокусировки решают одни про-
блемы, но порождают другие. В частности,
активная система не может сфокусироваться
на объекте за стеклом, испытывает серьезные
трудности при съемке сквозь решетки, сетки,
ветки. Поэтому важнейшей функцией камеры
становится возможность вручную выбирать
точки фокусировки (Focus Lock). Фотограф
может навести резкость по любой точке, пере-
местить аппарат для нужной компоновки кадра
и лишь затем нажать спуск.

Скорость работы автофокуса
У любой цифровой фотокамеры суще-

ствует интервал между нажатием на кноп-
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Развитая система фокусировки
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Развитые системы автоматической фокусиров-
ки для измерения расстояния используют много
точек. В нашем примере показана система авто-
фокуса камеры Canon EOS-1D Mark II, насчиты-
вающая 45 точек.
В полностью автоматическом режиме камера
демонстрирует в поле зрения видоискателя
задействованные точки фокусировки. Те из них,
которые используются в данный момент для
расчета фокусного расстояния, подсвечивают-
ся красным цветом. Можно переключиться в
режим замера по центру кадра (маркер в виде
окружности).

В полном полуавтоматическом режиме в поле
зрения видоискателя показаны все 45 точек
фокусировки. Фотограф с помощью джойстика
выбирает любую из предложенных точек.
В упрощенном полуавтоматическом режиме в
поле зрения видоискателя представлено всего
11 точек фокусировки. Захват нужной точки
производится джойстиком.
В периферийном полуавтоматическом режиме
задейстованы восемь точек фокусировки, рас-
положенные по периметру границ кадра.

ку спуска и срабатыванием затвора, то есть
реальной фиксацией изображения матрицей.
По большей части величина этой задержки
определяется временем срабатывания авто-
фокуса. «Заторможенный» автофокус выдает
большой процент кадров, где сняты затылки,
хвосты, спины и прочие детали объектов, кото-

Снимать спины и хвосты — удел цифровых камер
с «тормозным» автофокусом

рые успели поменять положение, пока камера
«размышляла».

В характеристиках камеры иногда приводят
скорость срабатывания автофокуса. Поскольку
нет единой методики измерений этого параме-
тра, цифры ни о чем не говорят. По эксперт-
ной оценке, в среднем по скорости автофокуса
лидируют зеркальные цифровики, аппараты
компактного класса заметно отстают.

Простейший способ тестирования авто-
фокуса на скорость срабатывания — съем-
ка товарища, который быстро высовывает и
тут же убирает язык. При хорошей скорости
автофокуса язык «ловится» на 70—90% кадров.
Успех в 50-70% случаев свидетельствует о
нормальной скорости. Слегка «тормознутый»
аппарат поймает 30-50%. Встречаются такие
«заторможенные» системы автофокуса, кото-
рые не могут поймать ни одного кадра с высу-
нутым языком.

JJJH Выводы
Lj7 К важнейшим параметрам системы фоку-
сировки относятся:
• наличие пассивной системы автофокуса;
• подсветка активной точки фокусировки;
• возможность ручного захвата точек фоку-

сировки;
• фокусировка по центральному перекре-

стию;
• возможность фокусировки вручную;
• скорость срабатывания автофокуса.
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Система экспозамера

В ИДЕАЛА ЧАЕ ЭКСПОЗИЦИЯ ДОЛЖН/

ДЕТАЛИРОВКИ ОБЪЕКТОВ В ПОЛЕ ЗРЕНИЯ КАГ

ЭКСПОЗИЦИЯ : ;ЭЕДЕЛЯЕТСЯ КОЛИЧЕСТВОМ

ГЮ ПЕРЕ

Режимы
экспозамера

Зонная
система
экспонометрии

Выдержка

Чувствительность

К]\нергетика фотографии в полной
tw^Mepe характеризуется экспози-
цией — произведением освещенно-
сти изображения (в люксах), полу-
ченного в фокальной плоскости, на
время освещения (в секундах). В иде-
альном случае экспозиция должна
обеспечить точную передачу ярко-
сти, цвета и деталировки объектов
в поле зрения камеры.

Величиной экспозиции управля-
ют, изменяя количество света, про-
ходящего через объектив, и время
выдержки. То есть, при известной
чувствительности нужно подать на
матрицу определенную световую энер-
гию, которая обеспечит правильную
фиксацию изображения.

Правильное экспонирование пред-
полагает знание закона взаимозаме-
стимости. Согласно этому закону, при
заданном уровне чувствительности
фотоприемника большая выдержка и
малое относительное отверстие экви-
валентны малой выдержке и большо-
му относительному отверстию. Для
получения той же экспозиции при
уменьшении выдержки на одну сту-

Закон взаимозаместимости
]

пень необходимо открыть диафрагму
на одну ступень, и наоборот. Используя
школьную формулировку переме-
стительного закона, можно сказать,
что от перемены мест множителей
произведение не меняется.

Границами применения закона вза-
имозаместимости выступают выдерж-
ки от 1/1000 секунды до одной секун-
ды. За пределами верхней границы
действуют правила:
• при выдержках около одной

секунды надо увеличить экспо-
зицию на одну ступень;

• при выдержках около 10 с надо
увеличить экспозицию на одну
или две ступени;

• при выдержках около 100 с надо
увеличить экспозицию на две
или три ступени.
Условия съемки могут быть оцене-

ны при помощи светочувствительного
прибора — экспонометра. Встроенный
экспонометр цифровой камеры изме-
ряет отраженный от объектов свет. Во
многих моделях предусмотрен замер
света, прошедшего через объектив
(ТТЪ, throw-the-lens). На выходе экс-
понометра появляется некая вычис-
ленная величина экспозиции — EV
(Exposure Value). Это комбинация чув-
ствительности матрицы, диафрагмы
и выдержки. Математически зависи-
мость описывается формулой:

EV = log2
диафрагма^ х

1
х

(чувствительность ISOU
\выдержка/ \ 100

Светосила
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ВЫДЕРЖКА ДОЗИРУЕТ КОЛИЧЕСТВО СВЕТА,

ДИАФРАГМА ДОЗИРУЕТ ЯРКОСТЬ

К примеру, параметрами измеренной экс-
позиции 9 EV могут быть значения:
• чувствительность ISO 100;
• диафрагма f/2.8;
• выдержка 1/60 с.

В полностью автоматическом режиме систе-
ма экспозамера камеры сама рассчитывает эти
параметры. Некоторые современные камеры
имеют творческие режимы съемки, в кото-
рых можно вручную задать диафрагму (при-
оритет диафрагмы) или выдержку (приори-
тет выдержки), изменить чувствительность
матрицы. Остальные параметры вычисляются
системой экспозамера автоматически, опять-
таки базируясь на измеренной величине EV.

Для оперативного регулирования свето-
силы в объективах применяется диафрагма.
Обычно конструкция диафрагмы состоит из
нескольких лепестков-шторок, позволяющих
уменьшать или увеличивать отверстие, через
которое проходит свет.

Объектив с большим значением светосилы
удобен, если съемка ведется при понижен-
ной освещенности. Однако если объект съем-

тосила объектива становится помехой. Ведь
яркость создаваемого им изображения будет
настолько большой, что даже минимальная
выдержка не обеспечит правильную экспо-
зицию. Уменьшение диафрагменного отвер-
стия (диафрагмирование) позволяет понизить
яркость проецируемого изображения.

Диафрагмирование объектива на одну сту-
пень приводит к такому же уменьшению экспо-
зиции, как и уменьшение выдержки в два раза.
В цифровых камерах, использующих электрон-
ное управление и индикацию, применяют более
мелкие деления — 1/2 или даже 1/3 ступени.
Пользователи цифровых камер часто не заду-
мываются об установке диафрагмы, посколь-
ку электроника в некоторых режимах автома-
тически отслеживает установленное значение
относительного отверстия объектива.

Диапазон «экспозиционного маневра» каме-
ры можно оценить, зная диапазон выдержки
и пределы изменения диафрагмы. По табли-
це определяют, в каком диапазоне освещенно-
сти работоспособна камера, а также пределы
маневра при заданном уровне освещенности.
Например, замеренная экспозиция составляет
10 EV. Камера Minolta F100 (диапазон выдерж-
ки от 1 до 1/1000 секунды, диапазон диафраг-
мы F2.8—F11) сможет предложить пять вари-
антов комбинации выдержка/диафрагма при
данном уровне освещенности.ки освещен достаточно ярко, то большая све-

™ _ Соотношение экспозиции, диафрагмы и выдержки при ISO 100
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Режимы экспозамера

Сегодня практически все цифровые камеры
оснащены системой автоматического заме-

ра экспозиции. Начиная с камер компактного
класса, как правило, предлагается несколь-
ко методов замера, которые рекомендуется
использовать в разных условиях съемки.

Экспонометрические устройства обычно
калибруются из расчета отражения 18% пада-
ющего на объект света. Это означает, что если
весь кадр занимает чисто белый или чисто
черный объект, то система экспозамера пред-
лагает такую экспозицию, чтобы в результате
получился серый объект. Поэтому, если кар-
тина распределения света в сюжете сильно
отличается от стандартной, возникает необ-
ходимость экспокоррекции либо замеров не
в отраженном, а в падающем свете.

Применяемые в настоящее время методы
замера экспозиции условно можно разделить
на четыре группы:
• интегральный;
• точечный;
• центрально-взвешенный;
• матричный или многозонный.

Интегральный метод
Простейший способ, когда освещенность

измеряется в среднем по всему кадру одним
датчиком, не имеющим каких-либо зон. В этом
случае фотографу самому приходится при-
нимать решение о необходимости и величине
требуемых поправок.

Точечный метод
В точечном методе замера экспозиции

для вычисления яркости используется один

небольшой участок («точка») кадра. Яркость
в других частях кадра не замеряется вовсе.
Обычно точечный замер применяют при кон-
тровом освещении в кадре, когда главный объ-
ект съемки освещен сзади. При других методах
замера объект оказался бы недоэкспонирован-
ным, находясь в глубокой тени.

В режиме точечного замера область изме-
рения ограничена небольшой частью площа-
ди кадра, как правило от 1% до 3%. Иногда
используется частичный замер — до 10% пло-
щади кадра.

Центрально-взвешенный метод
Метод основан на том, что замеры, сде-

ланные в центральной части кадра, имеют более
высокую значимость (вес). Яркость в остальной
части кадра также измеряется, но имеет мень-
ший весовой коэффициент при расчете экспо-
зиции. Обычно соотношение «весов» замеров
в центре и на периферии составляет 5:1. Однако
каждая фирма сама определяет конкретные
алгоритмы комбинирования значений в сво-
их камерах. Например, встречаются системы,
в которых центральной части придается зна-
чимость 75%, а остальным частям 25%.

Метод центрально-взвешенного замера
хорошо работает в типовых условиях осве-
щения и в том случае, если объект по центру
кадра имеет ключевое значение, а периферий-
ные объекты не столь важны. Если контраст
освещения в кадре слишком велик, есть риск
получить недоэкспонированные или переэк-
спонированные области снимка.
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Матричный (многозонный) метод
Матричный метод (его также называют

многозонным, или мультисегментным, или оце-
ночным) основан на разбиении кадра по зонам.
Данные по яркости освещения в каждой зоне
замеряются отдельно, а затем комбинируют-
ся по специальному алгоритму, обеспечива-
ющему вычисление оптимальной экспозиции
по всей площади кадра. Для замера освещен-
ности используется многоэлементный фото-
приемник, получающий информацию непо-
средственно с объектива.

Число зон, способ разбиения, метод замера,
алгоритмы расчета — все это является пред-
метом фирменных технологий, зачастую запа-
тентованных или засекреченных. Известно, что
некоторые системы замера сравнивают полу-
ченные результаты со значениями из заложен-
ной в память базы данных. В базе содержатся
параметры для самых разных условий съемки.
Обнаружив совпадение, система окончательно
оптимизирует экспозицию.

Например, развитая система матричного
замера используется в зеркальных цифровых
фотокамерах Nikon. Датчик имеет 1005 полей
замера, система способна рассчитать экспози-
цию в диапазоне от 0 до 20 EV.

Такой метод хорошо работает в камерах с
обширным диапазоном выдержек и значений
диафрагмы, позволяя получать оптимальные
комбинации даже для параметров, близких к
предельным. Мультизонный метод рекомен-
дуется использовать при съемке нестандарт-
ных сюжетов, в сложных условиях освещения.
В большинстве цифровых фотокамер, поддер-
живающих мультизонный метод экспозамера,
он установлен по умолчанию.

Экспокоррекция
Для изменения вычисленной экспозиции

в цифровых камерах применяют ручные и авто-
матические системы. Обычно шаг коррекции
составляет 1/2 или 1/3 EV. Диапазон коррекции
достигает ±5 EV в лучших образцах.

Ручная экспокоррекция необходима, когда
фотограф использует зонную систему опре-
деления экспозиции, не полагаясь на автома-
тику камеры. Цифровая технология фикса-
ции изображения по сравнению с пленочной
обладает тем преимуществом, что появляется
возможность раздельной экспозиции областей
кадра, попадающих в разные зоны. Для этого
достаточно сделать серию снимков, в каждом
из которых сделать экспокоррекцию в пользу
сюжетно важных зон. Дальнейшее совмеще-
ние кадров на компьютере обеспечит расши-
рение оптимального визуального контраста
снимка в целом.

Эксповилка (брекетинг)
Процесс экспокоррекции в камерах ком-

пактного класса в настоящее время частич-
но автоматизирован. В режиме эксповилки
(транслитерированный вариант английского
названия — «брекетинг») фотоаппарат делает
несколько снимков: один с «нормальной» экс-
позицией, остальные с заданным шагом экс-
покоррекции в «минус» и в «плюс». Величину
шага задает пользователь при выборе режи-
ма эксповилки.

Пример эксповилки

Норма
-1 EV ^ W I H +1 EV
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Зонная система экспонометрии

войства зрения человека таковы, что гла-
% ^ з а способны быстро приспосабливаться к
изменению освещения. Для человека не пред-
ставляет сложности рассмотреть в подробно-
стях обстановку в темной комнате и вид из окна
солнечным днем. В целом диапазон распозна-
вания яркости объектов человеком достигает
фантастической величины — один к ста мил-
лиардам, за счет адаптации зрения. Диапазон
яркостей, различаемых без адаптации, уже —
примерно один к миллиону. Матрица цифрового
фотоаппарта способна запечатлеть соотноше-
ние яркостей примерно один к десяти тысячам,
а фотобумага — один к двумстам.

Отсюда возникает проблема адаптации изоб-

ражения применительно к возможностям техни-

ки и особенностям зрения человека. Эти задачи

призвана решать экспонометрия. С технической

точки зрения точность приборов вполне обе-

спечивает адекватное измерение света. Но

экспонометрия наполовину, если не больше,

задача творческая. Требуется добиваться сход-

Главная задача экспонометрии ?

Зрительная система человека: миллион градаций яркости

'

Матрица ЦФК:
тысячи

градаций
яркости

Печатное изображение: 200 градаций яркости

ства психофизиологических реакций зрителя
и фотографа, не «зацикливаясь» на цифрах,
выданных приборами.

Вернемся к сюжету с темной комнатой и
видом из окна. На фотографии можно воспро-
извести в нормальном тоновом диапазоне либо
комнату, либо вид из окна, но не то и другое
одновременно. С учетом возможностей тех-
ники и материалов были разработаны зонные
системы экспонометрии, самой известной из
которых является система Адамса.

Зонная система Адамса
Американский фотограф Ансел Адаме

по результатам многочисленных эксперимен-
тов разработал зонную систему экспономе-
трии, ныне повсеместно принятую фотографа-
ми как имеющую наибольшую практическую
ценность.

Сущность любой зонной системы в том, что
калибровка экспозиционной системы осущест-
вляется по центральной зоне. В системе Адамса
за центральную принята зона, в отраженном
свете дающая 18% серого. Если центральная
зона по условиям освещения воспроизводит-
ся нормально, значит и остальные зоны будут
адекватно зафиксированы фотоаппаратом.

Тоновый диапазон снимка, по Адамсу, дол-
жен содержать 9 зон экспозиции, яркость каж-
дой отличается от соседних зон в два раза.
Ступень между зонами в цифровой фотогра-
фии обычно обозначается как 1 EV. Восемь
ступеней дают различие яркостей в 256 раз,
что соответствует динамическому диапазону
негативной черно-белой пленки и большинства
матриц цифровых фотоаппаратов.

Не все сюжеты можно качественно отобра-
зить при стандартной методике использования
зонной системы. В некоторых случаях ключе-
выми в кадре могут быть объекты, попадаю-
щие в третью, четвертую, шестую или седьмую
зоны. В такой ситуации фотограф калибру-
ет аппарат по пятой зоне, но снимает с экспо-
коррекцией в одну-две ступени. В результате
повышается оптимальный визуальный кон-
траст печатного изображения.
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Зонная система Адамса

8

зона. Сплошной черный цвет. Самые глубокие
тени. Цвета и фактура объектов не различаются.
зона. Появление первых признаков тоновых раз-
личий. Глубокие тени. Цвет по прежнему нераз-
личим, первые признаки фактуры.
зона. Заметны расширенные тоновые различия.
Нормальные тени. Можно различить фактуру
материалов, но цвет распознается плохо.
зона. Средние тени. Листва в тени, камни, тени в
летний облачный день. Различаются фактура и
детали объектов. Можно определить контрастные
цветовые границы.

зона. Центральная зона служит образцом при
экспозамере. В отраженном свете соответствует
18% серого. Хорошо видны детали объектов, их
фактура, нормально различается цвет.

jj зона. Снег зимой в тени. Небо в солнечный день.
Очень хорошо различаются оттенки одного цве-
та, фактура и деталировка среднего плана, но
начинают пропадать самые мелкие детали объ-
ектов.

7 зона. Высокий ключевой тон. Снег при боковом
освещении, светлые камни. Небо в горах. Падает
насыщенность цвета, плохо различаются мел-
кие детали.
зона. Белые объекты с текстурой. Складки тка-
ни белого и слабонасыщенного цвета, кружева.
Цвет плохо различим, фактура различима толь-
ко на крупных деталях.

€§ зона. Сплошной белый цвет. Самые яркие обла-
сти в кадре. Снег в прямом свете, световые бли-
ки. Цвет, фактура, детали неразличимы.
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Выдержка

Время, в течение которого площадь кадра
подвергается воздействию света, называ-

ется выдержкой (в цифровых камерах обозна-
чается как Shutter speed). В пленочных аппа-
ратах длительность выдержки обеспечивается
затвором — механическим устройством, посто-
янно перекрывающим световой поток из объ-
ектива. При нажатии на кнопку спуска затвор
открывается на заданное время и пропускает
световой поток к пленке. Механическая кон-
струкция затвора центрального типа обеспе-
чивает выдержки до 1/500 секунды, а в про-
фессиональных камерах затворы ламельного
или шторного типа могут работать с выдерж-
кой до 1/8000 секунды.

Механический центральный затвор

В цифровой фотокамере затвор обычно
электронно-механический. Механическая
часть отвечает за пропуск света к матрице, а
электронная часть заведует параметрами соб-
ственно выдержки. Электроника отсчитывает
время от момента попадания на матрицу пер-
вых фотонов света и по окончании заданного
периода просто прекращает прием информа-
ции. Тем самым обеспечивается сколь угодно
малая выдержка.

В моделях цифровых фотоаппаратов про-
фессионального класса встречаются выдерж-
ки до 1/16 000 секунды. Компактные каме-
ры, как правило, обеспечивают выдержку до
1/2 000 секунды. Очевидно, что столь короткие

выдержки будут полезны только при специ-
альной съемке.

Другой границей диапазона выдержки,
доступного через меню камеры, обычно слу-
жат значения до 30 секунд (в ручном режиме).
Опять-таки, сверхдлинные выдержки приме-
няются только в специальных режимах съем-
ки. Для этой же цели предназначена функ-
ция BULB — регистрации светового потока
на матрице до тех пор, пока фотограф удер-
живает кнопку спуска. Например, в камере
Nikon Coolpix 8700 выдержка в режиме BULB
достигает 10 минут. Очевидно, что в нормаль-
ных условиях выдержка «вручную» гаранти-
рованно обеспечит засветку кадра.

Особые условия съемки

Очень короткая выдержка —1/2000 секунды

Очень длинная выдержка — 15 секунд
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Чувствительность

Матрица цифрового фотоаппарата обла-
дает неким базовым значением чувстви-

тельности. В цифровой фотографии параметр
чувствительности принято обозначать как ISO
Speed Rating. Он зависит, в основном, от физи-
ческого размера матрицы, размера ее ячеек
и, в меньшей степени, от применяемых при
изготовлении технологий. Все прочие значе-
ния чувствительности, доступные через меню
камеры или устанавливаемые автоматически,
есть результат работы электронного усилите-
ля (или делителя, если чувствительность тре-
буется уменьшить). Очевидно, что усилитель
одновременно увеличивает как полезный сиг-
нал, так и шумы.

С позиций экспонометрии управление чув-
ствительностью многократно расширяет диа-
пазон приемлемых условий освещения в сцене.
Если в пленочной камере фотограф вынужден
самостоятельно рассчитывать чувствительность
пленки в данных условиях и менять пленку при
смене освещения, то в ЦФК все происходит в
автоматическом режиме. В крайнем случае,
владелец цифровой камеры может установить
значение чувствительности вручную.

В пленочной фотографии ряд значений чув-
ствительности стандартизирован. В цифровой
фотографии некоторые фирмы придержива-
ются стандартного ряда ISO, а другие добав-
ляют собственные значения. Сравните значе-
ния чувствительности, доступные из меню, в
некоторых цифровых камерах верхнего сег-
мента компактного класса.

Параметры чувствительности цифровых камер*

Модель камеры

Canon PowerShot Pro1

Minolta DIMAGE A2

Nikon COOLPIX 8700

Olympus CAMEDIA C-8080
Wide Zoom

Sony CyberShot F828

Значения ISO Speed Rating

50,100,200,400

64,100,200,400,800

50,100,200,400

50,80,100,125,160,200,250,
320,400

64,100,200,400,800

Автоматика системы экспозамера хорошей
цифровой камеры крайне неохотно идет на
изменение параметров чувствительности. Но
если условия съемки не соответствуют диапа-
зону маневра диафрагмой и выдержкой, прихо-
дится подключать к управлению экспозицией
изменение чувствительности. В так называе-
мых творческих режимах съемки (приоритет
выдержки, приоритет диафрагмы) автомати-
ке системы экспозамера деваться некуда, так
как фотограф отдает ей в управление только
два параметра, один из которых — чувстви-
тельность.

Фотограф может задать чувствительность
вручную через меню камеры. Но пользовать-
ся этой функцией следует с большой осто-
рожностью. По меньшей мере, надо изучить,
как влияет повышение чувствительности на
уровень шумов. Предсказать что-либо зара-
нее на основании технических характеристик
камеры трудно, поскольку методика измере-
ния шумов не нормирована, и что считать при-
емлемым качеством, каждый производитель
решает сам. Точно так же и каждый владелец
камеры самостоятельно решает, при каком ISO
Speed Rating качество снимков остается удо-
влетворительным.

Принципиально надо понимать, что если в
характеристиках камеры записано ISO 3200,
это «круто» только на бумаге. На практике
сверхвысокая чувствительность никак не рас-
ширит диапазон применения камеры, и, ско-
рее всего, останется невостребованной техни-
ческой «фичей».

Сравнение шумов

* При минимальной чувствительности меньше шумы у камер
Minolta, Olympus, Sony и Canon. При чувствительности ISO 400
меньше всего заметен шум на снимках камерой Olympus.

Minolta F100, ISO 100 Minolta F100, ISO 800
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Дополнительные параметры
ЗНАЧИМОСТЬ ДОПОЛНИТЕЛЬНЫХ ПАРАМЕТРОВ ДЛЯ КОНКРЕТНОГО ФОТОГРАФА ЗАВИСИТ ОТ ЕЖИМА

ИСПОЛЬЗОВАНИЯ КАМЕРЫ. В ЧАСТНОСТИ, В СПОРТИВНОЙ И РЕПОРТАЖНОЙ СЪЕМКЕ СКОРО

СТАНОВИТСЯ КЛЮЧЕВЫМ ФАКТОРОМ, ПО КОТОРОМУ ЗАЧАСТУЮ ВЫБИРАЮТ КАМЕРУ

Монитор
и видоискатель

Фотовспышка

Интерфейсы

Запись видео
и звука

О правильном
питании

Дизайн

Некоторые дополнительные пара-
метры камеры не играют суще-

ственной роли в обеспечении качества
снимка, но могут испортить удоволь-
ствие от работы, если выходят за
приемлемые границы. К числу таких
параметров принято относить ско-
рость работы, возможность серийной
съемки, записи видео и звука, удоб-
ство монитора и видоискателя, дизайн
камеры и некоторые другие.

Значимость дополнительных пара-
метров для конкретного фотографа
зависит от режима использования
камеры. В частности, в спортивной и
репортажной съемке скорость стано-

вится ключевым фактором, по кото-
рому зачастую выбирают камеру.
Скоростные характеристики, как пра-
вило, нельзя найти среди указываемых
производителем данных, приходится
разыскивать их в Интернете.

Слагаемые скорости
Скорость цифровой камеры

оценивают по показателям:
• время подготовки к съемке;
• время срабатывания затвора;
• промежуток между снимками;
• скорость серийной съемки.

Каждый из перечисленных пока-
зателей может стать приоритетным

Результаты тестирования скоростных параметров

LEiCA DIGILUX 2

Timing & Performance

Support Us
About

Time, sees Time» sees
(Leica) (SanDisk Ultra)

1 . I 1

\

1 li *• Vi9 IJVJIÎ ^̂ B

1
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в той или иной ситуации. На основе личных
предпочтений часто появляются субъектив-
ные мнения о продукции компании в целом:
якобы камеры фирмы XXX «тормознутые», а
камеры фирмы YYY «скоростные». Мы рас-
смотрим объективные параметры.

Время подготовки
Время подготовки фотокамеры к съемке

обычно больше у аппаратов компактного класса
и меньше у зеркальных камер. Объясняется это
тем, что в компактных камерах часто необходи-
мо выдвинуть объектив в рабочее положение.
Типичное время подготовки для цифровых «зер-
калок» составляет 0,5~2 секунды, для компакт-
ных камер 2,5-8 секунд. Конечно, встречаются
исключения. Например, цифровая зеркальная
фотокамера Canon 300D «задумывается» при
включении на 2,5 секунды. Напротив, камера
компактного класса Konica Minolta G400 гото-
ва к работе уже через 0,6 секунды, невзирая
на выдвигающийся объектив.

Время подготовки важно для фотокамеры,
используемой в репортажной съемке. Увидев
интересный сюжет, фотограф должен быть
готов «к бою» мгновенно, иначе сценка грозит
рассыпаться.

Скорость затвора
Время срабатывания затвора отсчиты-

вается от нажатия на кнопку спуска до фик-
сации изображения матрицей и переноса его
в буферную память. Этот промежуток опре-
деляется, главным образом, временем сраба-
тывания системы автофокуса. Обычно камеру
тестируют в режиме автофокуса, принятом
по умолчанию.

Анализ результатов тестирования цифро-
вых камер показывает, что типичное время
срабатывания затвора составляет 0,7—1 секун-
да на «коротком» фокусе и 1,2-1,4 секунды в
длиннофокусном положении объектива. Как
всегда, есть модели, выделяющиеся в луч-
шую или худшую стороны. Например, камера
Nikon D2H отличается изумительной скорос-
тью — 0,2 секунды! А вот камера Minolta F100
«задумывается» почти на полторы секунды,
что неприемлемо в спортивной съемке.

Щ\ Скорость записи
Продолжительность промежутка меж-

ду снимками зависит в основном от скорости
записи изображения на носитель. Напомним,
что изображение, зафиксированное матри-
цей, обрабатывается встроенным процессо-
ром камеры, помещается в буферную память
и затем переносится на носитель.

Очень многое зависит от формата файла, от
типа использованного носителя и даже марки
производителя. Обычно сравнивают проме-
жуток между снимками при записи файлов
JPEG с максимальным разрешением и мини-
мальным сжатием. Разброс показателей очень
широк: от 0,2 секунды в камере Nikon D2H до
4,5 секунд в камере Rekam T55. Кстати, время
записи может улучшить сам фотограф, уста-
новив более скоростную модель носителя.

|®U Серийная съемка
В некоторых жанрах фотографии ценит-

ся способность камеры зафиксировать серию
кадров при однократном нажатии на кнопку
спуска. В технических характеристиках этот
параметр указывается в кадрах в секунду.
Типичная скорость серийной съемки 2~5 ка-
дров в секунду.

Продолжительность серии определяется
емкостью буферной памяти. В цифровых зер-
кальных камерах продолжительность серии
достигает 40 снимков (Nikon D2H). В камерах
компактного класса емкость буфера от трех
до пяти кадров.

Серийный режим

Canon PowerShot Pro1

Minolta DIMAGEA2

Nikon COOLPIX 8700

Olympus CAMEDIAC-8080
Wide Zoom

Sony Cyber-shot F828

Скоростной 2,5 к/с, серия до
6 кадров в формате RAW,
обычная серия 1 к/с, серия до
18 кадров

Скоростной 2,7 к/с, серия до
3 кадров в формате RAW

Скоростной 2,5 к/с, серия до
5 кадров, обычная серия 1,2 к/с,
серия до 12 кадров, скоростная
серия только для маленьких
кадров

Скоростной 1,6 к/с, серия до
5 кадров, обычная серия 1,0 к/с,
серия до 26 кадров

Интервал в серии 0,38 с или
0,42 с
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Монитор и видоискатель

Внастоящее время в мире цифровых фото-
камер заметна тенденция представления

информации о параметрах съемки с помощью
трех устройств: панели данных, монитора и
видоискателя. От их функциональной насы-
щенности во многом зависит удобство рабо-
ты фотографа и, в конечном счете, качество
снимков.

Устройства

Панель данных v

Щ

отображения

# Видоискатель

ЖК-монитор

Панель данных
В камерах компактного класса панель

данных скорее исключение, чем правило. В уль-
тракомпактах этого полезного устройства точно
не найдешь. Между тем информация, выводи-
мая на панель данных, чрезвычайно важна для
фотографа: чувствительность, баланс белого,
разрешение, формат записи, оставшееся место
на носителе, режим автофокуса и многое, мно-
гое другое. Если эти данные целиком отобра-
жать на мониторе, то для собственно снимка
останется не так уж много места.

Панель данных стала обязательным атри-
бутом камер полупрофессионального класса
и признаком серьезного подхода к проектиро-
ванию. При прочих равных условиях камера,
оснащенная панелью данных, имеет заведомое
преимущество в удобстве использования.

Информация панели данных

Чувствительность Заряд батареи

Баланс белого

Экспокоррекция

Качество записи

f Режим фотовспышки

Размер изображения

Число оставшихся кадров

щ Монитор
Цифровая камера перешла в разряд

популярных бытовых устройств с появлением
встроенного жидкокристаллического монито-
ра, на котором отображался снимаемый сюжет.
Параметры монитора в значительной мере
влияют на удобство съемки. Главные показа-
тели — яркость и контраст. При недостатке
того и другого увидеть что-либо на мониторе
в яркий солнечный день невозможно.

На монитор обычно выводят служебную
информацию, помогающую правильно выбрать
режим съемки: выдержка, диафрагма, точки
фокусировки, режим работы вспышки, ино-
гда демонстрируется гистограмма текущего
изображения.

Видоискатель
Оптический видоискатель служит вспо-

могательным устройством в камерах компакт-
ного класса и основным в зеркальных камерах.
Оптический видоискатель компактной каме-
ры — параллаксный: его оптическая ось не
совпадает с осью объектива.

От этого недостатка избавлены электрон-
ные видоискатели, применяемые в некото-
рых моделях аппаратов компактного класса.
Электронный видоискатель отображает сто
процентов площади кадра.
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Фотовспышка

Вспышка на цифровом фотоаппарате ста-
ла обязательным аксессуаром, применя-

емым почти во всех видах и жанрах съемки.
Компактные конденсаторы, емкие аккумуля-
торы и надежные полупроводниковые преоб-
разователи напряжения обусловили широкое
применение электронных вспышек.

Ведущее число вспышки
Размеры осветителя фотовспышки неве-

лики в сравнении с расстоянием до объекта
съемки, и его принимают за точку. Для точеч-
ного источника освещенность поверхности, на
которую падает свет, обратно пропорциональ-
на квадрату расстояния от нее до источника
света. Отсюда вытекает закономерность: если
перемножить значение расстояния до объекта
съемки и соответствующее уровню экспозиции
диафрагменное число, то эта величина будет
иметь постоянное значение. Этот параметр
широко используют в фотографии под назва-
нием «ведущее число вспышки». Обычно веду-
щее число вспышки обозначают в метрах.

Автоматика
Современные электронные фотовспыш-

ки имеют встроенную автоматику, получаю-
щую информацию от датчика, расположенного
в камере. Когда автоматика сочтет количество
прошедшего через объектив света достаточ-
ным для нормальной экспозиции, она преры-
вает разряд в лампе-вспышке.

Система учитывает влияние на экспози-
цию энергии вспышки, расстояние до объ-
екта съемки, светосилу объектива, значение
диафрагмы. Даже в самых сложных условиях
съемки современные системы дозируют свет
чрезвычайно точно.

Совместимость
Практически каждый цифровой аппа-

рат оборудован встроенной автоматической
вспышкой. Ее возможности далеко не всегда
удовлетворяют потребности даже любительской
съемки. Поэтому фотографы часто используют
внешние вспышки, устанавливаемые на специ-

альный башмак. Внешние вспышки выпуска-
ют производители фотоаппаратуры и незави-
симые фирмы. «Родные» системные вспышки
стоят дорого, но гарантированно совместимы
по всем режимам.

О б р а з ц ы ф о т о в с п ы ш е к

Встроенная откидная вспышка камеры Canon EOS 300D

Внешняя вспышка Canon Speedlite 550EX (ведущее число 55)
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Интерфейсы

I ифровая камера без выхода готового про-
Л-Хдукта (сиречь фотоснимка) во внешний
мир — вещь практически бесполезная. Поэтому
необходимы технические устройства, обеспечи-
вающие передачу снимков на компьютер, прин-
тер, минилаб, телевизор. Для связи с внешни-
ми устройствами цифровые камеры оснащают
специальными интерфейсами. Простейшим
«интерфейсом» можно считать ручной метод
переноса, когда носитель вынимается из камеры
и вставляется в устройство чтения карт памяти.
Такие устройства, по аналогии с дисководами,
получили название картридеров (картоводов),
хотя вращающихся деталей в них нет.

Картоводы
Устройство чтения карт памяти удобно

своей простотой и универсальностью. Будучи
подключенным к компьютеру, оно воспринима-
ется как массив логических дисков. Есть моде-
ли, которые можно подключить к проектору,
телевизору, плазменной или жидкокристал-
лической панели. Такой картовод имеет выход
телевизионного сигнала (Video out). Сейчас в
ходу устройства, которые могут работать прак-
тически с любым присутствующим на рынке
форматом твердотельных накопителей.

В последнее время блоками чтения карт
памяти оснащают телевизоры, плазменные и
жидкокристаллические панели, компьютер-
ные мониторы и даже мышки. Встроенное про-
граммное обеспечение, обслуживающее такие
блоки чтения, позволяет просматривать фото-
графии в виде миниатюр, смотреть видеоза-
пись, слушать голосовой комментарий, демон-
стрировать слайд-шоу, в отдельных случаях

- вращать и кадрировать снимки.

Камера плюс компьютер
Самые обширные возможности по редак-

тированию снимков и управлению камерой
предоставляет, конечно, прямое соединение
цифрового аппарата с компьютером. Для это-
го обычно используются кабельные интер-
фейсы USB или FireWire (другое обозначение
IEEE1394). Неплохую скорость обмена данными

Подключение цифрвой камеры к компьютеру посредством

интерфейса USB

обеспечивает интерфейс USB версии 2.0, более
ранняя версия 1.1 заставит долго ждать окон-
чания перекачки больших объемов данных.
В цифровой фототехнике обычно применяют
кабель, оснащенный с одного конца разъемом
mini USB, который и подключают к камере.

Интерфейс FireWire теоретически немного
уступает USB 2.0 в пропускной способности:
400 Мбит/с против 480 Мбит/с. Однако на прак-
тике скорость обмена файлами по интерфейсу
FireWire на 15-20% выше, чем по интерфейсу
USB 2.0. Тому есть техническое обоснование, но
в такие подробности мы вдаваться не будем.

Помимо банальной переброски снимков на
компьютер, прямое соединение обеспечивает
массу дополнительных функций, например
прямую съемку в компьютер, то есть запись
фотографии в оперативную память компьютера
и затем на жесткий диск. При этом параметры
камеры полностью доступны в окне специаль-
ной программы. Управляющим устройством
служит обычная мышка.

Дистанционное управление открывает обшир-
ные возможности в области научной съемки и
домашнего экспериментирования. Соединение
с компьютером по кабельным интерфейсам —
двунаправленное, что позволяет программи-
ровать управление параметрами камеры и
заменять фирменное программное обеспече-
ние (Firmware) на более свежие версии.
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Камера плюс принтер
Несмотря на все преимущества работы

цифровой фототехники в паре с компьютером,
часть людей не желает или не может иметь
компьютер. Об их интересах позаботились как
производители самих камер, так и производи-
тели принтеров. Некоторые модели цифровых
фотоаппаратов бытового класса могут работать
с принтерами, имеющими так называемую
док-станцию. Аппарат укладывается в гнездо
док-станции подобно тому, как укладывается
цифровой телефон на базу. Автоматически
включается интерфейс, и сразу можно печа-
тать снимки, хранящиеся в карте памяти. Часто
принтер с док-станцией позволяет выполнять
простейшие операции редактирования изо-
бражений: кадрирование, поворот, улучшение
резкости и насыщенности цвета.

Разъемы интерфейса mini USB и видеовыхода в цифровой
камере компактного класса

Существуют модели принтеров, к кото-
рым можно подключать цифровую камеру по
интерфейсу USB. Эта функция называется
Direct Print или, более интригующе для поку-
пателя, Picture Bridge. Понятно, что принтер
не обладает возможностями компьютера и
может только распечатать готовые изобра-
жения с фотоаппарата. Функции редактиро-
вания снимков определяются возможностями
фотоаппарата.

Компанией Epson разработана технология
Print Image Matching, оптимизирующая про-
цесс прямой печати. Информация о параме-
трах изображения и требованиях к выводу на
печать записывается в специальный заголовок
файла JPEG (раздел EXIF).

Камера плюс телевизор
Просмотр фотографий на большом теле-

визионном экране на первый взгляд является
полезной функцией. Тем более, что она поддер-
живается в большинстве моделей цифровых
фотокамер, комплектуемых выходом A/V. Но
при более внимательном изучении проблемы
оказывается, что вывод на телевизор в боль-
шинстве случаев приносит мало пользы.

Телевизионное изображение имеет сравни-
тельно низкие параметры. В частности, картинка
содержит всего 640 строк (в системе NTSC) или
525 строк (в системах PAL/SECAM), а изобра-
жение выводится чересстрочно, по половинке
кадра, с частотой 60 или 50 раз в секунду. Даже
в простейшей двухмегапиксельной цифровой
камере снимок содержит 1600 строк. Конвертер
телевизионного сигнала вынужден «утрамбо-
вывать» эти строки в свой формат. Понятно, что
о качестве говорить не приходится.

Кроме того, исходная фотография представ-
лена в цветовом пространстве RGB. В телеви-
зионном сигнале цвет описывается в цвето-
разностном формате YUV, имеющем гораздо
меньший цветовой охват. Поэтому при конвер-
тации в телевизионный стандарт фотография
многое теряет и выглядит на экране совсем не
так, как должна.

Прямое подключение цифровой камеры к принтеру
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Запись видео и звука

Опытные фотолюбители хорошо знают, что
самое неблагодарное занятие — это раз-

борка фотоархива. Глядя на очередной снимок
из скопившейся груды, фотограф мучительно
пытается вспомнить, при каких обстоятель-
ствах появилась фотография. Часто бывает,
что трудно назвать даже персонажей на сним-
ке. Иногда помогает функция впечатывания
даты и времени съемки, но это не всегда удоб-
но, поскольку ведет к уменьшению полезной
площади кадра.

Звук
В помощь фотографу производители

придумали полезную функцию записи голо-
сового комментария к снимку. Комментарий в
виде звукового файла прикрепляется к фай-
лу изображения и воспроизводится при про-

смотре снимка в фотокамере
или на компьютере. Обычная
продолжительность голосово-
го комментария 15—30 секунд.
Рекомендуемая дистанция от

встроенного микрофона камеры до губ фото-
графа 15~20 сантиметров.

В некоторых моделях цифровых камер пред-
усмотрена запись аудио-аннотаций. Они соз-
даются в режиме просмотра снимков и заме-

щают голосовой комментарий,
если таковой уже существует.
Аннотация так же «приклеи-
вается» к соответствующему
изображению. Максимальная

продолжительность аудио-аннотации равна про-
должительности голосового комментария.

Видео
Понимающие толк в технике люди знают,

что для повышения маркетинговой привлека-
тельности продукта производители частень-
ко встраивают в него эрзац-функции, якобы
расширяющие основные. Как ячменный эрзац-

кофе лишь цветом напоминает
настоящий, так и эрзац-функ-
ции лишь в названии похожи
на полноценные.

Ф О Т О К А М Е Р Н О Е ВИДЕО ТАКАЯ Ж Е

11 ПРОФАНАЦИЯ, К А К ЯЧМЕННЫЙ К О Ф Е

В цифровой фототехнике повсеместной эрзац-
функцией стала запись видеоклипов. В передо-
вых моделях поддерживается формат записи
MPEG или AVI с параметрами 320 Х240 пиксе-
лов (30 кадров в секунду) или 640x480 пиксе-
лов (15 кадров в секунду). Продолжительность
видеоролика определяется емкостью буфер-
ной памяти, производительностью встроен-
ного в камеру процессора, емкостью носите-
ля данных.

В сравнении с записью цифровой видеока-
меры формата DV, видеоролики, полученные
на цифровом фотоаппарате, выглядят диле-
тантски. В камерах компактного класса обыч-
ной является частота 10—15 кадров в секунду,
что при воспроизведении вызывает только
раздражение. Функцию видеозаписи обыч-
но опробуют два-три раза и забывают о ней
навсегда. Ситуация с фотосъемкой на видео-
камерах аналогична: эрзац-фотографии смо-
трятся убого.

Запись видео и звука

Режим записи видеоролика

Режим записи аудио-аннотации

Режим записи голосового комментария
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О правильном питании

Пребывающий в городской среде фотограф
редко задумывается над вопросом электро-

питания цифровой камеры. Аккумуляторами
и батарейками торгуют на каждом углу, дома
лежит зарядное устройство, розетка найдет-
ся почти везде.

Но вопросы электропитания превращают-
ся в огромную проблему для фотографа-нату-
ралиста или отпускника, вырвавшегося на
лоно дикой природы. Зарядник не воткнешь
в дупло посреди тайги, а батарейки непросто
купить даже в Европе, например, где-нибудь
на трассе между Борисоглебском и Балашовом.
Поэтому в некоторых ситуациях главным пара-
метром цифровой камеры становится энерго-
потребление.

Как считать
Ассоциация производителей фототех-

ники (Сатпета & Imaging Products Association,
CIPA) разработала стандартную процедуру
тестирования продолжительности работы циф-
ровых камер. Ее основные условия включа-
ют: использование вспышки на 50% снимков,
перевод объектива из одного крайнего положе-
ния фокусировки в противоположное каждые
30 секунд, дисплей камеры непрерывно вклю-
чен, съемка сериями по 10 снимков, после каж-
дой серии камера выключается, температура
окружающей среды 23° С.

Как видно, условия достаточно жесткие
и соответствуют интенсивной эксплуатации
камеры. Поэтому, если производитель в харак-
теристиках аппарата указывает продолжи-
тельность работы по тесту CIPA, этим цифрам
можно верить. Для росийской зимы продолжи-
тельность работы надо поделить на два.

Написанному верить

Model
Operation

Nhimĥr nf Shots
(Operating Time)

EX-Z30
Apporoximate
Battery Life
360 shots
(180 minutes)

EX-Z4O
Apporoximate
Battery Life
360 shots
(180 minutes)

Если в характеристиках цифровой камеры есть заветная
аббревиатура CIPA, написанному можно верить

Стандарт CIPA достаточно свежий (декабрь
2003 года), и потому далеко не все камеры из
имеющихся в продаже тестировались соглас-
но его требованиям. Нередко в официальных
характеристиках можно встретить данные о
продолжительности работы без описания усло-
вий испытаний. А некоторые производители
вообще не рискуют публиковать параметры
энергопотребления. В таком случае эти пара-
метры следует разыскивать в Интернете на
сайтах независимых обозревателей.

Ш О батареях
Существуют общие правила эксплуата-

ции аккумуляторов для цифровых фотокамер.
Напомним самые важные из них.

Энергоемкость батарей уменьшается при
понижении температуры. В холодную погоду
(ниже 10° С) рекомендуется держать комплект
батарей в теплом месте, например во внутреннем
кармане одежды, и устанавливать их в каме-
ру непосредственно перед съемкой. Обычно
замерзшие батареи можно вернуть в рабочее
состояние при восстановлении температуры
до нормальной. Лучше переносят низкие тем-
пературы литий-ионные аккумуляторы, хуже
— никель-металл-гидридные.

При длительном перерыве в эксплуатации
камеры (более месяца) снимите батареи и храни-
те их отдельно. Протечка батарей может повре-
дить аккумуляторный отсек и даже угробить
камеру, замкнув электронные схемы.

Индикатор состояния батарей — прибор
очень неточный. Например, при эксплуатации
алкалиновых батарей индикатор частенько
выдает ошибочное предупреждение о слабом
заряде, хотя на самом деле заряд практически
полный. И наоборот, при использовании NiMH
аккумуляторов индикатор может показывать
треть заряда при почти «пустых» батареях.

Опытный фотолюбитель всегда имеет про
запас второй комплект батарей с гарантиро-
ванно полным зарядом. Ну а к специфиче-
ским условиям, например к дальней поездке
по диким местам, следует готовиться особо,
запасаясь зарядными устройствами.
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Дизайн
111ехнический дизайн охватывает не только
X внешний вид, но и эргономику изделия, то

есть во многом определяет удобство его при-
менения по назначению. В области цифровой

фототехники выделилось несколько направ-
лений дизайна аппаратуры, в зависимости от
ее класса и предназначения. Мода в той или
иной степени влияет и на рынок техники.

Ультракомпактные камеры

В камерах ультракомпактного класса на пер-
вый план выходят массо-габаритные параме-
тры. Поэтому дизайн фотоаппаратов предель-
но технологичен. В некоторых моделях он носит
имиджевый привкус и оформительскими реше-
ниями напоминает изделия смежных катего-
рий: мобильные телефоны, смартфоны, кар-
манные компьютеры, цифровые аудиоплееры.
Ультракомпакты не отличаются широкой функ-
циональностью. Как правило, число органов
управления минимизировано, расположены
они не всегда удобно. Дисплей очень компак-
тен и не слишком заметен. Некоторые модели
имеют встроенные диктофоны, аудиоплееры и
даже модули беспроводной связи.

Компактные камеры классического дизайна

В камерах компактного класса заметны два
направления в дизайне. Первое условно можно
назвать классическим. Корпус камеры класси-
ческого дизайна в общих чертах повторяет пле-
ночные аппараты соответствующего уровня.
В облике аппарата главным элементом служит
корпус, объектив малозаметен. Состав органов
управления по сравнению с ультракомпактами
расширен, расположены они более удобно.

; D

,
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Компактные камеры технологического дизайна

Второе направление в дизайне компактных аппа-
ратов можно назвать технологическим. Здесь
основное внимание уделено технологичности кон-
струкции и удобству размещения органов управле-
ния. В общих чертах аппарат как бы построен
вокруг объектива. В целом камеры, выполненные
в технологичном стиле, наиболее ярко выражают
цифровую суть современной фотографии.

Цифровые зеркальные камеры

Цифровые зеркальные фотокамеры имеют
строгий классический дизайн, обусловленный
использованием корпусов зеркальных пленоч-
ных аппаратов. Так обеспечивается совмести-
мость с номенклатурой объективов, вспышек и
другого оборудования. Органы управления
многочисленны. Те параметры, которые в более
простых аппаратах следует разыскивать в
меню, в цифровых зеркалках обслуживаются
кнопками и переключателями, расположенны-
ми под рукой.
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Параметры съемки

3APAI 1НЫЕ ПРОИЗВОДИТЕЛЕМ РЕЖИМЫ СЪЕМКИ ПОЗВОЛЯЮТ НЕ ЗАДУМЫВАТЬСЯ (

НАСТРОЙКАХ ПАРАМЕТРОВ КАМЕРЫ. ДОСТАТОЧНО ВЫБРАТЬ СЦЕНАРИЙ СЪЕМКИ, ПОДХОДЯ!.,

•МДИИ. РУЧНЫЕ РЕЖИМЫ ОБЕСПЕЧИВАЮТ ПОЛНЫЙ ДОСТУП К НАСТРОЙКАМ К/

Творческие
режимы

Глубина
резкости в
жанровой
съемке

Экспокоррекция

Баланс
белого

Поддержка цифровым фотоаппа-
ратом широкого перечня режи-

мов съемки свидетельствует о его
классе: чем больше вариантов, тем
выше класс камеры. В первую очередь
это касается режимов, предусматри-
вающих вмешательство владельца
в настройку ключевых параметров
съемки.

Обычно для выбора режима съем-
ки предназначено главное управля-
ющее колесо, специальные кнопки и
джойстики, пункты меню камеры.
Ниже представлены типовые режи-
мы съемки, поддерживаемые многи-
ми моделями цифровых камер.

Автоматический режим
Автоматический режим есть

в цифровых фотоаппаратах любого
класса. Он обычно выставляется по
умолчанию при включении каме-
ры. Такой режим идеально подходит

для любителей, снимающих в стиле
«навел — нажал».

Действия фотографа при включен-
ном автоматическом режиме сводят-
ся к компоновке кадра и нажатии на
кнопку спуска. Как правило, в типо-
вых условиях съемки, при невысоких
требованиях к качеству отпечатка,
для формата 10x15 автоматический
режим удовлетворяет запросам боль-
шинства любителей.

Сюжетные режимы
Производители фотокамер в

моделях начального уровня и клас-
сических компактах стараются в
полной мере использовать заранее
заданные параметры для типовых
условий съемки. Как правило, такие
параметры заложены в базу данных
камеры и образуют группу сюжет-
ных (сценарных) режимов съемки.
Конечно, нельзя объять необъятное

Выбор режима съемки

Режим съемки обычно выбирают с
помощью так называемого главного
колеса. Режимы маркируются надпися-
ми, буквами и пиктограммами.
Например, автоматический режим —
словом Auto, ручной режим — буквой
М (Manual).

Как правило, сценарии сюжетного
режима маркируют пиктограммами,
форма которых определяется произво-
дителем камеры. Соответствие ищите в
руководстве к фотоаппарату.
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Установки параметров цифровой камеры в автоматическом режиме

Режим экспозиции

Режим измерения экспозиции

Чувствительность камеры (ISO)

Режим работы вспышки

Зона фокусировки

Управление фокусировкой

Режим «протяжки»

Коррекция экспозиции

Резкость

Цветовой режим

Баланс белого

Непрерывный автофокус

Программный

Мультисегментный

Автоматическая

Автоматический

Широкая зона

Автофокус

Однокадровый

Нет

Нормальная

Естественный цвет

Автоматический

Включен

Фиксирован

Фиксирован

Фиксирована

Может быть изменен

Может быть изменена

Фиксирован

Может быть изменен

Может быть настроена

Фиксирована

Фиксирован

Фиксирован

Фиксирован

и предусмотреть все многообразие сюжетов,
встречающихся в реальных условиях съемки.
К настоящему времени сложилась группа сце-
нариев, ставшая стандартом «де-факто» прак-
тически во всех моделях камер компактного
класса. Однако производители не успокаива-
ются и оснащают некоторые модели сюжет-
ными режимами, которые относятся к раз-
ряду экзотических, как, например, сценарий
съемки текста.

Наиболее распространенные сюжетные
режимы съемки:
• макро;
• портрет;
• спорт;
• пейзаж;
• ночная съемка;
• ночной портрет.

Реже встречаются сценарии «закат», «салют»,
«панорама», «контражур», «снег и песок», «инте-
рьер», «текст» и другие.

МАКРО — режим съемки с малого
расстояния. В режиме «макро» объ-
ектив обычно автоматически уста-
навливает линзы в положение мак-

симального увеличения. Резкость регулируют
изменением дистанции до объекта съемки.

ПОРТРЕТ — оптимизация воспроиз-
ведения теплых, мягких тонов кожи
человека при некоторой размытости
фона. Большинство портретов смо-

трятся лучше всего при использовании боль-

ших фокусных расстояний и малой глубины
резкости.

СПОРТ — оптимизируются настрой-
ки фотокамеры для съемки быстро
движущихся объектов. Выдержка
минимальна, диафрагма открыта,

часто используется следящий автофокус.
ПЕЙЗАЖ — настройки фотокаме-
ры оптимизируются для получения
четких, насыщенных снимков пей-
зажей, с большой глубиной резко-

сти. При съемке на улице в условиях яркого
освещения также желательно использовать
данный режим.

НОЧНАЯ СЪЕМКА — параметры
камеры оптимизированы для условий
низкой освещенности. Системы экс-
позамера и автофокуса могут выда-

вать ошибочные данные и требуют контроля.
Вспышка работает в автоматическом режи-
ме. При отключенной вспышке выставляется
чувствительность, максимально возможная в
автоматическом режиме. Выдержка продол-
жительная.

НОЧНОЙ ПОРТРЕТ — оптимизация
настроек фотокамеры для съемки
портретов людей ночью с большой
глубиной резкости для хорошей про-

работки деталей фона. Так как в этом режиме
вспышка не работает, время экспозиции может
быть продолжительным. Рекомендуется исполь-
зовать штатив. Если вспышка установлена в
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заполняющий режим, экспозиции вспышки и
фона будут автоматически сбалансированы.
Попросите людей в кадре не двигаться после
срабатывания вспышки, поскольку затвор оста-
ется открытым для экспонирования фона.

Программный режим
В программном режиме (обычно марки-

руется на главном колесе буквой Р) сохраняется
функция автоматического расчета экспозиции.
В отличие от автоматического режима здесь
появляется возможность управления параме-
трами цвета, баланса белого, чувствительно-
сти матрицы, способом фокусировки.

В камерах полупрофессионального и про-
фессионального уровня в программном режиме
можно использовать функцию программного
сдвига (Program Shift). Она позволяет изме-
нить выдержку или диафрагму, не переклю-
чаясь в ручной режим.

Приоритет выдержки
Режим приоритета выдержки обычно

присутствует в компактных камерах среднего
класса и, конечно, в более дорогой аппаратуре.
В этом режиме выдержку можно устанавливать
вручную. Автоматически камера устанавли-
вает диафрагму в соответствии с вычисленной
оптимальной экспозицией. Если возможности
камеры по установке диафрагмы не позволяют
при данной выдержке сохранить экспозицию,
фотограф предупреждается о выходе за гра-
ницы допустимых параметров.

0 Приоритет диафрагмы
Ручное управление диафрагмой при авто-

матическом расчете экспозиции позволяет в

определенных пределах изменить глубину
резко изображаемого пространства, не бес-
покоясь о правильной экспозиции. Пределы
изменения диафрагменного числа зависят,
главным образом, от возможностей объектива.
Чем качественнее объектив, тем шире творче-
ские возможности фотографа при управлении
диафрагмой.

Ручной режим
Ручной режим управления выдержкой

и диафрагмой, то есть ручной установки экс-
позиции, предусмотрен в камерах компакт-
ного и более высокого классов. Как правило,
при переключении в такой режим индикаторы
камеры всеми способами (миганием, красным
цветом индикаторов) сообщают, что автомати-
ка полностью снимает с себя ответственность
за результат съемки.

Ручная выдержка
В режиме ручной выдержки затвор

открыт, пока палец удерживает кнопку спу-
ска. В камерах компактного класса ручная
выдержка ограничена 15-30 секундами, в про-
фессиональных камерах возможна установка
выдержки до полутора часов.

Блокировка экспозиции
В некоторых цифровых камерах преду-

смотрена функция блокировки экспозиции.
Автоматика определяет экспозицию в обыч-
ном режиме, а фотограф имеет возможность
зафиксировать вычисленное значение и сни-
мать с блокированной экспозицией совсем в
других условиях освещения. Так можно полу-
чать кадры с хорошей проработкой теней.

Сравнение некоторых режимов съемки

Режим съемки

Автоматический

Программный

Приоритет выдержки

Приоритет диафрагмы

Ручной

Спорт

Параметры

Фокусировка

Авто

Авто

Авто

Авто

Авто или вручную

Авто, следящий

Program Shift

-

+

-

-

-

-

Экспокоррекция

-

+

+

+

+

-

Метод экспозамера

Многоточечный

Многоточечный

Многоточечный

Многоточечный

Центровзвешенный

Многоточечный
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Творческие режимы

(Творческими принято называть такие режи-
JL мы съемки, в которых одним или обоими

параметрами установки экспозиции (выдерж-
кой и диафрагмой) фотограф управляет вруч-
ную. В ручном режиме фотограф волен выби-
рать любое сочетание выдержки и диафрагмы
в пределах возможностей камеры. Но и ответ-
ственность за результат съемки лежит толь-
ко на нем.

Экспозамер
Автоматика замера экспозиции зани-

мается тремя основными процессами: изме-
рением освещенности снимаемых объектов;
расчетом оптимального сочетания выдержки
и диафрагмы; управлением режимом и про-
должительностью работы вспышки.

Выбирая один из творческих режимов, фото-
граф берет на себя часть перечисленных функ-
ций. Для примера рассмотрим гипотетический
вариант съемки камерой с допустимым диа-
пазоном диафрагмы от 2 до 8 и выдержкой от
1/30 до 1/1000, единственным значением чув-
ствительности ISO 100. При данных параме-
трах камера способна правильно отработать
экспозицию в диапазоне освещенностей от
7EV до 16EV.

На границах диапазона у системы экспо-
замера выбора нет: освещенность 7EV требу-
ет сочетания выдержки 1/30 и диафрагмы Е2\
освещенность 16EV требует сочетания выдерж-
ки 1/1000 и диафрагмы F8.

Однако внутри диапазона появляется воз-
можность выбрать пять различных сочетаний
выдержки и диафрагмы, если камера допуска-
ет коррекцию параметров с единичным шагом
(один стоп). Многие модели позволяют изме-
нять параметры с шагом полстопа, тогда вари-
антов будет десять. И все они будут верными
с точки зрения правильной отработки экспо-
зиции, то есть дадут одинаковые по количе-
ству света кадры.

\ Приоритет выдержки
Фотографии объектов, находящихся в

движении, запечатлевают настроение азар-

та, скорости, ритма. Для передачи динамики
фотограф использует самые разные приемы
съемки. В этом ему помогает режим приори-
тета выдержки.

При установке очень короткой выдержки
движущийся объект получается четким. Но при
этом во многом пропадает динамизм сюжета.
Трудно вблизи снимать объект, двигающий-
ся перпендикулярно оси визирования. Для
получения резкого изображения нужны очень
короткие выдержки. Если камера не может
отработать требуемое сочетание выдержки
и диафрагмы, приходится увеличивать рас-
стояние съемки.

Для лучшей передачи динамичных сюжетов
часто используют более длительные выдержки,
чем «положено» для получения резкого изо-
бражения. В результате движущийся объект
получается смазанным. Увеличенную выдержку
часто используют при съемке текущей воды.

Выдержка и резкость
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О' Приоритет диафрагмы
В теории, идеально резкое фотографи-

ческое изображение можно получить только
для объектов, находящихся в одной плоскости,
параллельной плоскости матрицы. Однако на
практике резким получается не только объект,
на котором сфокусирована камера, но и пред-
меты, расположенные ближе или дальше.

Это связано с особенностями зрения, которое
имеет ограниченную разрешающую способность
и потому не замечает некоторую нерезкость.
Причем нерезкость в фотографии нарастает
постепенно, и для одних людей предмет может
казаться достаточно резким, а другие уже
замечают некоторую размытость. Допустимую
границу круга нерезкости устанавливают фор-
мально. Например, это может быть круг диаме-
тром 40 мкм. Расстояние, в пределах которого
все предметы будут казаться на изображении
достаточно резкими, называется глубиной рез-
кости, пли, более точно, глубиной резко изо-
бражаемого пространства (ГРИП).

Глубина резкости зависит от фокусного
расстояния объектива, величины относитель-
ного отверстия диафрагмы и расстояния до
объекта съемки. Есть несколько закономер-
ностей, зная которые можно приблизитель-
но определить границы резко изображаемого
пространства.

1. Чем меньше фокусное расстояние объектива,
тем больше глубина резкости. Изменение вдвое
фокусного расстояния изменяет глубину резко-
сти примерно вчетверо.

2. Чем меньше значение диафрагмы, тем больше
глубина резкости. На закрытой диафрагме глу-
бина резкости максимальная, а на открытой —
минимальная.

3. Чем больше дистанция от объекта съемки до
фотоаппарата, тем больше глубина резкости.
Изменение дистанции влияет на глубину резко-
сти так же, как изменение фокусного расстоя-
ния.

4. Зона приемлемой резкости за объектом, нахо-
дящимся в фокусе, больше, чем перед ним.

В режиме приоритета диафрагмы фотограф
доверяет автоматике управление экспозици-
ей за счет изменения выдержки, а сам сосре-
доточивается на управлении относительным
отверстием. Тем самым реальным объектом
управления становится глубина резко изо-
бражаемого пространства. Это одно из фун-
даментальных понятий фотографии и одно из
важнейших средств повышения выразитель-
ности снимков.

Для объективов компактных камер диапа-
зон стандартных значений диафрагмы обыч-
но составляет ряд F2.8, F4, F5.6, F8, иногда

Диафрагма и глубина резкости

На схеме показано влияние значения диафрагмы на
глубину резкости в условиях, типичных для компактной
цифровой камеры: фокусное расстояние объектива 30 мм,
дистанция до объекта съемки 3 м, «творческий» режим
приоритета диафрагмы. Хорошо видно, что фотограф

может сделать резким только объект съемки (диафрагма F2),
ближний задний план (диафрагма F4) или сцену на всю
ее глубину (диафрагма F8). Объекты, не попавшие в поле
резкости, не будут отвлекать внимание зрителя от главного
предмета съемки

f = 30 мм

I00 10 9
F5.6F8
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Сравнение глубины резкости

Ml
в

f = 50 мм; приоритет диафрагмы, F2.8 f = 50 мм; приоритет диафрагмы, F16

встречается значение F11. Казалось бы, про-
странство для маневра в режиме приоритета
диафрагмы не слишком велико. Однако заме-
чательная особенность цифровой обработки
сигналов проявляется в том, что система экс-
позамера использует нестандартные значения
диафрагмы и выдержки.

Расчет правильной экспозиции не пред-
ставляет сложности для процессора камеры
при любых значениях диафрагмы и выдержки.
Изучая свойства цифровых снимков, вполне
можно встретить значения диафрагмы F4.5 или
F6.7. Кстати, для отработки правильной экспо-
зиции система экспозамера не стесняется при-
менять и нетиповые выдержки: 1/45 секунды
или 1/650 секунды, или любые другие. Если
«кривизны» этих двух параметров не хвата-
ет, система экспозамера использует «кривые»
значения чувствительности, например ISO 114
или ISO 128.

Поэтому владелец цифровой камеры в режи-
ме приоритета диафрагмы в принципе обла-
дает широкими возможностями управления
глубиной резко изображаемого пространства,
если камера оснащена приличным объекти-
вом и большой матрицей. В компактных циф-
ровых камерах контролировать ГРИП трудно.
Матрица сравнительно небольшой площади
требует короткого фокусного расстояния объ-

ектива. Короткий фокус автоматически обес-
печивает большую глубину резкости.

Для типовых фокусных расстояний (28-50 мм
в 35-мм эквиваленте) существенная разница в
глубине резкости становится видимой только
на границах диапазона установки диафрагмы.
Качественные (и дорогие) объективы позволя-
ют более гибко управлять глубиной резкости,
поскольку имеют широкий диапазон допу-
стимых значений диафрагмы. Однако такие
сменные объективы устанавливают лишь на
зеркальные цифровые камеры.

Диапазон ГРИП, обеспечиваемый конкрет-
ной цифровой камерой, не найти в офици-
альных данных производителя. Энтузиасты
разрабатывают огромные таблицы для опре-
деления глубины резкости в самых разнооб-
разных условиях. Существует и немало домо-
рощенных программ расчета ГРИП, которые
легко разыскать в Интернете.

Как показывает практика, обычному фотогра-
фу, владеющему компактной камерой, полезно
знать глубину резкости для типовых значений
диафрагмы на коротком и длинном фокусе объ-
ектива. Главное — побольше снимать в режиме
приоритета диафрагмы и затем анализировать
полученные снимки. На третьей-четвертой
сотне кадров как бы сам собой появится опыт
установки правильной глубины резкости.
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Глубина резкости в жанровой съемке

Глубина резкости является одним из важ-
нейших выразительных средств фотогра-

фии. Для некоторых жанров сложились опре-
деленные каноны. Например, «классические»
портреты обычно снимают с малой глубиной
резкости, чтобы отделить объект от фона и при-
влечь внимание зрителя к снимаемому челове-
ку. При съемке натюрморта, наоборот, важно,
чтобы все предметы попали в зону резкости.

Для правильной компоновки кадра и выбо-
ра оптимального значения диафрагмы следует
определить, какой объект является в сюже-
те самым значимым. Этот объект необходимо
поместить в зону резкости.

Портрет
Естественно, что при съемке портрета

в зону резкости нужно поместить модель, а
задний и передний планы постараться «уве-
сти» в нерезкость. Для повышения вырази-
тельности иногда полностью открывают диа-

фрагму и акцентируют внимание на глазах,
при этом уши и волосы модели не попадут в
зону резкости. Кстати, в фотоаппаратах при-
мерно по такому алгоритму работает сюжетная
программа «портрет». В этом режиме камера
автоматически открывает диафрагму до мак-
симального значения, учитывая, конечно, усло-
вия освещения.

Классические портреты снимают на фокус-
ных расстояниях 70 мм, 85 мм, 135 мм, при этом
диафрагму открывают до F5.6 или F4.

j f f l Пейзаж
Как правило, при съемке пейзажа тре-

буется большая глубина резкости, ведь на
изображении резкими должны быть и пред-
меты на переднем плане, и удаленные объек-
ты. Чтобы добиться максимальной глубины
резкости, на широкоугольном объективе при-
крывают диафрагму. А если пейзаж удален на
значительное расстояние (например, горная
гряда) и при этом на переднем плане объек-
тов нет, лучше сфокусироваться на вершину
и выставить диафрагму F5.6 или F8. Хребты и
склоны получатся на изображении достаточ-
но резкими, ведь в зону резкости попадут все
объекты, находящиеся от камеры на рассто-
янии более 5 метров. Это достаточно универ-
сальный и простой способ, позволяющий при
ландшафтной съемке уделять контролю глу-
бины резкости меньше внимания, чем, напри-
мер, при макросъемке.

При съемке пейзажа удобно использовать
технику гиперфокальной фокусировки, что-
бы знать, на какой объект нужно сфокусиро-
ваться для получения максимальной глуби-
ны резкости. Конечно, не бывает правил без
исключений, и, возможно, в каком-то пейза-
же следует выделить отдельную деталь, один
объект, чтобы привлечь к ним внимание зри-
теля. Пусть он выделяется на фоне остальных
объектов, которые не попадут в зону резкости.
Нерезкие объекты на заднем плане, скорее все-
го, не испортят общего впечатления, а вот рас-
плывчатые силуэты на переднем плане будут
выглядеть не очень естественно.
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Натюрморт
Опытные фотографы считают, что для

съемки натюрморта требуется особый талант.
Ведь надо не только выставить освещение и
придумать идеальную композицию, но и соз-
дать настроение, без которого невозможно сде-
лать запоминающуюся фотографию.

Классика натюрморта — старинные карти-
ны голландских и фламандских живописцев.
Бросается в глаза, что все объекты, состав-
ляющие композицию, изображены на карти-
нах резкими.

Если объект исключить из зоны резкости,
он выпадает из общей композиции. Это требу-
ет скрупулезного расчета ГРИП при съемке
натюрморта, замера дистанции до объектов и
прочих ухищрений.

Архитектура
При съемке архитектурных объектов

обычно руководствуются теми же правила-
ми, что и при съемке пейзажей. Чтобы пере-
дать перспективу и включить в зону резкости
все объекты, глубина резкости должна быть
максимальной. Если объекты на переднем и
заднем плане будут казаться одинаково рез-
кими, это поможет сделать вашу фотографию
более информативной и интересной. Чтобы
выделить на снимке какую-то часть компози-
ции, можно размыть задний фон за счет сни-
жения глубины резкости.

;%. Макросъемка
При съемке мелких объектов дистанция

до объекта, как правило, ничтожна. Поэтому
глубина резкости даже при закрытой диафраг-
ме становится очень маленькой. Приходится
уделять контролю глубины резкости повы-
шенное внимание, иначе главные детали могут
оказаться вне зоны резкости. Важно правиль-
но найти точку фокусировки, чтобы добиться
максимальной глубины резкости.

При кропотливой и неспешной съемке в
студийных или домашних условиях не будет
лишним воспользоваться специальными табли-
цами глубины резкости.

^
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Экспокоррекция

"Т Удешевление цифровых камер ультраком-
С/ пактного и компактного классов привело к

стремительному росту новой категории поль-
зователей — любителей, ранее снимавших
пленочной мыльницей. Многие «перебежчи-
ки» продолжают снимать в пленочно-мыльной
манере: навел и нажал. Такой подход вполне
допустим, если фотографа не особенно забо-
тит качество снимков. Но для получения каче-
ственного продукта требуется освоить некото-
рые приемы настройки цифровой камеры под
конкретные условия съемки. В этом смысле
даже самый простой ультракомпакт даст сто
очков форы пленочной мыльнице.

Фундаментом фотографии как таковой слу-
жит экспозиция. Неверная экспозиция загу-
бит что аналоговый, что цифровой снимок.
В цифровой камере всегда есть возможность
компенсировать вычисленную автоматикой
экспозицию. И даже больше — задать съем-
ку серии кадров с компенсацией экспозиции
относительно вычисленной как в большую, так
и в меньшую сторону.

Чувствительность
Цифровая матрица обладает некоей

номинальной чувствительностью к светово-
му излучению. Эта базовая величина зависит

от многих факторов, которые мы здесь опу-
стим. Главное, что физическую чувствитель-
ность матрицы изменить нельзя. Все значения
чувствительности, отличные от номинального,
получают за счет усиления или ослабления
сигнала. Усиление неизбежно вносит искаже-
ния в исходный сигнал и увеличивает шумы.
Отсюда вывод: наилучшее качество снимка
достигается при установке номинальной чув-
ствительности.

В большинстве случаев базой служит зна-
чение чувствительности ISO 100, а в некото-
рых ультракомпактных камерах даже ISO 50.
В камерах полупрофессионального и професси-
онального класса используют матрицы с номи-
нальной чувствительностью до ISO 400.

При уменьшении экспозиции влияние чув-
ствительности на качество фотографии воз-
растает. Поэтому особенно важно снимать на
номинальном уровне чувствительности ночью,
в сумерках и в других условиях недостатка све-
та. Причина проста: номинальная чувствитель-
ность обеспечивает минимум шумов в тенях.
Штатив выручит, когда величина выдержки
будет больше 1/30 секунды. Установка повы-
шенной чувствительности оправдана только
в светлое время суток и только для съемок
быстро движущихся объектов.

Цифровой шум

На увеличенном участке снимка
хорошо заметно, что уровень
цифрового шума очень высок

Пример снимка, сделанного цифровой камерой компактного класса
(емкость сенсора 4 Мп) при установке чувствительности ISO 400

PwcartUte;
РввЬ: 4736. Cache Lewds 1

Проверить уровень шумов
можно в графическом редакторе.
Выделите однотонный участок.
В окне гистограммы выберите
канал красного цвета (Red) и
посмотрите значение параметра
Std. Dev. Если оно больше 6,
цифровой шум слишком велик
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Динамический диапазон
Важнейшей характеристикой фото-

аппарата, напрямую влияющей на качество
снимков, является динамический диапазон
(D), по смыслу аналогичный фотографиче-
ской широте пленки. К сожалению, произво-
дители фотокамер убеждены, что это один из
самых «секретных» параметров, и никогда и
нигде его не сообщают. Наоборот, фотографи-
ческая широта фотопленки явно указывается
для всех ее типов.

Динамический диапазон матрицы, то есть
свойство, по сути аналогичное экспонометри-
ческой широте фотопленки, варьируется в
очень широких пределах. Для миниатюрных
матриц ультракомпактов динамический диа-
пазон вряд ли превысит 1,8D. У некоторых
цифровых задников динамический диапазон
достигает 5D. Матрицы типовых аппаратов
компактного класса обычно имеют динамиче-
ский диапазон до 2,3D.

Экспозиционная широта фотопленки и дина-
мический диапазон матрицы цифрового фото-
аппарата вычисляются как десятичный лога-
рифм отношения предельно передаваемых
освещенностей. Например, освещенность одного
и того же предмета на улице солнцем в полдень
и лампами накаливания в обычной квартире
отличается в 10 000 раз, то есть на 4 порядка.
Матрица, способная зафиксировать подобный
перепад освещенностей, должна обладать дина-
мическим диапазоном не менее 4D.

Негативная черно-белая пленка имеет экс-
позиционный диапазон 7EV. Цветные негатив-
ные фотопленки охватывают диапазон до 6EV.
Обратимые пленки, которые иногда называют
«слайдовыми», имеют экспошироту 5EV. Эти
цифры легко привести к динамическому диа-
пазону Например, если фотоширота пленки
составляет 7EV, тогда она способна передать
диапазон градаций яркостей 27 = 128, или 2,11D.
Соответственно 6EV = 1,81 Д a 5EV = 1,5D.

Проверка динамического диапазона

Динамический диапазон
цифровой камеры
проверяют при съемке
сюжетов, имеющих
большой диапазон
яркостей. Фотографию

открывают в графическом редакторе и проверяют гистограмму.
Если гистограмма плавно опускается к краям и сходит на нет у
границ тонового диапазона, это свидетельствует о достаточном
для данных условий съемки динамическом диапазоне камеры.
Пример такой фотографии приведен на рисунке слева

- " : " • • " • • • • , • • • • • • ' • • - • •

В сюжетах с большим
диапазоном яркостей
динамического диапазона
камеры для полноценной
передачи градаций тонов
может не хватать. В этом
случае на границах тонового диапазона гистограммы заметны
пики, а гистограмма имеет корытоотбразную форму. Если бы
камера обладала более широким динамическим диапазоном, на
фотографии справа удалось бы запечатлеть больше тоновых
уровней в тенях и светах
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НЕЛЬЗЯ ПУТАТЬ ДИНАМИЧЕСКИЙ ДИАПАЗОН

И ДИАПАЗОН ПЛОТНОСТЕЙ ПЛЕНКИ, КОТОРЫЙ

ТАКЖЕ ОБОЗНАЧАЕТСЯ БУКВОЙ D (DENSITY).

СЛАЙД ДАЕТ НАИБОЛЬШУЮ ВЕЛИЧИНУ

ДИАПАЗОНА ПЛОТНОСТИ — ДО 4D, ТО ЕСТЬ

СООТНОШЕНИЕ ПЛОТНОСТЕЙ 1 : 10 000

Казалось бы, что даже простенькая циф-
ровая фотокамера, матрица которой имеет
динамический диапазон 1,8D, должна выда-
вать качество снимков заметно лучше, чем
на слайде. Однако на практике это незаметно.
Сравнимое или лучшее качество обеспечивают
только сравнительно дорогие камеры, с дина-
мическим диапазоном не менее 2,5D.

Ш Передаточная характеристика
Зависимость плотности пленки от экспо-

зиции называют передаточной характери-
стикой. Применительно к цифровой матри-
це передаточная характеристика описывает
зависимость величины накопленного заряда
от экспозиции.

Передаточная характеристика пленки нели-
нейна, что видно на графике. Чем выше мощ-
ность светового потока, тем медленнее нарас-
тает оптическая плотность пленки. С другой

4 3 2 1 0 1 2
log H (люкс - секунда)

Пример передаточной характеристики цветной негативной пленки

стороны, в тенях нелинейность приводит к
понижению чувствительности.

Типовая цифровая матрица имеет практи-
чески линейную передаточную характеристи-
ку. Линейность способствует повышенной чув-
ствительности в тенях, но приводит к быстрому
накоплению заряда ячеек, попавших в зону
интенсивного светового потока. Переполнение
заряда в засвеченных ячейках происходит еще
до того, как полностью отработала выдержка.
Поэтому даже при нормальной экспозиции

Оптимальный визуальный контраст

L

Представленная сцена обладает огромным диапазоном яркостей.
Ее экспозиционная широта от 9EV в тени до 15EV на небе, то есть
6 экспозиционных зон. Для оптимального визуального контраста
требуется устройство с динамическим диапазоном около 2,5D

В данной сцене экспозиционная широта в два раза ниже:
примерно 3EV. Однако узкий динамический диапазон камеры
не позволил добиться оптимального визуального контраста,
поскольку часть диапазона была потеряна
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Пример передаточной характеристики цифровой фотокамеры

светлые области нередко оказываются выбе-
ленными, бесцветными.

Р Несимметричность границ
Система экспозамера рассчитывает экс-

позицию так, чтобы общая освещенность сце-
ны оказалась примерно равна так называе-
мой «среднесерой» точке (18% черного). Если
поместить эту точку на линейной развертке
фотошироты матрицы, 18% черного окажется

отнюдь не по центру, а гораздо ближе к свет-
лым областям.

Иными словами, при сравнительно хоро-
шем динамическом диапазоне 2,3D фотогра-
фическая широта матрицы ляжет в интервал
примерно 0,33EV в плюсе и почти 7EV в мину-
се. Поэтому небольшое превышение яркости
(всего на полступени!) приведет к переэкспо-
зиции светлых областей.

Мм Эксповилка
В большинстве моделей камер компакт-

ного и более высокого класса предусмотрено
средство съемки серии кадров со сдвигом экс-
позиции в каждом кадре на заданную величи-
ну. Сдвиг экспозиции получил название экс-
позиционной вилки.

Типовые интервалы эксповилки: 0,3EV, или
0,5EV, или 1EV. Типовой порядок серии: нор-
мальная (вычисленная или установленная) экс-
позиция, +£V, -EV. При использовании ручной
коррекции экспозиции шаг эксповилки отсчи-
тывается от скорректированного значения.

Применять эксповилку рекомендуется в
условиях сложного освещения сцены, когда
фотограф не может определить, по какому
участку следует провести экспозамер.

Снимаем с эксповилкой

Включаем камеру, устанавливаем режим автоматической экспозиции.

При необходимости можно выбрать сценарий сюжетной съемки, соот-

ветствующий построению кадра.

В меню камеры или с помощью органов управления выбираем режим

экспозиционной вилки. Органом управления устанавливаем шаг бреке-

тинга. В аппаратах компактного класса лучше установить максималь-

ный шаг (обычно 1EV).

Нажимаем кнопку спуска наполовину до срабатывания автофокуса и

системы автоматического экспозамера.

Д Утапливаем кнопку до отказа и удер-

живаем ее до тех пор, пока камера не

отработает всю серию. Число остав-

шихся снимков контролируем по дис-

плею. Желательно использовать шта-

тив или упор для рук. Снимать без

упора можно при выдержках короче

1/60 секунды. В т о р о й с н и м о к экспозиция +1EV

Первый снимок, автоэкспозиция

Третий снимок, экспозиция -1EV
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Приемы нормализации экспозиции

В цифровой фотографии приходится использо-
вать некоторые ухищрения, чтобы получить на
снимке нормальную экспозицию. Существует три
основных приема, позволяющих обойти недостат-
ки цифровой матрицы.
Во время съемки даже в солнечный день можно и
нужно использовать вспышку для подсветки тем-
ного переднего плана. Встроенная вспышка обыч-
но слаба (подсвечивает на дистанции до трех
метров), поэтому на больших дистанциях жела-
тельно задействовать внешнюю вспышку.
Встроенную вспышку удобно включать при съем-
ке малогабаритных объектов, имеющих тонкую,
сложную фактуру. Вспышка также помогает при
съемке портретов в контражуре.
Ручная коррекция экспозиции на -1EV, -2EV или
-3EV, в зависимости от обстоятельств. Величину
экспокоррекции надо контролировать по дисплею:
как только появился нормальный, соответствую-
щий реальности цвет в светлых областях, значит,
экспокоррекция достаточна. Далее такой снимок
необходимо править в графическом редакторе,
корректируя тоновую кривую или тоновые уров-
ни.

Исходным для рисунка справа послужил тре-
тий снимок из «эксповилочной» серии с коррек-
цией экспозиции -1EV. Он обработан в програм-
ме Adobe Photoshop CS средствами коррекции
теней и светов (Image > Adjustments > Shadow/

Highlight) и управления насыщенностью (Image >

Adjustments > Hue/Saturation).

Виртуальная мультиэкспозиция с использовани-

ем возможностей графического редактора.

Сначала делают снимок с экспозицией, вычис-

ленной автоматикой цифровой камеры для сред-

несерой точки сцены. Не меняя положения каме-

ры, второй снимок делают со сдвигом экспозиции

в минус до тех пор, пока не получатся светлые

области с глубоким, насыщенным цветом. Затем

в графическом редакторе размещают оба снимка

на разных слоях и смешивают их так, чтобы и све-

та, и тени имели оптимальный визуальный кон-

траст. Недостаток такого приема в том, что сни-

мать приходится со штатива, обеспечивающего

стабильность камеры и полное совпадение эле-

ментов в кадре.

Встроенная вспышка помогла отчетливо проявить структуру
паутины и отделить ее от фона

Как показано на рисунке, из теней можно вытащить нормальный
цвет и хорошую деталировку

Снимок, «мультиэкспонированный» из двух кадров
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Баланс белого

Большинство фотографов предполагает, что
особых отличий в технике фотографиро-

вания на пленку и полупроводниковую матри-
цу нет. Тем не менее, практика показывает,
что появление цифровой техники несколько
изменило идеологию самого процесса фото-
съемки. В частности, одной из особенностей
цифрового фотоаппарата является необходи-
мость выставления так называемого «баланса
белого». Это нужно для того, чтобы все цвета
получились на снимке правдоподобно.

Цветовая температура
Баланс белого тесно связан с понятием

цветовой температуры. Проведем виртуаль-
ный опыт. Предположим, что мы имеем лам-
пу с нитью накаливания из абсолютно черного
материала, который поглощает все лучи све-
та. Начальная температура материала -273°
по Цельсию (температура абсолютного нуля)
или ноль градусов по Кельвину.

Подключим лампочку к электрической сети,
выключим в лаборатории свет и начнем посте-
пенно повышать напряжение на нити накали-
вания. В какой-то момент мы заметим, что нить
начала светиться красным цветом. Если заме-
рить ее температуру, она окажется равной 1200°
по Кельвину. При увеличении напряжения и
повышении температуры нити мы последова-
тельно увидим излучение оранжевого, желто-
го, зеленого, белого, голубого, синего и фиоле-
тового цветов. Например, желтый цвет — при
температуре 3000К, а белый при температуре
5500К. Цветовая температура никак не связа-
на с тепловой температурой реальных источ-
ников света. Голубое небо с цветовой темпе-
ратурой 9000К нисколько не горячее пламени
свечи с цветовой температурой 1500К.

Цветовая температура удобна для одно-
значного описания цветовой составляющей
освещения в снимаемом сюжете. Если каме-
ре сообщить эту температуру, она правильно
зафиксирует цвет объектов, поскольку будет
знать, какова цветовая температура белых
объектов, отражающих свет. Для точного заме-
ра цветовой температуры используют спе-

циальное устройство — колориметр. Более
простой и неизмеримо более дешевый метод —
использование таблиц цветовой температуры.
Недостаток таблиц в том, что нельзя учесть
изменения цветовой температуры в тени и
при смешивании излучения от нескольких
источников, что довольно часто встречается
в реальных сюжетах съемки.

В фотографии существуют собственные
понятия «солнечный свет», «небесный свет» и
«дневной свет». Под солнечным светом пони-
мается прямое излучение полуденного солн-
ца, с цветовой температурой примерно 4000К
(желтый свет).

Свет неба имеет голубой оттенок с цветовой
температурой около 7000К. Под дневным све-
том понимается смесь солнечного и небесного
света, цветовая температура такого освещения
около 5500К. Но стоит солнцу зайти за облако,
как баланс цветовой температуры сразу же
смещается в диапазон 6000-7000К. Наоборот,
на закате общий баланс цвета смещается в
сторону понижения цветовой температуры,
иногда вплоть до 3000К.

Цветовая температура источников освещения

Условия освещения

Небо в полярных широтах

Дымка

Пасмурно

Тень в ясный летний день

Дневной свет, фотовспышка

Голубая фотолампа

Солнце — два часа после
восхода или перед закатом

Солнце — час после восхода

Фотолампа тип А

Фотолампа тип В

Восход и закат

Галогенная лампа

Лампа накаливания 200 Вт

Лампа накаливания 100 Вт

Лампа накаливания 75 Вт

Люминесцентная лампа

Свеча

Цветовая температура

12000К—18000К

9000К — 12000К

6500К —7500К

6000К

5500К (от 5400К до 5600К)

4900К

3850К —4100К

3450К —3750К

3400К

3200К

3050К —3150К

2200К —3000К

3000К

2900К

2800К

2700К

1200К—1850К
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лито] Автоматические режимы
Как правило, в фотокамерах компактно-

го класса предусмотрено несколько режимов
баланса белого: полностью автоматический
(Auto) и предустановленные для разных усло-
вий освещения, например «Cloudy», «Tungsten»,
«Fluorescent», «Speedlight». Продвинутые моде-
ли фотокамер имеют режим установки баланса
белого вручную: заданием цветовой темпера-
туры или по образцу. Названия и номенклатура
режимов установки баланса белого могут раз-
личаться, но суть от этого не меняется.

Разработчики фотокамер и фотографы
соглашаются, что ни один из автоматических
режимов не дает правильной цветопередачи.
Понятно, что реальная цветовая температура
в сцене всегда отличается от заданной в каком-
либо предустановленном режиме. Величина
расхождения определяет степень искажения
цвета на снимке. Алгоритмы, используемые
разными производителями, дают существен-
но разные результаты.

Некоторые камеры для компенсации иска-
жений оснащают корректором, позволяющим
изменить цветовую температуру в небольших
пределах, например до +3 (смещение в область
холодных тонов) или до ~3 (смещение в область
теплых тонов).

Предустановленные режимы
В тени и

в пасмурную погоду

Облачная погода

Прямой солнечный свет

Автоматический режим

Баланс белого по образцу
Многие фотографы не признают ника-

ких предустановленных режимов и выстав-
ляют баланс белого исключительно по образ-
цу. В качестве образца используют лист белой
бумаги или специальный шаблон («серая карта
18%»). Поскольку остальные предметы в месте
замера освещаются тем же светом, то любое
отклонение от табличного белого цвета камера
учитывает по всей площади фотографии.

Установка баланса белого по образцу позво-
ляет привести к единому знаменателю цвето-
передачу камеры и гарантирует адекватное
восприятие зрителями цвета в стандартных
условиях. Но фотография может потерять
выразительность, обеспечиваемую специфи-
ческим балансом цвета.

В некоторых цифровых фотокамерах мож-
но вручную выставить баланс белого по ранее
отснятому кадру. Например, если съемка
велась в помещении со сложным освещени-
ем, а баланс белого был выставлен по мишени,
нет смысла в следующий раз тащить мишень
с собой. Достаточно выбрать правильный кадр
из предыдущей фотосессии и назначить его в
качестве образца.

Смешанное освещение

Свет люминесцентных ламп

Свет ламп накаливания Лампы накаливания » Дневной свет
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Установка баланса белого вручную

Подготавливаем лист белой бумаги размером
не менее А4 (примерно 210x300 мм).
Желательно использовать сорта бумаги с белиз-
ной не менее 95-96%. Хорошо подходят для этой
цели листы чертежного ватмана.
Включаем камеру и способом, указанным в
инструкции, переходим в режим ручной уста-
новки баланса белого (обычно в меню обозна-
чается как Manual).

Устанавливаем лист белой бумаги вблизи сни-
маемого объекта. Это особенно важно в слож-
ных условиях освещения, когда смешивается
свет от нескольких источников различного
характера. В крайнем случае устанавливаем
лист белой бумаги вблизи точки съемки.
Наводим видоискатель камеры на лист белой
бумаги так, чтобы он полностью заполнял кадр.
Нажимаем исполнительную кнопку запуска про-
цедуры (назначение кнопок узнайте в инструк-
ции камеры). По окончании процедуры установ-
ленный баланс белого сохраняем в памяти
камеры под уникальным именем. Если на дис-
плее появляется сообщение о невозможности
замера экспозиции (Over — переэкспозиция,
Under — недоэкспозиция), пробуем изменить
условия освещения так, чтобы система экспоза-
мера работала нормально. Например, при недо-
экспозиции задействуем вспышку.

ftiCUSTOM WB

С ]

CHANGE WB+W
NOT CHANGE*© CANCEI"*@2SB

Если условия освещения изменились, проводим
процедуру установки баланса белого вручную
заново и запоминаем настройки под другим
именем. В некоторых моделях фотоаппаратов
можно запоминать несколько вариантов поль-
зовательских установок баланса белого.

M a n u a l

ШУШЕ>
Запуск процедуры ручной установки баланса белого

Съемка в помещении в режиме автоматического баланса белого

Съемка в помещении после ручной установки баланса белого по
мишени (лист белой бумаги)
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Фотография и компьютер

Ц\АФ\ i ГОАППАРАТ И КОМПЬЮТЕР — БЛИЗНЕЦЫ-БРАТЬЯ. НЕ ИМЕЯ КОМПЬЮТЕРА, МО

СНИМАТЬ В ЛЮБЫХ РЕЖИМАХ И ПЕЧАТАТЬ СНИМКИ КАК ЕСТЬ. ИМЕЯ КОМПЬЮТЕР, МОЖНО С, ДЕЛАТЬ С

КАМЕ СНИМКОМ ЧТО УГОДНО

Дистанционное
управление

Организация
фотопапок на
компьютере

Отбор и
перемещение
снимков

Альтернативные
средства

Создание
коллекций

Типовые
операции
с файлами

Слайд-шоу

ТТюди, хорошо знакомые с устрой-
%} Хством компьютера, легко осваи-
вают цифровой фотоаппарат, потому
что его схемотехника практически
полностью повторяет компьютерную.
В этом нетрудно убедиться, взглянув
на сравнительную таблицу.

Управление
Совпадение принципиальных

схемотехнических решений ЦФК
и компьютеров облегчает
обмен данными и управле-
ние. К сожалению, по боль-
шей части обмен данными
ограничен перекачкой сним-
ков с фотоаппарата на ком-
пьютер или обратно.

Потенциально компьютер
способен серьезно усилить
возможности ЦФК по обра-
ботке снимков. Компьютер
оснащен несравнимо более
мощным процессором, боль-
шим объемом оперативной
памяти, а самое главное —
комплектом гибко настраи-
ваемых программ обработки
графики. Кроме того, ком-
пьютер способен эффективно
управлять процессом съемки,
что давно доказано историей
тесного взаимодействия ком-
пьютеров со сканерами.

Производители цифровых
фотоаппаратов, за редким
исключением, не предусма-
тривают средств управления
камерой с помощью компью-

тера. Хотя с инженерной точки зре-
ния проблем здесь нет. Повсеместной
компьютеризации цифровой фототех-
ники мешают маркетинговые сооб-
ражения. В лучшую сторону можно
отметить компании Olympus и Casio,
которые предлагают широкую гам-
му цифровых камер с компьютерным
управлением.

Некоторый прогресс наблюдает-
ся в аппаратах, позволяющих запи-

Сравнение схемотехники устройств

Компьютер Цифровой фотоаппарат

Исполнение программ

Универсальный процессор Процессор обработки
изображений

Хранение постоянных программ

ПЗУ BIOS ПЗУ

Временное хранение программ и данных

Оперативная память Оперативная память

Долговременное хранение данных

Жесткие диски, оптические
диски, флэш-память

Флэш-память, жесткие диски

Отображение данных

Дисплей Дисплей

Запись графических данных

Сканер, построчно Цифровая матрица, кадр

Органы управления

Клавиатура, мышь,
джойстик, тачпад, трекбол

Кнопки,колесики,
переключатели, джойстики

Внешние интерфейсы

USB, IEEE1394, 802.11,
Ethernet, 802.16, Bluetooth,
IrDA. COM, LPT

USB, IEEE1394, Bluetooth,
IrDA, COM

Программирование операций

Полное Ограниченное (через меню)

Возможность апгрейда элементов схемотехники

Расширенная Минимальная
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сывать данные в «сыром» формате RAW. Эти
данные представляют собой слепок яркостных
показателей пикселов матрицы. Они поступают
в оперативную память камеры и в дальнейшем
обрабатываются процессором или напрямую
записываются в долговременную память.

В ряде моделей ЦФК можно делать снимок
«в компьютер», то есть сразу перекачивать дан-
ные в формате RAW из памяти камеры в опе-
ративную память компьютера. Но число таких
моделей невелико. Возможно, это направление
будет развиваться с внедрением беспровод-
ных интерфейсов нового поколения и широким
распространением портативных компьютеров.
Даже карманные компьютеры значительно
мощнее встроенных процессоров ЦФК.

Подключение
При подключении камеры к компьюте-

ру кабелем USB операционная система авто-
матически определяет объем флэш-памяти и
представляет в системе только сменный носи-
тель в виде накопителя USB. Для того чтобы
компьютер распознал камеру как полноцен-
ное цифровое устройство, необходимо уста-
новить драйвер.

Процедура установки стандартная, поэто-
му описывать ее нужды нет. Помимо драйвера
потребуется программа управления камерой.

Фотокамера и компьютер ——

Цифровая фотокамера и компьютер образуют многоцелевой
комплекс, способный решать обширный круг задач:
от автоматизации съемки до выполнения охранных функций
в помещении

Чтобы все заработало нормально, следует про-
верить несколько условий.
• Версия прошивки ПЗУ камеры должна

поддерживать специальный режим управ-
ления от компьютера.

• Драйвер должен поддерживать данную
модель камеры.

• Программа управления должна поддер-
живать данную модель камеры.
Софт для управления камерой бывает двух

видов: фирменный (разработан производите-
лем камеры) и «самострочный» (от сторонних
разработчиков). Сторонние программы не всег-
да дружелюбны в установке и настройке. Для
их использования иногда требуются серьезные
познания в компьютерной области.

При удачном совпадении всех условий каме-
ра под управлением компьютера превращает-
ся в многоцелевой комплекс, обычно имеющий
возможность:
• динамически настраивать практически

все параметры съемки;
• снимать одиночные кадры и серии в интер-

активном режиме, с записью снимков в
компьютер;

• выполнять автоматическую съемку через
установленный интервал времени (обыч-
но от 1 секунды до 24 часов и даже более);

• работать в качестве веб-камеры, которая
периодически делает снимки и передает
фотографии на указанный сайт;

• переносить снимки из памяти камеры на
жесткий диск компьютера.
Область применения цифровой камеры под

управлением компьютера значительно расши-
ряется. А если скрестить камеру с ноутбуком
или КПК, становится почти безграничной. Не
придется вставать в четыре утра, чтобы запе-
чатлеть интереснейшие сюжеты на восходе
солнца. Не надо часами терпеливо сидеть в заса-
де, чтобы сфотографировать пугливое живот-
ное. Не надо бегать к распускающемуся цветку
каждые пятнадцать минут. Автоматизировать
все это и многое другое позволит компьютер,
подключенный к камере. В принципе, можно
управлять камерой через локальную сеть или
Интернет, находясь за десятки и сотни кило-
метров от самого аппарата.
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Дистанционное управление

Передовые компьютерные технологии про-
никают в цифровую фотографию чрез-

вычайно быстро. Внедрение некоторых из них
сулит революционные изменения, сравнимые
по своим последствиям с переходом фотогра-
фии с пленки на цифру В первую очередь речь
идет о беспроводных интерфейсах, соединяю-
щих цифровую камеру и компьютер. Конечно,
эксклюзивные технические решения беспро-
водного управления камерой существовали и
раньше, но они были дороги и малоэффектив-
ны. Между тем в последнее время произошло
несколько знаменательных событий, пред-
вещающих новый этап развития цифровой
фотографии.

Во-первых, стандартизированные, прове-
ренные компьютерные интерфейсы заняли
прочное место в конструкции цифровых камер.
Сегодня типовой цифровик обязательно осна-
щен интерфейсом USB, а профессиональные
модели — интерфейсом IEEE1394 (FireWire,
i-hink).

Во-вторых, началось внедрение беспровод-
ных интерфейсов, позволяющих заметно рас-
ширить возможности съемки. На нынешнем,
переходном этапе, обычно используют простую,
дешевую, но сравнительно низкоскоростную и
маломощную технологию Bluetooth. Первыми
ласточками, принесшими Bluetooth в цифро-
вую фототехнику, стали дорогие изделия вроде
задников фирмы Leaf. Сейчас со встроенным
модулем Bluetooth можно приобрести и деше-
вую цифровую мыльницу. В профессиональ-
ной цифровой фототехнике идет переход на
современную технологию беспроводной связи
802.11 (Wi-Fi), которая обеспечивает высокую
пропускную способность и хорошую дальность
действия. По-видимому, в обозримом будущем
в дешевых камерах для замены Bluetooth поя-
вится интерфейс Wireless USB, а более дорогие
изделия будут оснащать дальнобойным 802.11
и даже сверхдальним 802.16 (Wi-Max).

В-третьих, идет работа над стандартным
протоколом передачи медийных (фото, аудио,
видео) данных — Media Transfer Protocol (MTP)
и спецификациями MTP/IP, обеспечивающими

обмен медийными данными через Интернет и
по локальным сетям, в том числе беспроводным.
После принятия данного протокола функции
дистанционного управления цифровой камерой
станут стандартными в операционных систе-
мах семейства Windows. Пока, к сожалению,
для управления цифровой камерой требуются
специальные драйвера и программы.

Цифровая мыльница стоимостью менее 200 условных
единиц, оснащенная встроенным интерфейсом беспроводной
связи Bluetooth. Скорость передачи данных до 1 Мбит/с,
дальность действия до 10 метров на открытом пространстве,
рабочая частота 2,4 ГГц

Профессиональная цифровая камера Nikon D2H с подключенным
блоком WT-1 беспроводного интерфейса 802.11 b/g. Пропускная
способность до 11 Мбит/с, радиус действия на открытой местности
до 500 метров, в зданиях до 100 метров, рабочая частота 2,4 ГГц
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Возможности дистанционного управления

Рассмотрим возможности дистанционного управ-
ления цифровой камерой на примере професси-
ональной программы Nikon Capture Camera
Control. Элементы управления сгрупированы на

вкладках установки параметров экспозиции
(Exposure), записи изображения (Storage),
фокусировки (Mechanical) и обработки снимка
(Image Processing).

Elte Camera Settings ДО Help

The D2H is connected.

Images captured by this camera will bypass the CF card and be downloaded
directly to the computer until this window is dosed.

Hide Camera Controls

Enable controls on the camera body

Exposure 1 Exposure 2 Storage Mechanical Image Processing

Exposure Mode: Manual

Shutter Speed: @l

Aperture: @

Exposure Сотр.: Q)

Flash Сотр.:

Flexible Program:

© 1/200 sec

©f/13

©OEV

i OEV

OStep(s)

The D2H is connected.

Images captured by this camera will bypass the CF card and be downloaded
directly to the computer until this window is closed.

| Hde Camera Controls | | Download Options...

Enable controis on the camera body1

Exposure I Exposure 2 storage Mechanical Image Processing

®
Focus Area: ® © I )

о
Metering Mode: Multi-Pattern

Rash Sync Mode:
Sensitivity: ISO200 v •Auto

White Balance: Auto v [Fine Tune... ]

The D2H is connected.Images captured by this camera w! bypass the CF card and be downloadeddirectly to the computer until this window is closed.
[ Hide Camera ControlsJ {Download Options. •• [

Enable controls on the camera body-
Exposure 1 Exposure 2 Storage Mechanical image Processing

Shooting Mode: Single v
AF Area Mode:

Focus Mode: Manual
Lens:

Main Battery Level: •

Зафиксированное матрицей изображение попа- в программе Nikon Capture Editor, позволяющей
дает напрямую в компьютер, где обрабатывается на лету исправить недостатки.

Параметры съемки

Панель инструментов

Гистограмма

Цветовой баланс

Нерезкая маска

Динамический
диапазон

Размер и разрешение

Параметры
преобразования RAW

Баланс белого Снижение шума Виньетирование*
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Организация фотопапок на компьютере

Т юбая работа требует организации. Это в
t) JL полной мере относится и к цифровой фото-
графии. Едва начав работу, вы почувствуете
необходимость хранения исходных материа-
лов, результатов промежуточной обработки и
готовой продукции.

Основным средством организации данных
на компьютере являются каталоги. В операци-
онной системе Windows их функции выполня-
ют папки. Заранее позаботьтесь, чтобы необ-
ходимые папки были созданы и размещены
там, где это удобно.

При создании папок учитывайте стоящие
перед вами задачи. Например, если вы предпо-
лагаете использовать фотоснимки для просмо-
тра в электронном виде на экране, для печати
на бумаге и для размещения в Интернете, то
имейте в виду, что задачи эти несовместны. Не
удастся создать снимок, способный одновре-
менно выполнять все три функции достаточно
успешно. Соответственно, только для хране-
ния результатов работы может потребоваться
не менее трех папок. А если учесть необходи-
мость хранения исходных и ряда промежуточ-
ных материалов, то эффективная организация
работы с компьютером становится непростой
задачей. Решать ее надо профессионально.

Хранение архивов
Цель обработки снимка очевидна — его

улучшение, хотя разные люди понимают это
слово по-разному. То, что один воспринимает
как достижение, другой может посчитать вре-
дительством. Например, известно, что 4-мега-
пиксельная камера позволяет получить несжа-
тый кадр размером 12 Мбайт (сжатый кадр
«весит» чуть более одного мегабайта). Если
фотографию такого размера поместить на веб-
странице, редкий зритель дождется окончания
ее загрузки. Очевидное «улучшение» состоит
в том, чтобы удалить из снимка 95% отнюдь

ХРАНИТЕ СНИМКИ В АРХИВАХ. ПЕРЕД

ОБРАБОТКОЙ КОПИРУЙТЕ ИХ В

ТЕХНОЛОГИЧЕСКИЕ ПАПКИ

не бесполезной информации. Естественно, что
после такого насилия снимок потеряет ценность
и ни на что более интересное, чем публикация
в Интернете, станет не пригоден.

Снимок — это документ. Пока в него не вно-
сили изменений, в нем каждая точка в меру
возможностей камеры соответствует объек-
тивной реальности. Даже самый неудачный
снимок объективно отражает состояние окру-
жающего мира, преломленное через реаль-
ные условия съемки в данный момент вре-
мени. Обрабатывая далее снимок с помощью
компьютерных программ, с ним можно делать
удивительные вещи, благодаря которым его
художественная ценность должна возрастать.
Но художественную ценность каждый человек
понимает по-своему, а объективная ценность
снимка при любом внесении в него изменений
только падает. Это неизбежно и неотвратимо,
это закон природы.

Отсюда вывод: работать можно только с
копиями. Оставьте оригиналы детям и вну-
кам. Пройдут годы, появится новая техника
и новые программы. Возможно, через сто лет
кто-то сделает из ваших снимков что-то такое,
о чем сегодня и не мечтается. Чтобы это было
возможно, никогда не работайте с единствен-
ным экземпляром снимка.

Выбор устройства
В связи с быстрым развитием техноло-

гии производства жестких дисков в послед-
ние годы резко снизилась удельная стоимость
хранения снимков на этом магнитном носите-
ле. Сегодня она составляет менее 10 копеек за
кадр, что примерно соответствует аналогично-
му показателю для компакт-дисков. Поэтому
организуйте первые архивы на жестком дис-
ке. Пока он заполнен незначительно, може-
те считать, что архивы хранятся бесплатно,
ведь все равно для диска пока нет альтерна-
тивных задач.

Ситуация меняется, когда жесткий диск
заполнен более чем на 80%. Такая перегрузка
болезненно сказывается на производитель-
ности компьютерной системы в целом. В этот



момент стоит приобрести «пишущий» накопи-
тель CD-R/RW или DVD±R и начать переме-
щение архивов на оптические диски. Далее мы
расскажем о средствах каталогизации фото-
архивов, размещенных на различных носи-
телях.

Выбор папки
На Рабочем столе компьютеров, осна-

щенных операционной системой Windows, име-
ется папка \Мои документы, внутри которой
располагается папка \Мои рисунки. На первый
взгляд, это наиболее естественное место для
размещения фотоматериалов.

Файл Главка Вид Избранное Сервис Справка

3 Мои документы

MyeBooks Мои видеозаписи Мои источники
данных

Моя музыка

My Received Fies Мои рисунки

Папка Мои документы — не самое надежное место для
хранения архивов

Папку \Мои документы вместе со всем ее
содержимым отличает удобная особенность:
у каждого пользователя эта папка своя. При
загрузке операционной системы на Рабочий
стол заботливо выкладывается персональная
папка \Мои документы, принадлежащая теку-
щему пользователю.

Однако подобная заботливость имеет и тене-
вую сторону. Персональные папки — реквизит
операционной системы. Она работает с ними
более изощренно, чем с обычными папками.
Увы, есть определенная вероятность, что в
случае системного сбоя содержимое реквизит-
ных папок будет повреждено в первую очередь.
Причиной сбоя может стать компьютерный
вирус, мелкое нарушение в работе контролле-
ра жесткого диска, неаккуратность при замене
или обновлении операционной системы и дру-
гие неприятности.

Особенно не рекомендуется использовать
папку \Мои документы\Мои рисунки на компью-
терах с ограниченным объемом оперативной
памяти. Многие программы открывают эту
папку без спроса при попытке сохранить или
загрузить какую-либо графику. Если папка
переполнена рисунками, эта ненужная опера-
ция растягивается на несколько минут.

Используйте папку \Мои документы и вло-
женные в нее папки только для временного
хранения чего-нибудь не очень ответственно-
го. А для серьезной работы откройте корневую
папку жесткого диска, например С:\, и создай-
те в ней свою папку, например СДФото.

Настройка вида папки
Если папка Windows используется для

хранения мультимедийных данных, то ее мож-
но настроить так, чтобы работать с файлами
и воспроизводить их было особенно удобно.
Фотоснимки наряду со звуко- и видеозапи-
сями тоже относятся к мультимедийным дан-
ным. Поэтому полезно сообщить операционной
системе о назначении папки, чтобы восполь-
зоваться предоставляемым сервисом.

В операционной системе Windows XP каж-
дая папка может иметь слева специальную
панель, которая называется областью задач.
Обычно она зря занимает место на экране, и
большинство пользователей ее отключают,
что вполне справедливо.

Однако начинающим фотолюбителям, еще
не успевшим оснаститься разнообразным и
многообразным программным обеспечением,
область задач сослужит добрую службу. Дело
в том, что окно папки, содержащей графиче-
ские материалы, предоставляет специальные
средства для просмотра содержимого, но вос-
пользоваться ими нельзя, пока не включено
отображение области задач.

Чтобы включить отображение области задач
в окне папки Windows, действуйте следую-
щим образом.
1. Откройте окно ранее созданной папки,

например СЛФото.
2. Если область задач этого окна скрыта,

дайте команду Сервис > Свойства папки —
откроется одноименное диалоговое окно.
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Область задач папки

Область задач может быть
весьма полезной для работы
с фотографиями

Файл Правка Вид Избранное Сервис Справка

C:\pocuments and Set»Tgs\qwerty4^sktopUl№io

Просмотреть как слайд-шоу
Заказ отпечатков через
Интернет

Печать изображений
PICT0007 PICTO022 PICT0039 PICT2344

Создать новую папку

Опубликовать папку в вебе

Открыть общий доауп к этой
PICTOO77 PICT0076 PICTOO73

22,8 МБ %$ My Computer

3. Ha вкладке Общие диалогового окна

Свойства папки включите переключатель

Отображение списка типичных задач в пап-

ках.

Задачи

(#} Отображение списка типичных задач в папках

О Использовать обычные папки Windows

4. Нажмите командную кнопку Применить и
убедитесь в том, что в окне папки откры-
лась область задач.

5. Щелчком на кнопке ОК закройте диалого-
вое окно Свойства папки.

Выбор шаблона папки
Нагла следующая задача — оповестить

операционную систему о том, что папки пред-
назначены для хранения фотоснимков. Делают
это выбором адекватного шаблона для пред-
ставления содержимого папки.
1. Откройте окно ранее созданной папки.
2. Дайте команду Вид > Настройка вида папки

— откроется диалоговое окно свойств дан-
ной папки.

3. В диалоговом окне свойств папки открой-
те вкладку Настройка.

4. На панели Выбор подходящего типа папки
откройте раскрывающийся список, где
представлены доступные в системе типы
папок, и выберите в нем, например,
Фотоальбом. На этой же панели установи-

те ф л а ж о к Применять этот шаблон ко всем

подпапкам.

5. Нажмите командную кнопку Применить,
после чего закройте диалоговое окно.

Выбор режима представления
В большинстве случаев для просмотра

папок с фотоснимками удобен режим эскизов.
Его включают командой Вид > Эскизы стра-
ниц.

Если папка была предварительно настроена
на представление графического содержимого,
то в меню Вид можно найти еше одну команду
для включения полезного режима просмотра:
Вид > Диафильм. Ниже мы покажем, как этот
режим используют для отбора снимков.

I * *

•*Ф вьнжмть в первую очв

ОЗ_О9_ОЗ 04_05_2004

О5_0е_ОЗ 06_О9_03 О?_СГ9_ОЗ

Щ ЯН

— лт mm
0в_0е_ОЗ 0в_12_ОЗ 11_О7..20О4

Представление папок в режиме эскизов страниц помогает
ориентироваться в их содержимом, не открывая сами папки
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Организация структуры папок

Постепенно вы сами поймете, сколько и каких
папок для хранения, обработки и демонстрации
снимков необходимо иметь на компьютере.
Структура папок, в зависимости от решаемых
задач и степени увлеченности пользователя
фотографией, может быть очень сложной.
Например, в папке Печать могут быть вложен-
ные папки со снимками, отсортированными по
размеру отпечатка и по способу печати (принтер
струйный, принтер сублимационный, принтер
лазерный, минилаборатория и так далее).
Для любого, даже самого простейшего домаш-
него архива настоятельно рекомендуем преду-
смотреть наличие на компьютере хотя бы следу-
ющих четырех папок.
С :\Фото\Архи в
В архив перемещаются снимки из фотокамеры.
По мере исчерпания места на жестком диске
архив частями переписывается на заготовки
дисков CD-R. Вложенные папки удобно маркиро-
вать шестизначными числами, выражающими
дату создания архива в формате ГГ_ММ_ДД,
например: 03_07_06 — 6 июля 2003 года. Такой
формат избран из соображений удобства сорти-
ровки по календарной дате.

С :\Фото\Л аб
Технологическая папка, в которой снимки проходят
предварительную обработку (до изменения разре-
шения, масштабирования и кадрирования). Как
правило, это операции по улучшению резкости,
тонового диапазона и цветопередачи, которые
необходимы для любых видов дальнейшей публи-
кации снимков.

По мере исчерпания места на жестком диске сним-
ки из этой папки можно удалять. Если когда-нибудь
в них вновь возникнет необходимость, воспользуй-
тесь архивом.

3 С:\Фото\Печать

В этой папке хранятся снимки, подготовленные для
печати. Здесь выполняются масштабирование,
кадрирование, ретушь, монтаж, обрамление, над-
писывание и другие операции, связанные с кон-
кретными условиями и режимами печати. Вло-
женные папки маркируются в соответствии с
форматом отпечатка, а если предумотрено несколь-
ко способов печати — по их видам.

4 С:\Фото\Альбом
Папка для хранения снимков, предназначенных для
демонстрации на экране. Вложенные папки обычно
организуются по тематическому принципу.

Documents
and Settings

Диск 3,5 (А:) Л ™ 1 Й Локальный CD-дисковод U S B . D | S K ( R ) Съемный

Архив
г

I,

диск (С:) дискф:) (Е:)

J

Лаб

Фото WINDOWS

Печать Альбом

i 1

031107 040503 050901 10X14 10X15 13X18 Семья Дача Собака Спорт
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Отбор и перемещение снимков

Начинающему фотографу ничто не меша-
ет снять полсотни кадров и тут же все

их распечатать. Опытный любитель из того
же исходного материала вряд ли отберет для
печати более десятка кадров. Профессионал
скорее забракует сотню добротных снимков,
чем выпустит в свет один сомнительный.

Просмотр содержимого
Выбор и отбор — важнейшие этапы твор-

ческого процесса. Творчество начинается с
критического отношения к себе, со строгой
оценки результатов своей работы, со скрупу-
лезного отбора полученных материалов. Если
нет отбора, значит, это что угодно, например
учеба, но пока еще не творчество.

При съемке мы выбираем сцену, объект,
композицию, условия освещения, параметры
настройки камеры. Нередко недостаток опыта
и знаний мы компенсируем тем, что снимаем
несколько похожих кадров в разных режимах,
чтобы потом на досуге выбрать из них наилуч-
ший. Но это совсем не означает, что все, что
было снято, должно попасть в альбомы. Когда
съемка завершена и снимки скопированы в
архивную папку, приходит время подумать,
как ими распорядиться.

Для первичного отбора снимков нам не пона-
добятся специальные программы. Если шаблон
папки был предварительно настроен, то в окне
папки можно найти все средства, необходимые и
достаточные для первичного отбора снимков.

S Режим эскизов
Этот режим включают командой Вид >

Эскизы страниц. Он удобен для работы с фото-
графиями, потому что позволяет быстро оце-
нить содержание снимков и легко уничтожить
негодные экземпляры. Для удаления выделите
снимок щелчком левой кнопки мыши (снимок
приобретает контурную рамку) и в области
задач дайте команду Удалить файл. Файл уда-
ляется в Корзину Windows, откуда при необхо-
димости может быть восстановлен. Если необ-
ходимости в хранении файла в Корзине нет,
его можно удалить, минуя Корзину. Для это-

го команду Удалить файл надо подавать при
нажатой клавише SHIFT.

Просмотр содержимого папки в виде эски-
зов представляет собой определенную нагруз-
ку для компьютера. При недостаточной про-
изводительности системы просмотр может
заметно тормозиться. Наиболее критичный
фактор — объем оперативной памяти, уста-
новленной на компьютере. Для занятия циф-
ровой фотографией рекомендуются системы
с объемом памяти не менее 256 Мбайт, однако
желательно все-таки иметь 512 Мбайт и более.
Если замечаете, что компьютер плохо справ-
ляется с обслуживанием папок в режиме про-
смотра эскизов, уменьшите среднее количе-
ство снимков, приходящихся на одну папку,
хотя бы до 30~40.

Режим диафильма
Из-за небольшого размера кадров про-

смотр снимков в виде эскизов позволяет выя-
вить лишь явные операторские ошибки. Для
более тщательного просмотра снимков вос-
пользуйтесь режимом, который включается
командой Вид > Диафильм. Если вы не нахо-
дите этой команды в меню Вид, значит, либо

Файл Правка Вид Избранное Сервис Справка

. documents, and SetnngsyqwertypesktopWpaK

Размеры: 720x549

Размер: 80.1КБ

: Saturday, April 05, 2003,

щ "V
Горит нефть, jpg

Режим диафильма удобен для предварительного просмотра
и отбора снимков
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ваш компьютер работает с устаревшей опера-
ционной системой, либо не задан адекватный
шаблон для папки.

Функционально режим Диафильм очень
прост. Он позволяет просмотреть снимок в уве-
личенном виде и удобен, когда надо выбрать
один экземпляр из двух-трех похожих. Очень
полезна также возможность поворота кадра
на 90°. Снимки, непригодные для дальнейшей
работы, удаляют командой Удалить файл, пред-
ставленной в области задач.

Режим слайд-шоу
Этот режим просмотра снимков запус-

кается командой Просмотреть как слайд-шоу,
представленной в области задач. Для управ-
ления просмотром служит небольшая панель
в правом верхнем углу экрана. Чтобы в этом
режиме удалить бракованный снимок, надо
воспользоваться командой Удалить контекст-
ного меню снимка (открывается щелчком пра-
вой кнопки мыши на поле снимка).

Селекцию снимков в режиме слайд-шоу выполняют с помощью
контекстного меню

Размещение снимков
Итак, архив создан и предварительно

просмотрен, а все лишнее уничтожено. Пришла
пора готовить фотоснимки к публикации. Как
известно, требования к снимкам для разных
видов публикации могут различаться кар-
динально. Но на данном этапе не важно, как
они будут публиковаться: распечатываться на

'кажите, куда следует копировать выбранные
лементы (2 шт.), а затем нажмите кнопку
Копировать",

- ^ Ф о т о
+ „J Альбом

- О Архив

О 010904

ЁЭ 030504

g l 220704

a m
1 g| Печать

+ i t* Локягъннй лигк ГП:1

Цля просмотра подпапок щелкните по плюсику.

Создать папку 1 копирование 1 Отмена

Снимки, подлежащие обработке, копируются из архива
в папку\Лаб

бумаге или просматриваться на экране. Сейчас
следует взять снимки из архивной папки (С:\
Фото\Архив) и скопировать их в технологиче-
скую папку (С:\Фото\Лаб) для предваритель-
ной обработки.
1. Откройте архивную папку, например

С:\Фото\Архив\040725.
2. Выделите все объекты папки командой

Правка > Выделить все или комбинацией
клавиш CTRL + A.

3. В области типовых задач для текущей
папки выберите команду Скопировать
выделенные объекты — откроется диало-
говое окно Копирование элементов.

4. В открывшемся диалоговом окне разы-
щите папку, в которую должны быть ско-
пированы файлы, и нажмите кнопку
Копирование.

5. Если бы папка-приемник по каким-то
причинам еще не существовала, ее можно
было бы создать прямо сейчас. Для этого
надо выбрать папку, внутри которой она
должна располагаться, и нажать команд-
ную кнопку Создать папку.
Папка создается немедленно. Она получа-
ет принятое по умолчанию имя \Новая пап-
ка, которое следует безотлагательно заме-
нить более содержательным именем. Если
это не сделано сразу, то сменить имя мож-
но с помощью команды Переименовать
контекстного меню созданной папки.

6. Закройте диалоговое окно Копирование
элементов.
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Настройка команды «Отправить»
Хорошо, когда все файлы обширной груп-

пы надо скопировать в одно и то же место. Эта
работа одинаково легко выполняется как для
пары файлов, так и для пары тысяч файлов.
Хуже, когда одни файлы надо скопировать, а
другие — нет. Еще труднее задача отправки
файлов в разные места.

Впрочем, никакая задача не испугает того,
кто знает, как к ней подойти. Взгляните на
контекстное меню файла, представленное на
рисунке. Не правда ли, удобно: щелкни пра-
вой кнопкой на значке файла и выбери папку,
в которую файл будет скопирован.

1 Открыть
Печать
Открыть с помощью •
Обновить эскиз

Вьрезать
Копировать

Создать ярлык
Удалить
Переименовать

Свойства

LJ Лаборатория

£3 Город и люди

@| Снимки друзей

£Э Неразобранное

D Друзья и близкие

£Э Моя семья

& Живая природа

^Пейзажи

Й Старое и новое

4* Диск 3,5 (А;)

Применение команды «Отправить»

Создатели Windows предусмотрели в кон-
текстном меню удобную команду Отправить.
Она открывает список мест, куда можно ско-
пировать или переместить текущий объект.
Например, фотографию можно отправить на
принтер или по электронной почте или пере-
местить в любую папку Windows.

Настраивается команда Отправить не совсем
обычно. С нею связана системная папка, кото-
рая называется \SendTo. Настройка команды
Отправить заключается в наполнении этой пап-
ки ярлыками тех папок (устройств), в которые
(или на которые) надо отправить файлы.

На компьютере может быть несколько папок
\SendTo., по одной для каждого зарегистриро-
ванного пользователя. Надо не промахнуться
и заполнить ярлыками только «свою» папку.
Запомните ее адрес: C:\Documents and Settings\
XXX\SendTo. Здесь вместо <ХХХ> должно сто-

Эти полезные команды желательно помнить

CTRL + A

CTRL + С

CTRL + V

CTRL + X

Выделить все объекты

Копировать выделенные объекты в

системный буфер

Вставить содержимое буфера

Вырезать выделенные объекты (удалить в

буфер)

ять имя учетной записи пользователя в опе-
рационной системе.
1. Двойным щелчком на значке Мой компью-

тер откройте одноименное окно.
2. В окне Мой компьютер откройте папку

C:\Documents and Settings\XXX\SendTo.
3. Удалите в окне папки \SendTo все лишние

значки и ярлыки.
4. Откройте окно, содержащее значки папок,

предназначенных для приема копируе-
мых фотоснимков.

5. Перетаскиванием при нажатой правой
кнопке мыши создайте ярлыки папок-
приемников в окне папки \SendTo.

6. Закройте все открытые окна.
7. С помощью контекстного меню любого

объекта Windows убедитесь в том, что
меню команды Отправить содержит список
папок, предназначенных для приема гра-
фики.
Данная настройка позволит сочетать про-

смотр фотоснимков с их копированием в нуж-
ные папки.

Файл Правка Вид Избранное Сервис Справка

J C:\Documents and SetOngs\qwerty\SendTo

Папки

- jgj Мой компьютер
• А Диск 3,5 (А:)
Я ** Локальный диск (С:)

Ф ЁЭ $WIN_NT$.~BT

i i Distrlb
Documents and Settings

* Ё1 All Users
i _j Default User

qwerty
ш-еэ Application Data

£з Cookies

X

Город и люди

Лаборатория

Пейзажи

~ v Назад '

Друзья и
близкие

1
Моя семья

Снимки
друзей

|

Живая
природа

|

Неразобра.,

йрСтарое и
новое

i ^ Desktop
* ™J Local Settings
* Ё1 My Documents

NetHood
_j PrintHood
,J SendTo

Наполнение папки \SendTo ярлыками

7 2



Маленькие хитрости

| Как упорядочить команды в меню Отправить?
Порядок размещения команд в меню Отправить
совпадает с тем порядком, в котором соответ-
ствующие им ярлыки поступали в папку \SendTo.
Если временно извлечь из папки \SendTo все
ярлыки и затем вернуть их на место по одному,
они разместяться по очереди.

2 Можно ли переместить файлы командой
«Отправить»?

Команда Отправить создает копию объекта в
папке, ярлык которой хранится в папке \SendTo.
Если же надо, чтобы объект не копировался, а
перемещался, то команду Отправить надо
подать при нажатой клавише SHIFT.

| Как создать разветвленную структуру команд в
меню «Отправить»?
Обычно мы наполняем папку \SendTo ярлыками
папок-приемников. Но ее можно наполнять так-
же копиями папок (не ярлыками, а значками).
Каждая папка образует элемент иерархической
структуры меню команды Отправить.

Просмотр изображений

Для просмотра электронных изображений, име-
ющихся на компьютере, в операционной систе-
ме Windows XP имеется специальное средство
— Программа просмотра изображений и фак-
сов. У этой программы нет отдельного средства
запуска. Поэтому есть два основных способа
начать просмотр.

| Если папка предназначена для хранения изобра-
жений и никакая другая программа просмотра
на компьютер не установлена, то встроенная
программа просмотра запускается двойным
щелчком на значке файла.

- Для любого изображения из произвольной пап-
ки можно запустить программу просмотра через
контекстное меню (Просмотр или Открыть с
помощью > Программа просмотра изображе-
ний и факсов). Недостаток программы — отно-
сительно небольшой набор поддерживаемых
форматов: можно увидеть только файлы .BMP,
.GIF, JPG, TIFF и .PNG. Хотя именно эти типы
графических файлов встречаются чаще всего,
это лишь некоторые из множества существую-
щих форматов.

I

Операции в программе просмотра

| Выбранный рисунок отображается в окне. Для
прочих операций служат кнопки в нижней части.

2 Просматривают другое изображение в той же
папке кнопками Предыдущее изображение и
Следующее изображение.

Рисунки отображаются в натуральную величину
или масштабируются под размер окна. Для
управления масштабом изображения служат
кнопки Крупнее, Мельче, Истинный размер и
Подогнать размер.
Кнопками Повернуть по часовой стрелке и
Повернуть против часовой стрелки изменяют
ориентацию изображения.
Можно уничтожить текущее изображение
(Удалить), изменить его формат и местонахож-
дение (Копировать в), напечатать картинку
(Печать) или открыть ее в редакторе Paint
(Закрытие программы и открытие изображе-
ния для редактирования).
Щелчок правой кнопкой мыши на изображении
откроет контекстное меню, содержащее пере-
чень всех доступных операций с рисунком.

Повернуть по часовой стрелке
Повернуть против часовой стрелки
Крупнее
Мельче

Сделать фоновым рисунком рабочего стола

К Проверить на вирусы

Открыть с помощью

Отправить

Удалить

Свойства
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Альтернативные средства

Ранее мы рассказывали о методах катало-
гизации изображений, приемлемых для

фотолюбителей, которые снимают сотни кадров
в год. Но немало людей фотографирует с интен-
сивностью несколько тысяч снимков в год.
Держать фотоархивы такого размера в тема-
тических папках крайне неудобно. Положим,
что из очередного отпуска вы привезли три
сотни фотоснимков, где запечатлели себя и
спутницу на фоне различных достоприме-
чательностей. Встает вопрос: куда поместить
фотографию спутницы на фоне Эйфелевой
башни? Как быть, если нужно организовать
изображения по дате и одновременно по дей-
ствующим лицам, по сюжету и по местам дей-
ствия; как связать описание изображения со

снимком; как, наконец, найти среди 9384 изо-
бражений вашей спутницы то единственное, где
она улыбается? Когда число снимков перева-
ливает рубеж в несколько тысяч, такие вопро-
сы становятся неразрешимыми.

Даем бесплатный совет — забудьте о том,
что мы советовали в предыдущем разделе.
Если количество изображений в фотоархиве
исчисляется тысячами, остается единственный
выход: хранить снимки в папках, именован-
ных по дате съемки. А проблему каталогиза-
ции, поиска, просмотра изображений решать
с помощью специализированных программ.
Среди таких программ есть признанные лиде-
ры, например IrfanView или ACDSee, есть и бес-
платные утилиты, например PhoA. Мы рассмо-

Программа ACDSee

Панель папок Панель обзора Выбранное изображение

Панель просмотра Строка состояния Панель буфера изображений

Панель инструментов

D .j Selected
D ,.,i Sdected_C
i D ,j vietkong
D O3ma
П i „j Отобрано

17.09.2004 12:25:36

05.10.2003 15:02:38

20.09.2004 14:44:56

,j(>ipofla_01
D j Снимки, август
D .. j Снимки, дача, 2003

\ D ...J Снимки, дача, август 2>
: D Si СНИМКИ, дача, июль_2С
i D Ц Снимки, дача, май_200
i D j Program _F»es
!D..)R£CrCLER
I D, j stsrt
' D I System volum« Infer

D0F
Camera

J Make OLYMPUS OPTICAL
2\ Model C740UZ

Orientation upper left

P1010018.JPG P1O1O024.PG P1010026,JPG PIOIOO^.PG

_i Image des . OLYMPUS DIGITAL
31

MB, 05.10.2003 V 1CO63.JPG 1536

Панель свойств
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трим приемы работы с большими коллекциями
фотографий на примере программы ACDSee
компании ACD System (www.acdsystem.com).
Программа предлагает множество функций,
полный перечень которых займет страницу
убористого текста. Она проста в использова-
нии, обладает дружественным интерфейсом
и доступна любой категории пользователей:
от начинающих до профессионалов.

Быстрый старт
Основной принцип работы программы

заключается в индексировании мультиме-
дийных файлов (в том числе цифровых изо-
бражений) и создании базы данных. Основной
режим работы программы ACDSee — отобра-
жение содержимого выбранной папки. После
запуска на экране открывается окно програм-
мы, разделенное на панели:
• обзора эскизов изображений в папке;
• Folders (Дерево папок), аналог системной

программы Проводник;
• предварительного просмотра выбранного

изображения (Preview);
• Image Basket (Буфер изображений).

Остальные элементы интерфейса программы
вполне типичны: строка меню, панель инстру-
ментов, строка состояния. Открытие папки или
переход на другой диск выполняется двойным
щелчком. Для возвращения в родительскую
папку используется кнопка Up (Вверх на один
уровень) на панели инструментов или клави-
ша BACKSPACE.

Создание базы данных
Каждое изображение, попавшее в поле

зрения программы (для этого достаточно открыть
папку, содержащую рисунок), регистрирует-
ся в специальной базе данных. При этом запо-
минается эскиз рисунка, сведения о файле и
другая информация. Это дает возможность
аннотировать любые графические файлы, неза-
висимо от формата.

Если имя или местонахождение файла изме-
нить внешними средствами, база данных теря-
ет связь с источником. Поэтому все операции
с графическими файлами стоит выполнять
только в программе ACDSee.

При первом запуске программы желатель-
но в принудительном порядке сформировать
базу данных командой Database > Catalog Files.
В первом окне мастера Catalog Files Wizard уста-
навливаем переключатель Catalog a specific set
of folders.

В следующем окне мастера на вкладке Folders
to Catalog щелчком на кнопке Add Folder откры-
ваем диалоговое окно Choose Folders, в котором
отмечаем индексируемые папки. При первом
запуске желательно индексировать содер-
жимое дисков компьютера целиком, для чего
достаточно поставить флажки у значков нако-
пителей.

Choose the folders that you want to add to the list.
DGJjl Рабочий стол
- Q:J Мои документы

• D o A d o b e

DO My «Books
D3 МОИ рисунки

* Q J Моя музыка
" П "£ М0^ компьютер

• D«3 Мои документы

7p* Локальный диск (С:)
7\-«0 Выносить в первую очередь! (р:))

^ DVD/CD-RW дисковод (F:)
ft CD-дисковод (G:)

* 1ИГ*э1 Сетевое окружение
• о Альбомы
Do В обработке

D-J МУСОР
Q.,j На печать

• Q f i l Свежие фотографии
• Й Эксперименты

При первом запуске
программы ACDSee
устанавливаем флажки у
значков накопителей, не
раскрывая их структуры.
Это гарантирует
индексирование всех
изображений

На вкладке Advanced Options установкой
флажков включаем функции импорта данных
EXIF из заголовков файлов цифровых снимков,
индексирования упакованных файлов, соз-
дания эскизов изображений и каталогизации
только файлов растровой графики.

После щелчка на кнопке Далее программа
сканирует указанные папки и создает базу
данных найденных изображений. При большом
числе файлов процесс занимает длительное
время. Каталогизацию удобно вести в фоновом
режиме, для этого надо щелкнуть на кнопке
Hide (Скрыть).

Если вы уже имеете архивы фотоснимков
на съемных носителях, настоятельно рекомен-
дуем индексировать их в программе ACDSee с
помощью мастера Catalog Files Wizard. В даль-
нейшем желательно создавать архивы фото-
снимков на сменных носителях встроенными
средствами программы ACDSee.
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Создание коллекций
Коллекция изображений в программе

ACDSee — это выборка снимков определенной
сюжетной направленности или схожей тема-
тики. Работа с коллекциями сводится к опе-
рациям выборки, сортировки, запросов в базе
данных. При этом сами файлы изображений
могут находиться где угодно. Если одна и та
же фотография входит в разные коллекции,
физически она все равно остается в единствен-
ном экземпляре.

Создают и просматривают коллекции на
вкладке Categories. Первоначально предусмо-
трены следующие категории коллекций: Albums

(Альбомы), People (Люди), Places (Места), Various
(Разное) и Write Disk (Запись диска). По способу
создания и применения они полностью анало-
гичны категории Albums.

Свою категорию коллекций верхнего уровня
можно создать, если щелкнуть правой кнопкой
мыши на заголовке Category и выбрать в кон-
текстном меню пункт New Category. Вложенные
коллекции создают тем же способом, но щелч-
ком на заголовке категории или коллекции
более высокого уровня. Коллекции категории
Write Disk (Запись диска) создаются автомати-
чески при записи дисков средствами програм-
мы ACDSee.

Коллекции

Создаем коллекцию изображений в одной из кате-
горий. Обратите внимание, что в момент создания
должна быть выбрана категория, в которую будет
включена коллекция. В нашем примере показано
создание альбома.

Переходим на вкладку Categories. В списке кате-
горий выбираем Albums или любую другую кате-
горию.

2 Щелчком на кнопке New Category создаем новый
альбом и вводим его название. Завершаем ввод
нажатием клавиши ENTER. Теперь можно напол-
нять созданный альбом фотографиями.

3 Переходим на вкладку Folders и выбираем папку,
в которой размещены изображения.
На панели просмотра выбираем фотографии,
которые надо поместить в альбом. Методы выбор-
ки групп снимков стандартные — используем кла-
виши CTRL и SHIFT.

Перетаскиваем выбранные изображения на
вкладку Categories. He отпуская кнопки, пере-
таскиваем значок на название созданного аль-
бома. Отпускаем кнопку мыши. Напротив
названия альбома появляется флажок, а в окне
просмотра — эскизы фотографий.
Содержимым альбома управляют методом уда-
ления или добавления фотографий через
команды контекстного меню. Причем удаляют-
ся только ярлыки в альбоме, сама фотография
остается нетронутой.

• I Marfino
i D _i NOVIKOV
j D О Pasport
\ О £S Rossya_l
I _ J Selected

И SetecbedJH
_ j Vietkong
J Zima
j Отобрано

j Город_01

I O
; О
\ П
I •
! D - «
]

к..'
I269x837x24b 128Qx960x24b

New_OOl.psd New_002,psd

]

Э Природа_О1

j Снимки, дача, 2
i О „J Снимки, дача, август г
• -,,:> Снимки, дача, июль_2С

! D _j Снимки, дача, май_2ОО
| • „1 Program_Rtes

New_006.psd New_OO:

Вкладка Categories
Кнопка New Category •
Категория Альбомы •-

Категория Люди •-

Категория Места ••

Категория Разное

Категория Запись диска •

Е«е ЕЛ View Cceate

э/ р
' Search

7 6



Получение изображений
Внешними источниками изображений

в программе ACDSee считаются:
• любые внешние накопители;
• цифровые фотокамеры;
• устройства, поддерживающие универ-

сальный протокол TWAIN.
Для получения изображений из этих источ-

ников следует дать команду File > Acquire Images.
Операция проходит под руководством масте-
ра (Wizard). В окне мастера на левой панели
необходимо выбрать категорию источника изоб-
ражений, а на правой панели — конкретное
устройство. После щелчка на кнопке Далее
программа сканирует устройство и представ-
ляет в окне эскизы найденных графических
файлов. По умолчанию выбираются все фай-
лы. Кнопкой Clear All можно отменить выбор-
ку, кнопкой Select All вновь выбрать все фай-
лы. Эскиз каждого файла снабжен флажком.
Снятие флажка отменяет выборку, установка
включает изображение в выборку.

Проблема именования файлов
Известно, что в цифровой камере изо-

бражения именуются порядковым номером,
например PICT0121. После удаления файлов
нумерация начинается заново. Так в разных
папках скапливаются десятки файлов с оди-
наковыми именами.

В программе ACDSee предусмотрено спе-
циальное средство Batch Rename (Tools > Batch
Rename), позволяющее произвольно именовать
файлы изображений. Шаблон имени и способ
нумерации задают на вкладке Template.

Template search and Replace Advanced Options
@Use Template to rename files

(•)Use numbers to replace #'s
О Use tetters to replace #'s

Start at:

5 1 1 I

Insert metadata at the cursor position:

| Insert Metadata... |

Template;

Дача_###

Clear Templates

Current Name
| Июль.РС

PiCTOSCM.JPG
PICTQ506.JPG
PICT0507.PG
PICT0.507.psd
PICT0508.PG
PICT0511.JPG
PICT0512.JPG
PICT0513.JPG
PICT0514.JPG
PICT0515.JPG
PICT0516.JPG
PICTG517.JPG
PICT0518.JPG
PICT0520.JPG
PICT0527.JPG
PICT0528,JPG

i PiCT0529.JPG
\ PICT0530.3PG

PICT0531.JPG

New Name

flaMajDOl.JPG
fla4a_002,FG
fla4a_003.PG
fla4a_004.PG
Дача_005,рзс)
Дача_О0б.РС
{\ача_007.УРп
fla4a_008.PG
fla4a_009.PG

fla4a_014.JPG
fla4a_015.PG
Дача_01б.РС
fla4a_017.PG
fla4a_018.PG

Мастер Acquire Images, автоматически запу-
скаемый при получении изображений, так-
же имеет средство переименования файлов.
В окне мастера следует указать способ име-
нования файлов и папку для копирования
(перемещения).

По умолчанию на панели File names (Имена
файлов) установлен переключатель Keep origin-
al file names (Оставить прежнее имя файла). При
установке переключателя Rename using templ-
ate (Переименовать с использованием шаблона)
появляется возможность присваивать имена
копируемым файлам в соответствии с задан-
ным шаблоном. Параметры шаблона задают в
окне Edit File Template, открываемом щелчком на
кнопке Edit. Командная кнопка Insert Properties
открывает окно свойств, учитываемых при
формировании имени файла.

Template:
###<Camera:Modei>

Insert Property,,.

Insert Sequence Number

Sample: IDiMAGE F100

OK Cancel

В поле Template вводят шаблон имени файлов. Значками #
задают позиции для автоматической нумерации файлов

Созданный шаблон имени файла содержит трехзначный
порядковый номер и название модели фотокамеры

На панели Destination Folder указывают папку
или устройство, куда будут скопированы файлы.
Установка флажка Delete picture from my device
after copying them включает режим перемеще-
ния файлов. Установка флажка Automatically
rotate pictures after transferring включает режим
автоматического поворота изображений аль-
бомной ориентации.

В завершающем окне мастера по умолчанию
установлен флажок Browse new pictures. Если
его не снять, после щелчка на кнопке Готово
программа автоматически переходит в папку,
в которую были скопированы изображения.
Если полученные имена файлов не устраи-
вают, можно прибегнуть к помощи средства
Tools > Batch Rename.
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Просмотр изображений
Для общего обзора изображений в папке

удобнее всего использовать режим Thumbnails
(Эскизы). Параметры отображения настраива-
ют по своему вкусу

В окне программы ACDSee имеется панель
предварительного просмотра, в которой отоб-
ражается рисунок, выбранный в списке фай-
лов. Рисунок автоматически масштабируется
по размерам области просмотра, но не крупнее
его исходного размера. Изменяют масштаб с
помощью контекстного меню. Щелкните в обла-
сти просмотра правой кнопкой мыши и выбе-
рите нужный пункт. Кроме режима Auto Size
(Автоподбор) предлагаются варианты Full Size
(Полноразмерное), уменьшенное в два, четыре
или восемь раз изображение.

Если размер изображения больше области
просмотра, виден только фрагмент рисунка.
Чтобы увидеть другую часть рисунка, пере-
тащите изображение.

Для внимательного изучения одного или
нескольких изображений используют режим
просмотра. Переход из режима обзора в режим
просмотра и обратно осуществляется нажатием
клавишы ENTER или двойным щелчком мыши
на изображении. В режиме просмотра в окне
отображается только один рисунок. Для пере-
хода к следующему или предыдущему изобра-
жению служат кнопки Previous (Предыдущее) и
Next (Следующее). Им соответствуют клавиши
PAGE UP или PAGE DOWN.

Управлять просмотром удобно кнопками
панели инструментов или клавиатурными
командами. Менять масштаб просмотра про-
ще всего кнопками Zoom In (Увеличить масштаб)
и Zoom Out (Уменьшить масштаб). Им соответ-
ствуют клавиши «+» и «-» на дополнительной
панели клавиатуры. Однократная команда
изменяет масштаб примерно в полтора раза.
Если изображение больше окна, область про-
смотра перемещают методом перетаскивания
в нужную область рисунка.

Настройка просмотра

В ЛЮБОМ РЕЖИМЕ ПРЕДСТАВЛЕНИЯ ПОРЯДОК

ОТОБРАЖЕНИЯ ЗНАЧКОВ НА ПАНЕЛИ

ИЗМЕНЯЮТ ЧЕРЕЗ МЕНЮ VIEW > SORT

Настраиваем параметры отображения рисун-

ков в режиме обзора.

Даем команду Tools > Options (Сервис >

Параметры).

На левой панели выбираем категорию File

List > Thumbnail Display (Список файлов >

Отображение эскизов).

Thumbnail Display

В раскрывающемся списке Thumbnail Size

(Размер эскиза) задаем размер уменьшенно-

го изображения (в пикселах).

Движком Thumbnail spacing (Расстояние

между эскизами) устанавливаем промежутки

между отдельными значками.

Установкой флажков определяем дополни-

тельную информацию, отображаемую рядом с

эскизами.

Щелчком на кнопке ОК сохраняем заданные

параметры.

При необходимости в окне программы изменя-

ем размер эскизов перемещением движка.

1,4 MB 2272xl7O4x24bjp«9 Modified Date: 05,07.2003 20:07:24 23% Loaded in 0.43 s

Окно программы ACDSee в режиме просмотра. Панель
инструментов размещена в верхней части окна. В строке
состояния представлены основные свойства изображения
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Операции с файлами
Копирование и перемещение файлов

изображений желательно выполнять средства-
ми ACDSee. Для этого достаточно в окне про-
граммы перетащить значок из списка файлов
на значок папки назначения, представленный
на любой панели программы.

Принцип выбора конкретной операции заим-
ствован из системы Windows. По умолчанию
при перетаскивании в пределах одного диска
происходит перемещение файла. Для копиро-

Копирование группы файлов

Настраиваем параметры копирования командой
Edit > Copy to Folder. Откроется диалоговое
окно Copy files (Копирование файлов).

2 Если это диалоговое окно использовалось
ранее, на вкладке History представлены папки,
служившие местом назначения. Выбираем нуж-
ную папку в этом списке или в дереве папок на
вкладке Folders. Имя папки назначения можно
ввести в поле Destination вручную.

| Если нужной папки не существует, создаем ее с
помощью кнопки Create Folder. Способ разре-
шения конфликтов с именами файлов задаем в
раскрывающемся списке Overwriting duplicate
files. Кроме стандартных вариантов Replace
(Переписать) и Skip (Пропустить), предусмо-
трены методы Rename (Переименовать) и Ask
(Запросить). При выборе переименования в
конец имени файла добавляются символы «_2»,
«_3» и т. д.

В режиме запроса при совпадении имен файлов
откроется диалоговое окно Confirm File Replace.
В нем приводятся параметры файла, эскиз изо-
бражения и его свойства.

вания удерживайте клавишу CTRL — рядом с
указателем мыши появится значок «+». При
переносе файла на другой диск обычно выпол-
няется копирование. Для перемещения фай-
ла на другой диск следует удерживать кла-
вишу SHIFT.

Если требуется скопировать группу фай-
лов или в папке-приемнике уже могут быть
дубликаты копируемых файлов, лучше исполь-
зовать описанный ниже прием, позволяющий
избежать конфликта имен.

Преобразование формата файлов

Если изображения помещаются в одну коллек-
цию, имеет смысл привести их к единому фор-
мату.
В режиме обзора выбираем преобразуемые
файлы, даем команду Tools > Convert File
Format.
Выбираем нужный формат из списка.

Format Advanced Options

( JPG JPEGI PNG Portable Network Graphics) PSD5 SUN Rasterfite Image1 Red Storm File FormatSGI Imagek TargaTIFF Tag Image Fite Format

При активной кнопке Format Settings можно
настроить соответствующие формату параме-
тры. Например, для формата JPEG можно отре-
гулировать степень сжатия.
После щелчка на кнопке Далее задаем допол-
нительные параметры преобразования, в част-
ности место размещения преобразованных фай-
лов. Раскрывающийся список Overwrite existing
files предназначен для разрешения конфликт-
ной ситуации в случае совпадения имен.
Установка флажка Remove original files обеспе-
чивает удаление оригинала. После преобразо-
вания остается только измененный файл.
После щелчка на кнопке Далее задаем метод
обработки многостраничных документов (воз-
можности выбора зависят от конечного форма-
та файла).

Щелчок на кнопке Start Convert запускает про-
цесс преобразования.
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Слайд-шоу

Слайд-шоу — это режим просмотра груп-
пы изображений с автоматической сменой
кадров. Такой режим используют при демон-
страции последовательности картинок, когда
нужно сосредоточить внимание на содержа-
нии изображений, не отвлекаясь на управле-
ние показом.

В режиме просмотра имеется возмож-
ность автоматической смены картинок — это
не слайд-шоу в полном смысле этого слова, но
тоже удобный режим. Включают его клави-
шей PAUSE. Остановка просмотра выполняет-
ся той же клавишей, либо клавишами PAGE UP
или PAGE DOWN. Если перейти к следующему
или предыдущему изображению клавишами
ПРОБЕЛ или BACKSPACE, автоматическая сме-
на картинок будет продолжаться.

Слайд-шоу в прямом смысле слова мож-
но запустить из режима обзора или из режи-
ма просмотра. Первый вариант удобнее, если
нужно заранее отобрать демонстрируемые
изображения, а второй — если надо показать
все фотографии, находящиеся в определен-
ной папке.

Слайд-шоу демонстрируется в полноэкран-
ном режиме. При необходимости управляют
ходом процесса с помощью панели инструмен-
тов, которая располагается в нижней части
окна.

Приостановить воспроизведение позволяют
кнопки Пауза и Стоп. Продолжают просмотр
щелчком на кнопке Воспроизведение, которая
появляется на месте кнопки Пауза при останове.
Если для остановки использована кнопка Пауза,
показ продолжится с текущего изображения,
если Стоп — с первого кадра слайд-шоу.

Кнопки Предыдущее изображение и Следующее
изображение позволяют немедленно сменить
текущий рисунок. Кнопка Выход используется
для завершения просмотра слайд-шоу.

Независимо от способа запуска слайд-шоу
программа ACDSee выдает окно с элементами
управления параметрами демонстрации. Два-
три тренировочных показа позволят подобрать
удобные настройки. Для использования теку-
щих свойств демонстрации в последующих
слайд-шоу установите флажок Save current
settings as default.

Быстрый запуск слайд-шоу

В режиме просмотра
Даем команду View > Slide Show (Вид > Слайд-
шоу).

В диалоговом окне Slide Show Properties
(Свойства слайд-шоу) задаем необходимые
параметры.

Щелчком на кнопке ОК запускаем слайд-шоу.
В окне демонстрируются все изображения теку-
щей папки.
В режиме обзора
В списке файлов выбираем группу изображе-
ний, включаемых в слайд-шоу. Для выбора
используем стандартные приемы Windows.
Даем команду Tools > Slide Show.
В диалоговом окне Slide Show Properties зада-
ем необходимые параметры.
Щелчком на кнопке ОК запускаем слайд-шоу.
В окне демонстрируются только выбранные
фотографии.

Вкладка основных свойств

Select transition effects
• Bam Doors
•
П inset
01T1S

• Palate

П Radial Wipe

П Slide

D Spiral

П Stretch

Г] Venetian Blinds

Wheel

D Zigzag

Панель выбора эффектов

Время демонстрации изображения
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В диалоговом окне Slide Show Properties наибо-
лее важны вкладки Basic (Основные) и Advanced
(Дополнительные). На вкладке Basic задают
эффекты перехода от одного изображения к
следующему. Программа ACDSee поддержи-
вает двенадцать разных эффектов. При выбо-
ре любого из них замена картинки происходит
постепенно. Включенные эффекты демонстри-
руются в поле Preview (Предварительный про-
смотр). Цветом фона при просмотре слайд-
шоу и длительностью отображения рисунков
управляют на этой же вкладке.

На вкладке Advanced задают скорость выпол-
нения эффектов перехода. Здесь также при-

сутствуют элементы управления масштабиро-
ванием рисунков (оригинальный размер или
по размеру экрана), порядком их показа (есте-
ственный, обратный или случайный), запуском
циклического воспроизведения слайд-шоу.

Еще одна удобная возможность программы
ACDSee — создание автономного слайд-шоу в
виде исполняемого файла, при запуске кото-
рого происходит демонстрация изображений.
Такой файл при воспроизведении на другом
компьютере не требует никаких сторонних про-
грамм. Однако в исполняемый файл встроены
все изображения, поэтому его размер может
быть очень большим.

г Автономное слайд-шоу

Выбираем фотографии, которые надо вклю-
чить в слайд-шоу.
Даем команду Create > Create Slide Show.

В окне мастера создания слайд-шоу демон-
стрируются выбранные рисунки. Изменить
состав слайд-шоу можно кнопками Add
(Добавить) и Remove (Удалить). Затем нажи-

маем кнопку Далее.
Следующее окно мастера содержит вкладки
Transitions (Переходы) и Advanced (Допол-

нительно). Элементами управления на этих
вкладках настраиваем основные параметры
демонстрации. Нажимаем кнопку Далее.
На панели Image Size (Размер изображения)

устанавливаем размер рисунков. Они могут
отображаться в реальном размере (Actual
Image Size) или согласно заданному размеру.
При уменьшении размера изображений умень-
шается объем файла слайд-шоу, но и качество
картинки падает.

На панели File name and location (Имя и
местонахождение файла) указываем, куда
поместить файл слайд-шоу. Имя вводим вруч-
ную или выбираем с помощью кнопки Browse.
Нажимаем кнопку Далее для запуска процесса
создания исполняемого файла.
По завершении операции щелчком на кнопке
Готово закрываем окно.
Работоспособность исполняемого файла про-
веряем запуском слайд-шоу.

Click Add to browse for more Images, or «elect an image and click Remove to exclude it from your slide
Selected images

P1CTQ001.PG PlCrOO04.JPG PICTOOO5.3PG PICTOOQ6.3PG PlCTO007.JPG

PICTOOOS.JPG P1CTOOO9.3PU P1CTO010.PG Р1СТО0И, Я

Демонстрация состава слайд-шоу

ЁЭ 0Э_09_03
_j 0Э0927_Бот_йад
й> ОЭ092В_}Соломенское

a o e j M j M
ЁЮиМЦЯ
gj 07_09_03
„4 ое_ое_оз

„> 15„09„2О>4

PICTi«^4,3PG P1CTC«>*5.3PG PICTOCM6.PG

PICTQO47.PG PICT0048.JPG PICTC

: PICTOOO6.PQ P1CT0007.PS P1CTOO21.3PS Р1СТОО31.УЙ P1CTDO36.3PG Р1СПХ143.3Р6 Р!СТОСМв.ЗР5

Добавление фотографий из других папок и категорий
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Цифровое изображение

ОСНОВН А ПРИ РАБОТЕ С ЦИФРОВЫМ ИЗОБРАЖЕНИЕМ СОСТОИТ В ТОМ, ЧТОБЫ ИЗС БРАЖЕНИЕ

НА ЭКРАНЕ МОНИТОРА ТОЧНО СООТВЕТСТВОВАЛО КАК ТОМУ, ЧТО БЫЛО ЗАФИКСИРОВАНО

ФО1 )Й, ТАК И ТОМУ, ЧТО БУДЕТ НАПЕЧАТАНО НА ПРИНТЕРЕ

Физика и
физиология цвета

Простейшие
цветовые
модели

Алгебра
цвета

Цветовые
пространства

Цветотехническая
модель Lab

Управление
цветом

^ цифровой фотографией
t-^на более-менее серьезном уров-
не подразумевает самостоятельную
обработку снимков. Отсюда вытека-
ет необходимость изучения таких
настроек компьютерной системы, о
которых раньше не приходилось заду-
мываться. Основная задача состоит
в том, чтобы изображение на экра-
не монитора точно соответствовало
как тому, что было зафиксировано
фотокамерой, так и тому, что будет
напечатано на принтере. Проблема
приобретает особую важность, если
снимки обрабатывают на разных ком-
пьютерах, например дома и на работе,
и печатают на разных принтерах.

Цифровое изображение нельзя
обрабатывать «на глазок». У одно-
го компьютера монитор может быть
настроен одним способом, а у друго-
го — другим. В одном случае печата-
ют на принтере компании Epson, а в
другом — на изделии Canon. Кто-то,
возможно, вообще предпочтет отправ-
лять файлы на печать в сервис-центр
и не может знать, какое там установ-
лено оборудование.

Чтобы цифровое изображение,
зарегистрированное камерой, точно
соответствовало тому, что представ-
лено на экране монитора и тому, что
будет получено при печати, устрой-
ства и программы, участвующие в
работе со снимком, должны опирать-
ся на единое понятие о цвете. Говоря
точно, все компоненты компьютерной
системы должны работать в едином
цветовом пространстве.

Играя на компьютере в игры или
просматривая кинофильмы, вы могли
как угодно менять настройки мони-
тора, лишь бы глазу было приятно.
Теперь придется не только забыть
об этой свободе, но еще и оградить
монитор от вмешательства посторон-
них. Надо создать и закрепить единое
цветовое пространство для фотокаме-
ры, монитора, принтера и программ.
Причем, если предполагается куда-
то отправлять снимки в электронном
виде (публиковать их в Интернете
или передавать в сервис-центр для
печати), то крайне желательно, что-
бы рабочее цветовое пространство не
слишком отличалось от общеприня-
того. Лучше никак не обрабатывать
снимки и передать их в сервис-центр
по принципу «как есть», чем редак-
тировать их «на глаз» в некорректно
настроенном или вовсе неизвестном
цветовом пространстве.

Начиная разговор о цветовом про-
странстве, мы вторгаемся в околона-
учную сферу, изрядно насыщенную
новыми терминами. Поэтому нам при-
дется сделать важное отступление,
чтобы ввести основные понятия и
рассказать:
• о том, как происходит восприя-

тие цвета человеком;
• о существующих психофизио-

логических цветовых моделях;
• о том, как числами выражают

параметры цветности;
• о способах управления цвето-

вым пространством в компью-
терных системах.
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Физика и физиология цвета

Свет — это электромагнитные волны опре-
деленного диапазона — от 375 до 780 нано-

метров (10~9 м). Для сравнения скажем, что их
длина волны примерно в тысячу раз меньше
тех, что используются в СВЧ-плитах, в десят-
ки тысяч раз короче волн сотовой телефонии и
спутникового телевидения и в миллионы раз
короче волн, используемых в обычном эфир-
ном телевидении.

Излучение с длиной волны менее 375 нм
невидимо и называется ультрафиолетовым.
Невидимо также излучение с длиной волны
более 780 нм, которое называется инфракрас-
ным. Внутри же диапазона каждой длине волны
соответствует определенный цвет, наблюдае-
мый человеческим глазом. Например, красно-
му цвету соответствуют волны длиной 700 нм,
а оранжевому — 600 нм.

Ультрафиолетовое

излучение

Инфракрасное

излучение

400 нм 500 нм 600 нм 700 нм

В целом диапазон длин волн видимых излу-
чений довольно узок. Его правый и левый пре-
делы различаются по частоте всего лишь в два
раза. Если условно спроецировать этот диа-
пазон на диапазон слышимого звука так, что-
бы красному цвету соответствовала нота «до»
первой октавы, то фиолетовому цвету будет
соответствовать нота
«си». То есть, весь диа-
пазон видимых цвето-
вых оттенков займет
всего лишь одну окта-
ву слышимого звука.
Для сравнения скажем,
что слух человека спо-
собен различать звуки
девяти октав.

Но узость видимого диапазона отнюдь не
означает бедности воспринимаемой цветовой
палитры. Большинство людей уверенно раз-
личают миллионы цветовых оттенков.

Физиология цвета
Люди улавливают световые волны с

помощью глаз. В сетчатке глаза есть свето-
чувствительные клетки двух видов: палочки
и колбочки. Палочки обладают более высокой
светочувствительностью, чем колбочки. Они
отвечают за зрение при недостатке света.

Колбочки, в свою очередь, обеспечивают
цветовосприятие. Оно основано на том, что
один и тот же свет вызывает разную реакцию
в колбочках, чувствительных к лучам разных
длин волн. Анализируя сигналы, поступаю-
щие от колбочек разных типов, мозг форми-
рует ощущение цвета.

Большинство людей имеют колбочки трех
типов, которые проявляют наибольшую чув-
ствительность к лучам длиной 450, 550 и 600 нм.
Условно эти колбочки можно считать сине-
чувствительными, зелено-чувствительными
и красно-чувствительными.

Интересно отметить, что в области зелено-
го цвета, наиболее распространенного в при-
роде, глаз не имеет специальных рецепторов,
зато этот цвет способны регистрировать кол-
бочки всех трех типов. Так что на самом деле
зелено-чувствительных колбочек нет, а ощу-
щение зеленого цвета, как и миллионов иных
цветов, — это продукт работы мозга.

Восприятие цвета

Каждый тип колбочек особо выделяет световые волны
определенной длины, но зеленые тона регистрируют колбочки
всех типов
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Простейшие цветовые модели

Из того факта, что глаз и мозг, действуя
совместно, синтезируют представление

о цвете по сигналам, полученным от колбочек
трех разных типов, следует, что произвольный
видимый цвет можно представить комбинаци-
ей нескольких (не более трех) базовых цветов.
Правда, надо еще договориться, какие цвета
взять за основу На сей счет существуют раз-
ные подходы. Их закрепляют в так называе-
мых цветовых моделях.

Цветовые модели — это абстракции, удоб-
ные прежде всего тем, кто в силу обстоятельств
имеет счастье работать с цветом и кому при-
ходится описывать цвета, воспроизводить их
по описанию, сохранять и передавать данные
о цвете. В эту обширную категорию попада-
ют не только фотографы, но также издатели,
полиграфисты, работники телевидения и кине-
матографии, дизайнеры интерьеров и моделей
одежды и даже простые маляры. Добавьте
сюда еще разработчиков принтеров, сканеров,
проекторов, мониторов. Надо ли после этого
удивляться тому, что существует великое мно-
жество цветовых моделей? Каждому хочется
иметь модель, которая наилучшим образом
подходит для решения его задач.

Радуга
Радуга — простейшая цветовая модель,

предложенная самой природой. На примере
радуги люди постигают магию цвета и порядок
следования цветов: красный, оранжевый, жел-
тый, зеленый, голубой, синий и фиолетовый.

Цветовое колесо
Цветовое колесо — самая наглядная цве-

товая модель. В цветовом колесе шесть цветов,
расположенных по секторам круга в следующем
порядке: красный, желтый, зеленый, голубой,
синий и пурпурный. Как видите, цветовое коле-
со — это та же радуга, лишенная оранжевого
цвета. Сделано это ради симметрии, которая
в этой модели играет важную роль.

У цветового колеса есть два полезных свой-
ства:
• каждый цвет модели может быть получен

сочетанием двух его соседних цветов;
• диаметрально противоположно каждому

цвету находится его дополнительный
цвет.
Дополнительным для данного цвета назы-

вается цвет, дополняющий его до белого.

Обозначения цветов

Основные цвета

1 R

J G

1 В

Red
Green
Blue

Дополнительные цвета

I е

1 м
"Y

Cyan
Magenta
Yellow

Красный

Зеленый

Синий

Голубой

Пурпурный

Желтый

Нейтральные цвета

| W

ШИННИк
White
blacK

Белый

Черный
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Алгебра цвета

Если свойства цветового колеса записать
формально, мы получим основные цвето-

вые соотношения. При всей своей простоте они
достаточно полезны. Может быть, не каждому
захочется их запомнить, но понимать их начи-
нающий фотограф все-таки должен.

Первые две группы соотношений позволя-
ют выразить каждый цвет модели через два
смежных цвета.

Ш =Ш 0) © = (2)

Соотношения третьей группы связывают
между собой взаимодополнительные цвета.
Связь происходит через белый цвет.

+щ=щ

Аддитивное взаимодействие
Соотношения (3) справедливы для тако-

го взаимодействия световых потоков, когда их
яркости складываются, то есть потоки взаим-
но осветляют друг друга. Такая модель взаи-
модействия цветных лучей называется адди-
тивной. Характерный пример аддитивного
взаимодействия — наложение пятен света от
театральных прожекторов. В том месте, где они
пересекаются, яркость больше, чем в каждом
из пятен порознь.

С аддитивным механизмом цветообразо-
вания мы имеем дело, когда рассматриваем
самосветящиеся объекты (экраны телевизо-
ров или мониторов), а также объекты, осве-
щенные проходящим светом (проекционные
экраны).

Светочувствительная матрица цифрового
фотоаппарата регистрирует приходящий свето-
вой поток согласно аддитивной модели. Каждый
светочувствительный элемент способен вос-
принимать только яркость, ибо накапливает
заряд пропорционально количеству попавших
на него фотонов. Для того чтобы зарегистри-
ровать цвет, приходится устанавливать перед
матрицей набор цветных фильтров, соответ-
ствующих аддитивной модели RGB. Обычно
в таком комплекте число зеленых элементов
удвоено, поскольку, как мы отмечали ранее,
зрение человека более чувствительно к зелено-
му цвету. В итоге комплект фильтров выглядит
как RGBG (фильтр Байера). Ячейки фильтра
размещают псевдослучайным образом.

Иногда вместо второго зеленого фильтра
ставят особый фильтр, подчеркивающий опре-
деленный оттенок. Например, компания Sony
использует фильтр Emerald (изумрудный).

К сказанному можно добавить, что и сам
глаз человека работает согласно аддитивному
механизму. Чем больше световых импульсов
зарегистрирует сетчатка, тем более сильный
сигнал отправляется на обработку в головной
мозг, тем выше кажущаяся яркость объекта.
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Субтрактивное взаимодействие
Наверное, соотношения (3) могут устро-

ить только взрослого читателя, привыкше-
го доверять всему, что пишут в книгах. А вот
здравомыслящий ребенок младшего школьного
возраста, узнав о том, что смешением красок
можно получить что-то новенькое, сразу же
берется за цветные карандаши... И конечно,
очень быстро понимает, что сколько ни смеши-
вай красное с голубым, ничего, кроме грязной
серости, не получишь. А еще он замечает, что
чем старательнее красить, тем ближе эта серость
к черному цвету, но никак не к белому.

Это действительно так, но не потому, что
наши выводы не верны, а потому, что здесь
речь идет не о взаимодействии цветных потоков
света друг с другом, а о взаимодействии лучей
света с поверхностью тела. В ходе этого вза-
имодействия часть светового потока отража-
ется в сторону глаз наблюдателя, но это имен-
но часть, а не весь поток, потому что какие-то
лучи из общего потока вычитаются. Какие
именно — зависит от свойств поверхности.
Такой «вычитательный» механизм образова-
ния цвета называется субтрактивным. При
субтрактивном взаимодействии результиру-
ющая яркость нескольких красок меньше, чем
любой из исходных в отдельности.

Белый свет, упавший на бумагу, окрашивается после вычитания
из него лучей, поглощенных красителем. Поскольку нам важно
воспроизвести не точный спектральный состав света, аналогичный
объектам реального мира, а цветовые ощущения человека,
адекватные наблюдаемой сцене, то состав и соотношение
красителей могут быть совершенно произвольными

С субтрактивным механизмом мы имеем
дело, когда наблюдаем цветные объекты в отра-
женном свете. Для цветной фотографии осо-
бенно важно, что именно в отраженном свете
мы рассматриваем иллюстрации в книгах и
фотоснимки, напечатанные на бумаге.

При субтрактивном взаимодействии соче-
тание взаимодополнительных цветов дает не
белый цвет, а черный, и приведенные выше
формулы (3) следовало бы записать иначе.

ш + ш = о

Однако практического интереса соотноше-
ния (З1) не представляют, потому что никто не
собирается получать черный цвет смешением
чистых красителей. Для этого есть гораздо
более простые и дешевые средства. Поэтому
формулы для субтрактивных процессов все-
таки записывают через белый цвет, но сложе-
ние заменяют вычитанием.

|У1 = wj — га

Соотношения (3м) и (3"?) имеют весьма важ-
ный практический смысл. Они показывают, как
из одной тройки цветов (RGB) через белый цвет
получить цвета другой тройки — CMY.

Цвета RGB принято называть основными,
а цвета CMY — дополнительными. На самом
деле эти тройки взаимодополнительны и совер-
шенно равноправны, так что их названия — это
еще одна условность. Главное — то, что, ком-
бинируя составляющие цвета либо той, либо
другой тройки, теоретически можно получить
любой произвольный цвет. Благодарить за это
надо физиологическую трехцветность челове-
ческого зрения (три типа колбочек).
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Цветовые пространства

Рассматривая цветовые модели, всегда под-
черкивают, что получить можно «теорети-

чески любой» цвет. На практике не бывает ни
идеальных красителей, ни идеального белого
света, ни идеальной белой бумаги. Плюс, как
уже отмечалось ранее в нашей книге, имеет-
ся очень большая проблема с передачей всей
ширины динамического диапазона, доступ-
ного глазу.

Для цифровой фотографии на этапе реги-
страции изображения гораздо важнее не меха-
низм получения произвольного цвета из состав-
ляющих, а наоборот, механизм разложения
любого произвольного цвета на составляю-
щие. Такой механизм позволяет выразить и
записать любой произвольный цвет числа-
ми, указывающими интенсивность каждой
составляющей. В зависимости от того, какие
составляющие избраны для данной цветовой
модели, сделать это можно бесконечным чис-
лом разных способов, например:
• в координатах К, G и Б;
• в координатах С, М и Y;

• в одной из производных систем коорди-
нат, например (R-G), (B-R-G), (R+G+B);

• в любой системе координат А, В и С, для
которой определены соотношения, связы-
вающие значения А, Б и С со значениями
R, G, В или С, М и Y.
Таким образом, налицо возможность запи-

сывать цвета в бесконечном множестве систем
координат. Но если каждый человек, каждый
прибор и каждая программа будут работать
в своем собственном цветовом пространстве,
то согласовать их действия при записи, редак-
тировании и воспроизведении изображений
практически нереально.

Цветовое пространство RGB
Цветовое пространство RGB принято

использовать в двух случаях:
• когда в момент записи изображения цвет

регистрировался по аддитивному меха-
низму (лучи складывались);

• когда технологии воспроизведения осно-
ваны на аддитивном механизме.

А

Модель образования цветного
изображения в пространстве RGB
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На практике в цветовом пространстве RGB
записываются и обрабатываются следующие
изображения:
• созданные цифровой фотокамерой (или

видеокамерой);
• записанные большинством сканирующих

устройств;
• предназначенные для воспроизведения на

экране монитора;
• предназначенные для воспроизведения

мультимедийными проекторами.
Яркость каждой из трех цветовых состав-

ляющих выражают целым числом. Обычно
это 8-битное число от 0 до 255. Нулевые зна-
чения соответствуют минимальной яркости.
Соответственно, черный цвет имеет значение
(О, 0, 0), а белый цвет — 255, 255, 255.

В последние годы появились фотокамеры,
способные работать с 12-разрядным представле-
нием цвета (от 0 до 4095) и даже с 14-разрядным
представлением (от 0 до 16 383). В связи с этим
в ряде программ (например, в Adobe Photoshop)
поддерживается возможность 16-разрядно-
го представления цветовых составляющих.
В этом случае на запись информации о цвете
одной точки в пространстве RGB расходует-
ся 48 бит данных.

Цветовое пространство CMYK
В то время как процессы, основанные

на аддитивном механизме, принято обраба-
тывать в цветовом пространстве RGB, на долю
дополнительного цветового пространства CMY

Модель образования цветного
изображения в пространстве CMYK

ПО-АНГЛИЙСКИ CMYK ПРОИЗНОСИТСЯ КАК

«СМАЙК», НО В РОССИИ СО ВРЕМЕН ПУШКИНА

ПРИНЯТА ФРАНЦУЗСКАЯ ТРАНСЛИТЕРАЦИЯ.

ПОЭТОМУ КОГДА ПРОФЕССИОНАЛЫ ГОВОРЯТ

«ЦМИК», НЕ СПЕШИТЕ ИХ ПОПРАВЛЯТЬ

выпало обслуживание субтрактивных процес-
сов цветообразования.

Субтрактивный механизм образования цве-
та чаще всего ассоциируется с полиграфией,
а также с печатью цветных фотографий на
принтерах. При этом одной из наиболее важ-
ных проблем является получение черного цве-
та, корректного не только с технической, но и с
эстетической точки зрения. Теоретически, его
можно получить смешиванием трех красите-
лей, но это лишь теоретически. На практике
есть несовершенство красителей, имеется так-
же разброс в свойствах используемой бумаги.
Добавьте к этому принципиальную невозмож-
ность заранее предсказать, при каком осве-
щении будут читать книгу или рассматри-
вать фотографию, а ведь цветовые свойства
печатных изображений существенно зависят
от свойств света, падающего на них.

Эту проблему решили просто: ввели четвер-
тый краситель — черный, и для субтрактивных
процессов используют четырехкомпонентное
пространство CMYK. Здесь буква К соответ-
ствует черной составляющей — ЫасК. Ко вре-
мени введения этой модели буква Б уже была
занята синей компонентой модели RGB.
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Как и в модели RGB, яркость каждой из
четырех составляющих записывают целым
числом. Обычно это число от 0 до 100, на запись
которого расходуется один байт. Всего же на
запись цвета в цветовом пространстве CMYK
расходуется 4 байта (32 бита).

В противоположность модели RGB нулевое
значение соответствует максимальной ярко-
сти (минимум вычитания), то есть значение 0,
0, 0, 0 выражает белый цвет, а черному цвету
соответствуют все значения С, М, Y, 100 при
любых значениях С, М, Y.

По многим соображениям в готовом изоб-
ражении целесообразно заменять многочис-
ленные варианты черного цвета каким-нибудь
одним, например (0, 0, 0, 100). Однако у про-
фессиональных дизайнеров существуют свои
фирменные рецепты черного цвета. Кто-то
считает, что лучший черный — (0, 20, 0, 100),
а кто-то полагает, что легкая примесь голу-
бого (40, 0, 0, 100) дает черному благородную
глубину. Впрочем, надо также учитывать и
сюжет снимка. Черный цвет, хороший для
рояля, не годится для изображения темноко-
жего пианиста.

Цветовой охват
Если сравнить красочность современной

киноленты с цветным фильмом полувековой
давности, то сравнение будет явно не в поль-
зу классики. Конечно, это не говорит о том,
что раньше жизнь была мрачной, а сегодня
вдруг прояснилась. Дело в химических веще-
ствах, которые использованы в светочувстви-
тельном слое кинопленки. Понятно, что более
совершенные материалы дают более красоч-
ные изображения.

То же явление мы обнаружим, сравнивая
современный телевизионный приемник на кине-
скопе с образцом тридцатилетней давности.
И там, и здесь ячейка экрана имеет три цвет-
ных элемента: красный, зеленый и синий, но
применение более совершенных люминофоров
позволяет воспроизвести большее количество
цветовых оттенков.

Диапазон воспроизводимых оттенков назы-
вается цветовым охватом. Он характеризует
не только изображение, но и устройства вос-

произведения, и всю систему записи и воспро-
изведения цвета.

Для занятия цифровой фотографией надо
хорошо понимать, что цветовой охват про-
странства CMYK существенно меньше, чем
цветовой охват пространства RGB.

Этот факт связан совсем не с тем, что цвета
С, М и Y чем-то хуже цветов К, G и В. Дело не
в конкретных цветах, а в механизме цветооб-
разования. При аддитивном механизме шире
возможности по управлению яркостями цве-
товых составляющих. Разброс между самыми
яркими и наиболее темными тонами вполне
может составлять четыре порядка и более.

В свою очередь, при субтрактивном меха-
низме у нас не бывает достаточно ярких тонов.
Наиболее яркое пятно на отпечатке не может
быть ярче самой бумаги, а она, как известно,
не светится, а отражает свет. Поэтому яркость
отпечатка несравнимо меньше яркости типовых
активных источников. Максимальный разброс
между яркими и темными тонами на отпечат-
ке составляет не более двух порядков.

Субтрактивным способом принципиально
нельзя создать столько же цветов, сколько
позволяют получить аддитивные процессы. Не
совсем научно, зато совсем не скучно этот факт
демонстрирует представленная диаграмма.

Не всякий цветовой тон, успешно воспроизводимый
монитором или проектором, может быть напечатан на бумаге.
На рисунке показано принципиальное различие цветовых
охватов устройств аддитивного и субтрактивного типа
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Из сказанного можно сделать следующие
принципиальные выводы.
1. Цветовой охват монитора RGB обычно

больше, чем принтера CMYK.
2. Если не приняты специальные меры, одно

и то же изображение заведомо выглядит
на экране лучше, чем на бумаге. Это обсто-
ятельство бывает неожиданным для
заказчиков фотопечати. Предварительно
налюбовавшись снимками на экране мони-
тора, они не всегда радостно принимают
отпечатки из лабораторий.

3. Если один и тот же снимок предполагает-
ся использовать как для печати на бумаге,
так и для демонстрации на экране, то луч-
ше сделать две копии изображения и
обработать их по-разному. То, что опти-
мально для печати, не вполне пригодно
для просмотра на экране и наоборот.
Но неужели нельзя сделать так, чтобы печат-

ное изображение соответствовало тому, что
показывает экран?

Да, кое-что сделать можно. Прежде всего,
зная характеристики экранного и печатного
устройств, компьютер способен заблаговре-
менно выявить цветовые области, которые не
могут быть адекватно напечатаны. Эта функ-
ция называется Gamut Warning (Предупреждение
о неполном цветовом охвате).

Сравнение цветовых охватов

1
лШ у

т

\*Щ '

Принтер Epson 1290
J на бумаге Premium
| Semigloss Photo

Paper

Настроенный
калиброванный
монитор
Mitsubishi
2020U \

Офсетный
печатный
станок с
профилем
Euroscale

Настроенный
калиброванный
сканер
Epson 1650

Красные пятна — не дефект снимка, а сигнал программы о
том, что не все цвета могут быть достоверно воспроизведены в
избранном цветовом пространстве (в нашем примере —
в цветовом пространстве принтера Epson 1290)

Можно также принудительно загрубить
изображение на экране, чтобы оно соответ-
ствовало тому, что будет получено при печати.
Разумеется, в мониторах не бывает голубых,
желтых и пурпурных электронных пушек.
Невозможно вообразить пушку, испускающую
лучи черного цвета. Однако то, что нельзя сде-
лать аппаратно, реализуют программно.

В мощных редакторах изображений при-
нято понятие так называемого рабочего цве-
тового пространства. Оно хоть и является
пространством RGB, но искусственно сужено
так, чтобы соответствовать по цветовому охва-
ту CMYK-пространству принтера, на котором
предполагается печатать снимки. Выбор рабо-
чего цветового пространства для обработки и
печати фотографий — это одна из важнейших
настроек. Сделать ее надо своими руками. Ниже
мы покажем, как она выполняется.

9 0



Цветотехническая модель Lab

Совокупность цветовых оттенков, воспро-
изводимых или регистрируемых данным

устройством, образует его цветовое простран-
ство. У каждого устройства оно свое.

Так какое же цветовое пространство считать
базовым, чтобы относительно него проводить
расчеты для прочих устройств? Лучший ответ
на этот вопрос — никакое! Никакое конкрет-
ное физическое устройство не следует исполь-
зовать в качестве базового. Чтобы показать на
устройстве А, как будет выглядеть изображе-
ние на устройствах Б или В, в качестве базового
следует принять пространство, не связанное
ни с одним из этих устройств. Пространство
должно быть аппаратно-независимым.

Такое пространство существует — это
пространство Ь*а*Ъ*. В 1976 г. его ввела в дей-
ствие Международная комиссия по освеще-
нию. Отсюда звездочки в обозначении, чтобы
отличить стандартизированное комиссией про-
странство от прочих (свои Lab-пространства
разрабатывали несколько фирм). Как и про-
странства RGB и CMY, пространство Ь*а*Ъ*
трехпараметрическое.

Многих интересует физический смысл пара-
метров L*, а* и Ь*. На самом деле физическо-
го смысла нет даже в параметре L (Lightness,
светлота). Хотя он изменяется от 0 (черный
цвет) до 100 (белый цвет) и соответствует как
бы черно-белой составляющей изображения.
Но светлота — это не физическая яркость, а
ощущение, создаваемое яркостной составля-
ющей изображения.

Параметры а* и Ь* также не содержат ника-
кого прямого физического смысла. Это просто
математические комплексы, приводить которые
в нашей книге было бы неуместно. Однако по
прошествии времени достаточно неожиданно
выяснилось, что у этих величин имеется если
не физический, то физиологический смысл.
Можно считать, что параметр а* соответствует
разности красной и зеленой составляющих в
цвете точки, а параметр Ь* — разности синей
и желтой составляющих.

Переходя к цветоразностной интерпрета-
ции параметров, убирают звездочки в обозна-

чениях (теперь а и Ъ уже не абстрактные мате-
матические комплексы) и ту же самую модель
называют Lab. Изменяются параметры а и Ъ
от —128 до + 127. Значение 0 и близкие к нему
соответствуют нейтральному (серому) цве-
ту. Крайние значения соответствуют чистым
цветам.

Цветовой охват пространства Lab много
шире, чем пространства RGB и, тем более,
CMYK. Он соответствует теоретическим воз-
можностям человеческого глаза. Цвета, соот-
ветствующие предельным значениям параме-
тров а и в, не воспроизводятся ни на бумаге,
ни на экране монитора.

Основное достоинство модели Lab заклю-
чается в том, что в ней полностью разорвана
связь между черно-белым информационным
каналом и каналами, несущими информацию о
цвете. При обработке изображений в простран-
ствах RGB или CMYK любое изменение цвета
точки непременно сказывается на ее яркости.
В пространстве Lab редактировать изображе-
ния проще, так как яркость не влияет на цве-
товой тон, а тон не влияет на яркость.

Модель формирования изображения в пространстве Lab
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Управление цветом

Ни одно реальное устройство не может воз-
действовать на зрение человека так, чтобы вос-
произвести все цветовые ощущения, которые он
способен испытывать. Поэтому ни одно реальное
устройство не может полностью соответство-
вать рассмотренной нами модели CIE Lab.

А что делать с цветами, лежащими вне цвето-
вого охвата устройства? Можно, конечно, просто
присвоить им ближайшие цвета, находящиеся
на границе цветового охвата. Но в этом случае
мы можем потерять важную информацию, а
изображение кардинально изменится.

На рисунке показан результат такого опыта. Слева — исходное
изображение. Справа — результирующее. Потеряно большое
количество деталей, по сути, справа — уже совсем другое
изображение

Как правило, человек мириться с такими
потерями не согласен. Если в изображении
имеются цвета, которые лежат вне цветового
охвата устройства, необходимо передать соот-
ношение между ними.

Цветовые профили
В большинстве случаев нам придется

пожертвовать точностью воспроизведения
тех цветов, которые лежат внутри цветового
охвата устройства, чтобы сохранить соотно-
шения между цветами оригинала. Необходимо
так сформировать цветовые ощущения, что-
бы они максимально точно совпадали с ориги-
нальными. В этом случае мы заменяем ориги-
нальные цвета похожими из цветовой палитры
устройства.

Всегда надо помнить, что если не принять
специальных мер, практически всегда два раз-

ных устройства покажут один и тот цвет по-
разному. Но нам-то ведь надо, чтобы они пока-
зывали их одинаково! Сделав снимок любимой
собаки, мы хотим, чтобы все наши знакомые
увидели одинаковые цвета на своих мони-
торах, независимо от того, какая фирма и в
каком году их выпустила. Нас не интересует,
из каких химикатов делали люминофорное
покрытие для конкретного монитора. Нам не
важны рецептуры цветных чернил для принте-
ров. Мы просто хотим быть уверены, что прин-
теры Hewlett Packard, Epson и Canon напеча-
тают наши фотоснимки одинаково.

Если зайти в магазин, где продают телеви-
зоры и изучить два десятка образцов, то мож-
но увидеть, что все они по-разному передают
цвет моря и небес, песка и заката. В принципе,
это не очень страшно, ведь то, что показывают
по телевизору, мы своими глазами не видели и
потому воспринимаем цвета как условные.

А теперь представьте, что по телевизору
показывают ваш дачный домик. Его цвет вам
известен достоверно (сами красили), и здесь
любая фальшь будет болезненной.

Невозможность одинаково представить один
и тот же цвет на разных устройствах связана
с тем элементарным фактом, что у каждого
устройства свой цветовой охват. Трудно рас-
считывать на какое-то единообразие, сравни-
вая с одной стороны экран катодно-лучевой
трубки, а с другой стороны — экран на жидких
кристаллах. Совсем трудно добиться единства
для устройств разных категорий: мониторов,
проекторов, принтеров, сканеров.

Для решения этой проблемы в 1993 г. восемь
заинтересованных корпораций создали меж-
дународный консорциум по вопросу представ-
ления цветных изображений — Image Color
Consortium (ICC). Он утвердил общепринятый
подход к проблеме, основанный на использова-
нии так называемых цветовых профилей.

Любое устройство не идеально, но если оно
служит профессиональным целям, то его можно
откалибровать, используя для этого специаль-
ные приборы (спектрометры и колориметры)
и приспособления (контрольные распечатки и
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тестовые таблицы), а также специальное про-
граммное обеспечение. В этом случае отличия
устройства от некоего стандартного идеала
можно выразить набором числовых данных,
которые называются цветовым профилем
устройства.

В качестве «идеала» международный кон-
сорциум ICC избрал стандартного наблюда-
теля образца 1931 года (того самого, цветовым
ощущениям которого соответствует простран-
ство CIE Lab). А еще консорциум ICC разрабо-
тал формат, в котором записывается профиль
устройства — профильный файл, профайл.

Далее все просто. Файлы с цветными изоб-
ражениями передаются вместе с профилями
устройств, на которых они были созданы или
обработаны. Если профиль имеет огромный
размер и его нецелесообразно прикладывать
к файлу, значит, указывается, какой профиль
был задействован. В последнем случае его
можно взять из драйвера этого устройства
или разыскать в Интернете.

Передавая изображения между устройства-
ми, компьютерная система управления цветом
всякий раз подправляет значения цветов точек,
компенсируя погрешность устройства.

Когда изображение выводится на экран, его цвета корректируются с
учетом профиля монитора и становятся более насыщенными.
А когда изображение передается принтеру, цвета точек, наоборот,
осветляются согласно цветовому профилю принтера

Где искать цветовые профили
Основной источник 7СС-профилей —

драйверы устройств. Производитель обору-
дования лучше, чем кто бы то ни было иной,
знает характеристики своей продукции. Он
тестирует образцы в стандартных условиях,
сравнивает их с эталонами и вводит в профиль
необходимые поправки.

Профиль, как правило, не содержит слож-
ных формул, а представляет собой матрицу
преобразования цветов. Для устройств печати
размер файла с профилем достигает несколь-
ких мегабайт. Ведь приходится записывать
матрицы преобразования цветов для каж-
дого сорта бумаги, для каждого вида красок
или чернил отдельно. Профили для типовых
устройств входят в комплект драйверов, по
размеру гораздо меньше, но работают заметно
хуже. Цветовые профили, поступившие вме-
сте с драйверами устройств, хранятся в папке
C:\Windows\System32\Spool\Drivers\Color\.

Adobe RGB (1998)

Apple RGB
ColorMatch RGB
SRGBIEC61966-2.1

Euroscale Coated v2
Euroscale Uncoated v2
Japan Color 2001 Coated
Japan Color 2001 Uncoated
Japan Standard v2
Japan Web Coated (Ad)
U.S. Sheetfed Coated v2
U.S. Sheetfed Uncoated v2
U.S. Web Coated (SWOP) v2
U.S. Web Uncoated v2

Dot Gain 10%
Dot Gain 15%
Dot Gain 20%
Dot Gain 25%
Dot Gain 30%
Gray Gamma 1,8
Gray Gamma 2.2

CIE RGB
DiamondTron Monitor G22 D93
EPSON Stylus Photo 1290
e-sRGB
Generic Monitor Adobel998RGB D65 WP 2,2 Gamma
Generic Monitor AppleRGB D65 WP 1.9 Gamma
Hitachi Monitor G22 D93
KODAK DC Series Digital Camera
NEC Multisync Monitor G22 D93
NTSC (1953)
PAL/SECAM
ProPhoto RGB

Цветовые профили, установленные в компьютерной системе
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Профиль устройства может с течением вре-
мени меняться. Характерный пример — струй-
ный принтер. Если он был приобретен пару лет
назад, то за это время могли произойти изме-
нения в составе чернил. Мы не имеем в виду,
что чернила испортились. Просто сегодня про-
изводитель делает их чуть лучше, чем вчера,
и чтобы это заметно сказалось на качестве
печати, надо обновить 1СС-профиль.

Если предполагается передать файлы для
печати в лабораторию, полезно выяснить, на
каком оборудовании их будут печатать, после
чего разыскать в Интернете нужные 1СС-про-
фили и настроить на них средства просмотра
и редактирования.

Для типового оборудования цветовые профи-
ли поставляют вместе с операционной системой
и специализированными программами. Так,
например, в операционной системе Windows 98
профили ICC хранятся в папке C:\Windows\
System32\Color.

Ну и наконец, JCC-профиль устройства мож-
но построить вручную в ходе специальной
операции, которая называется калибровкой.
Для профессиональной калибровки монитора
необходимы специальные приборы: спектро-
метры. Они способны замерить объективные
параметры цвета.

При продаже некоторых мониторов полу-
профессионального класса к ним прилагают
специальную программу и бумажный эталон
цвета. Так, например, компания ViewSonic при-
лагает к своим мониторам программу Colorific,
позволяющую удовлетворительно откалибро-
вать монитор.

В домашних условиях простейшую кали-
бровку монитора можно выполнить с помощью
программы Adobe Gamma. Она устанавлива-
ется автоматически вместе с другими про-
граммами от компании Adobe Systems: Adobe
Acrobat, Adobe Photoshop, Adobe Illustrator и
Adobe InDesign.

Калибровка монитора

Простейшую калибровку монитора выполняют в
программе Adobe Gamma. Начинающим пользо-
вателям рекомендуется выбирать режим мастера
(Wizard), дающий пошаговые инструкции.
Даем команду Пуск > Настройка > Панель
управления > Adobe Gamma. В окне программы
устанавливаем переключатель Step By Step
(Wizard). Щелкаем на кнопке Далее. Отмена j

Which version would you lik* (e use*

• Step By Step (VVUewl)

В следующем окне мастера выбираем типовой
профиль люминофора монитора. Для большей
точности выбираем параметр Custom и вводим
данные, предоставленные производителем.
На следующих этапах работы мастера главное —
выставить правильную гамму и цветовую темпе-
ратуру согласно рабочим задачам.

с После открытия следующего окна органами
управления монитора выставляем максимально
приемлемый контраст. Органы управления ярко-
стью ставим в такое положение, чтобы серый пря-
моугольник на фоне черного почти сливался с
фоном, но еще был различим. Программные
средства для этого не использовать!

Th# gamma »««nfl of уош me
, V 1 bnghtyowmi*ont»art.E«al

gemma by adjusting the «iictei
fade» into the patterned deme

У View Singl» Gamma Only

Now choose m* d«»n«d gemn

Gemme. :ШЕ32аНЯ

< Назад

«or d«fm*t how
h?h the current
until th»s«nterbcw

1

Л

[ f i e n t » > j Отмене ;
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Применительно к цифровой фотографии
процесс использования JCC-профилей выгля-
дит достаточно просто.

На первом этапе из аппаратных данных
RGB (фотокамеры) по матрице пересчета, ука-
занной в профайле, определяются цветовые
координаты L*a*b*.

На втором этапе цветовые координаты L*a*b*
изменяются таким образом, чтобы не только
цветовые координаты данного снимка, но и все
цветовое пространство Lab поместилось в цве-
товой охват устройства назначения.

На третьем этапе согласно указаниям в
профайле устройства назначения из цвето-
вых координат вычисляются аппаратные дан-
ные. В этот момент часть информации без-
возвратно теряется. Поэтому использовать
JCC-профиль нужно на завершающем этапе
работы, когда окончательно определено целе-
вое устройство.

Методики замены цвета
Существуют разные методики подме-

ны цветов, рассчитанные на создание похо-
жего, но не аутентичного цветового ощуще-
ния. В частности, в программе Adobe Photoshop
реализованы четыре метода.

Relative colorimetric. Наиболее распростра-
ненный способ, при котором программа выбирает
оттенок, имеющий в данном снимке максималь-
ное значение, и в точности его воспроизводит.
Все прочие оттенки воспроизводятся как полу-
чится. Те, что находятся наиболее далеко от
основного, подменяются.

Замена цвета

При «относительном» приведении цвета отсекается все,
что не считается значимым

Absolute colorimetric. По действию очень
похож на Relative colorimetric, но расчет про-
изводится не относительно самого значимого

Компрессия в цветовой охват принтера Epson Stylus Photo 1290 с
бумагой Lomond Glossy 120, методом Relative Colorimetric
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оттенка, а относительно точки белого, приня-
той в качестве основной.

1т\ -. i

При «абсолютном» приведении цвета отсекается все,
что не попало в область цветового охвата

Perceptual. Изменяя цвета, программа борется
за сохранение тональных соотношений между
пикселами изображения. Точностью цветопе-
редачи при данном способе приходится жерт-
вовать. Зритель простит, если красное яблоко
станет золотым или зеленым, но спелый бочок
в любом случае должен быть виден. Метод
Perceptual часто оказывается оптимальным
при большом количестве оттенков, не попада-
ющих в цветовой охват.

Приведение «по ощущениям» искажает все,
но делает это гармонично

Saturation. Способ, отдающий предпочте-
ние сохранению насыщенности в ущерб тону
и цвету. Применяется редко (в основном для
деловой графики).

Приведение «по насыщенности» усредняет все

Таким образом, даже при наличии профай-
лов необходимо всякий раз осмысленно выби-
рать способ подмены цветов, помня о том, что
чем-то придется жертвовать: либо тональны-
ми соотношениями, либо точностью цветовос-
произведения, либо деталировкой.

Абстрактные устройства
Несовершенство реальных RGB-устройств

послужило толчком к созданию профайлов
абстрактной, идеализированной RGB-аппа-
ратуры. Таких устройств нет в природе, но
существуют их профили ICC.

Первыми были приняты стандарты Apple
RGB и sRGB (название расшифровывается как
standard RGB — стандартное устройство RGB).
Оба устройства представляют собой усреднен-
ные парметры мониторов компьютерных плат-
форм MAC и PC соответственно, существовав-
ших на время принятия стандарта.

В 1998 году было стандартизировано абстракт-
ное устройство Adobe RGB. Оно обладает огром-
ным цветовым охватом, который перекрывает
любые реальные RGB- и CMYK-устройства
Adobe RGB очень удобен в работе с цифровыми
изображениями: можно неоднократно перехо-
дить от цветовой модели RGB к цветовым коор-
динатам Lab и обратно, не теряя цвета из-за
компрессии. Если цифровая камера позволя-
ет записывать файлы с профилем Adobe RGB,
это свидетельствует о высоком техническом
уровне аппарата.

Для цветовой модели CMYK также суще-
ствуют абстрактные цветовоспроизводящие
устройства: Euroscale Coated, SWOP Coated и
другие. Они учитывают спецификации офсет-
ной печати CMYK-красителями.

Потребительский подход — sRGB
У подхода, предложенного консорциумом

ICC, есть недостаток — он рассчитан на подго-
товленных людей. Чтобы уверенно обращаться
с профайлами, нужно хотя бы понимать, что
такое драйвера устройств, где их берут и как
устанавливают.

В старые добрые времена, когда компью-
терами владели в основном энтузиасты, мож-
но было рассчитывать на их знания. Сегодня
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Компрессия цвета в sRGB

Исходное изображение с профилем Photoshop 5 Default CMYK

производители устройств рассчитывать на это
не могут. Действительно, о каких драйверах
и профилях может идти речь, когда цифро-
вую фотокамеру подключают к фотопринте-
ру напрямую и печатают фотографии вообще
без помощи компьютера?

Обеспечить потребительскую простоту в
работе с цветом призвано абстрактное устрой-
ство sRGB. Его профиль обычно обозначается
как sRGB IEC 61966-2.1. Если прибор относится
к компьютерной периферии (монитор, сканер,
принтер), его sRGB-профиль прикладывают к
драйверу. Если же он предназначен для авто-
номной работы (цифровая фото- или видеока-
мера, мультимедийный проектор, фотоприн-
тер), его sRGB-профиль записывают в ПЗУ
(постоянное запоминающее устройство).

Когда в состав компьютерной системы входит
несколько цветотехнических устройств, меж-
ду ними происходит информационный обмен.
Управляет этим обменом операционная систе-
ма компьютера. Операционные системы плат-
формы PC по-настоящему эффективно начали
справляться с этой задачей с появлением вер-
сии Windows Me. В настоящее время для работы
с цветом наиболее эффективно использовать
операционную систему Windows ХР.

Изображение с профилем sRGB. Обратите внимание на
деградацию цвета в тенях и насыщенных областях

С точки зрения потребителя технология
sRGB проста и надежна. Если устройства неком-
пьютеризированы, значит, они сами «догово-
рятся» между собой о коррекции цветового
пространства. Если же они подключены к пер-
сональному компьютеру, значит, договориться
им поможет операционная система. И нако-
нец, sRGB — отличный выход из положения,
когда об устройстве печати вообще ничего не
известно.

Как результат компромисса технология
sRGB имеет недостатки. Во-первых, цвето-
вой охват пространства sRGB заметно меньше
охвата большинства RGB-устройств (фотока-
мер, мониторов и др.). Это расплата за универ-
сальность. Фактически, переводя свой фото-
снимок в пространство sRGB, мы теряем в нем
то, что можно было бы сохранить, если работать
с 7СС-профилями конкретных, а не абстракт-
ных устройств.

Технология sRGB предназначена для наи-
более эффективного (по цене и производитель-
ности) удовлетворения массового спроса. Она
не обеспечивает максимально высокое каче-
ство публикации. Зато она гарантирует, что
абсолютно неприемлемое качество вы тоже
не получите.
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Типовая обработка фотографий

НЕ ОБЯЗАТЕЛЬНО ЗАПУСКАТЬ В ОБРАБОТКУ ПО ПОЛНОМУ ЦИКЛУ КАЖДУЮ ФОТОГРАФИЮ, НС ДЛЯ

ОТВЕТСТВЕННЫХ РАБОТ СОБЛЮДЕНИЕ. ПОСЛЕДОВАТЕЛЬНОСТИ И ОБЪЕМА ТИПОВОГО ПРОЦЕ ХА ВЕСЬМА

ЖЕЛАТЕЛЬНО. ПО КРАЙНЕЙ МЕРЕ, НАДО ПРОВЕРИТЬ ВСЕ ПАРАМЕТРЫ

Преобразование,
ориентация,
анализ

Кадрирование
и зачистка

Установка
баланса белого

Улучшение
цветового
баланса

Улучшение
контраста и
насыщенности

Улучшение
резкости

Выборочная
коррекция
снимка

Выборочная
ретушь

Исправление
перспективы
и композиции

Изменение
размера и
плотности

Завершающие
этапы

ифровая фотография, несмотря
Л_Д,на относительную молодость,
уже имеет свои традиции и устояв-
шиеся приемы. В частности, по опы-
ту работы фотографов с миллионами
цифровых изображений сложился
типовой процесс обработки (в англо-
язычной литературе — Workflow), в
общем случае применимый к любой
цифровой фотографии.

Типовой процесс обработки вклю-
чает следующие этапы.
1. Перенос из источника на ком-

пьютер, преобразование в тре-
буемый формат, предваритель-
ная ориентация по осям, анализ
содержания.

2. Кадрирование, предварительная
очистка.

3. Установка баланса нейтральных
тонов (баланс белого, баланс
черного); при необходимости
расширение тонового диапазо-
на до полного.

4. Улучшение цветового баланса.
5. Улучшение контраста и насы-

щенности.
6. Улучшение резкости.
7. Выборочное улучшение контра-

ста и тонового диапазона в
отдельных областях снимка.

8. Выборочная ретушь.
9. Исправление перспективы;

исправление композиции или
создание новой композиции
(фотомонтаж).

10. Изменение размера и плотности
в соответствии с задачами
публикации.

12. Окончательная установка рез-
кости, исправление мелких
артефактов.

13. Преобразование в универсаль-
ный формат и сохранение.

14. Преобразование в цветовой
охват устройства, запись на
носитель.

Необязательно запускать в обработ-
ку по полному циклу каждую фото-
графию, но для ответственных работ
соблюдение последовательности типо-
вого процесса весьма желательно.
По крайней мере, необходимо прове-
сти контроль указанных параметров.
Тщательность практически гаранти-
рует высокое качество публикации
на любом устройстве вывода.

Помимо типовых задач фотоху-
дожники часто решают задачи спе-
циальные. Например, композиции из
разных фотографий относятся к спе-
циальным задачам. Но если оригина-
лы не прошли обработку по типовому
процессу, нельзя ожидать заметного
эффекта от художественных приемов,
поскольку несовершенна основа.
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Этап 1. Преобразование, ориентация, анализ

ТТ ля ответственных работ используют ори-
^ЦЦгиналы снимков в формате RAW. До начала
преобразований в программе Adobe Photoshop
необходимо выбрать рабочее цветовое простран-
ство с возможно большим охватом, например
Adobe RGB.

Преобразование в стандартные форматы
проводят с помощью программного обеспече-
ния, предлагаемого производителем камеры.
Универсальным средством служит расширение
программы Adobe Photoshop — Camera RAW.
Оно работает автоматически (File > Open), если
программе известна данная спецификация RAW.
Желательно записывать оригинал в режиме
16 бит на канал, сохраняющем исходные цве-
та в полном объеме. Для бытовых целей мож-
но использовать оригиналы в формате JPEG с

возможно меньшей степенью сжатия. Высокие
коэффициенты сжатия применяют только к
снимкам, публикуемым в Интернете или пере-
сылаемым по электронной почте.

Преобразованый оригинал сохраняют на
жестком диске компьютера в формате PSD
или TIFF (File > Save As), с включением цвето-
вого профиля (флажок ICC Profile). После запи-
си файла оригинал поворачивают в соответ-
ствии с альбомной или портретной ориентацией
снимка (Image > Rotate Canvas).

При необходимости «доворачивают» кадр.
Для этого инструментом Measure протягивают
линию параллельно вертикали или горизонта-
ли на снимке. Командой Image > Rotate Canvas >
Arbitrary поворачивают холст, угол поворота
учитывается программой автоматически.

Преобразование RAW в стандартный формат

Режимы
отображения
параметров

Гистограмма
(белая — общая,
цветные — по
каналам)

Вкладка
управления
основными
параметрами

Цветовая
температура

Коррекция
экспозиции

Коррекция
в тенях

Коррекция
яркости

Коррекция
контраста

Коррекция
насыщенности
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)
Анализ снимка
Основным инструментом для анализа

цифровой фотографии служит гистограмма.
Она графически показывает распределение
пикселов изображения по уровням яркости
в общем или отдельно по цветовым каналам.
Чем выше столбик гистограммы, тем больше
пикселов данной яркости присутствует в изо-
бражении.

Многие модели цифровых фотокамер осна-
щены средством просмотра гистограммы на
экране дисплея камеры. Это позволяет пред-
варительно оценить снимки и не использо-
вать заведомо испорченные кадры. Снимки,
попавшие на компьютер, удобно анализиро-
вать с помощью палитры Histogram программы
Adobe Photoshop. По итогам анализа принима-
ют решение о дальнейшей последовательно-
сти и объеме работы.

Полезные сведения о цвете и яркости участ-
ков изображения предоставляет палитра Info.
Для съема данных используют инструмент
Eyedropper (Пипетка). На панели свойств инстру-
мента в раскрывающемся списке Sample Size
задают размер обла-
сти взятия пробы.

Информация о цвете пикселов отобража-
ется на панели Info в порядке, заданном при
настройке параметров палитры. Мы рекомен-
дуем выбрать режимы Actual Color (Цветовое
пространство изображения) для первой инфор-
мационной панели и Grayscale (Серая шкала) —
для второй. В этом случае можно одновременно
оценивать не только координаты цвета в данной
точке, но и общую яркость (плотность).

Назначьте разные режимы
отображения информации,
чтобы иметь полное
представление о цвете и
яркости пикселов в области
взятия пробы

Г и с т о г р а м м а

Sample Size: 5 bv 5 Average V

•| Navigator
Л

•н

R :
G :
В :

X :
V :

J j I n f e "

10
10
10

2162
1138

•\
Л

а

*
к : эгн

W:
Н :

First Color Readout

Node: Actual Cotor v

Second Color Readout

MQde: • Grayscale

Mouse Coordinates

Buter Units: Pixels

• Show 16 bit values

На левой панели показаны
цветовые координаты
пробы, на правой —
значения плотности
(непрозрачности)

Channel: RGB

A
Mean: 115,84StdDev: t&OOMedian: 1%Pixels: 15950bRed

<Sreen

Bio*

Count:Percent*!*:Cache Level: 2

Общий вид гистограммы

говорит о многих свой-

ствах изображения: диа-

пазоне охвата тонов, рас-

пределении уровней тона,

балансе тонов или сдвиге

в темные (светлые) обла-

сти, контрастности. Более

точные данные предо-

ставляют информацион-

ные строки.

В строке Mean

(Средневзвешенное)
указывается средневзве-
шенный уровень яркости
пикселов изображения.
Чем выше средневзве-
шенное значение, тем

больше общая светлота изображения.

В строке Std Dev (Стандартное отклонение)

содержится информация о статистическом (средне-
квадратичном) отклонении (разбросе) уровней
тонов. Чем больше стандартное отклонение, тем
выше контрастность снимка.

В строке Median (Медиана выборки) дано зна-

чение тона, разбивающего выборку на две равные
части. Этот тон является «точкой равновесия» для
гистограммы. Близость значений медианы к сред-
невзвешенному значению говорит о равномерном
тоне.

В строке Pixel (Пиксел) показано общее число
пикселов в изображении.
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Недоэкспозиция

Типичные проблемы - — •

Область заполнения пикселами в
гистограмме недоэкспонирован-
ного снимка смещена влево. При
этом в светах пикселы или отсут-
ствуют, или имеются в минималь-

ном количестве, которым можно пренебречь. В нашем примере,
анализируя сюжет и гистограмму, можно утверждать, что сни-
мок недоэкспонирован, поскольку съемка проводилась днем и в
небе должны быть светлые оттенки.

Переэкспозиция

Слабый контраст

В гистограмме переэкспониро-
ванного снимка явно не хватает
информации в области теней и
четвертьтонов. Искусственная
растяжка существующего диапа-

зона приводит к появлению областей, заполненных белым цве-
том, что нарушает нормальное соотношение цветов. Поэтому
коррекция переэкспонированных снимков представляет собой
самую сложную задачу в цифровой фотографии. Обычно сове-
туют такие снимки считать испорченными.

Гистограмма снимка с низкой
контрастностью не имеет выра-
женных пиков, ее площадь огра-
ничена плавной кривой. Хотя на
снимке представлен практически

полный тоновый диапазон, контрастность в интегральном кана-
ле яркости слишком мала, что снижает выразительность изоб-
ражения.

На однородных участках цветового тона при
установке высокой чувствительности (например,
в цифровых мыльницах при ISO больше 100) воз-
можно появление цифрового шума — хаотично
расположенных пикселов случайного цвета. На
гистограмме это выражается появлением узких

пиков и провалов в определенном диапазоне. Как пра-
вило, шумы наиболее заметны в канале синего цвета.
Даже камеры профессионального класса (в нашем при-
мере Nikon D60) при высокой чувствительности получа-
ют в канале синего шум.
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Этап 2. Кадрирование и зачистка

Кадрирование — не столько техническая,
сколько творческая задача. Кадрирование

призвано отсечь все лишнее и оставить в кадре
ту часть композиции, которая соответствует
замыслу фотографа, подчеркивает главные
элементы снимка, повышает его художествен-
ную ценность. В некоторых случаях кадри-
рование помогает превратить банальный, на
первый взгляд, снимок в художественное про-
изведение.

В фотографии, как и в архитектуре, живо-
писи, других графических искусствах полезно
использовать принцип золотого сечения. Суть
этого закона в том, что меньший отрезок отно-
сится к большему, как больший ко всей длине.
Алгебраически это выглядит так:

а : Ъ = Ъ : (а + Ь).
Одним числом золотое сечение выражается
как 1,618. Суть в том, что подобное соотношение
благоприятно глазу в силу психических и физи-
ческих особенностей строения человека.

Важно соблюдать и другие принципы ком-
позиции: равновесие, ритмику, симметрию,
опорные линии и т. д. Анализ любой удачной
фотографии однозначно показывает, что в ней
присутствует прочная композиционная осно-
ва, которая начинается с правильного кадри-
рования.

Композиция

Соотношение сторон
соответствует золотому сечению

Ось симметрии Ведущий элемент композиции
расположен в центре кадра

Инструмент кадрирования

W
Н

1121
1484

Размер кадра отображается
на палитре Info

Выбираем инструмент Crop. Ничего не надо

менять на панели свойств инструмента!

Устанавливаем указатель инструмента в угол

прямоугольника кадрирования и протягиванием

определяем границы кадра. Проверяем разме-

ры кадра на палитре Info.

При необходимости перемещаем рамку кадра с

помощью курсорных клавиш или мышью при

нажатой клавише CTRL. Границы кадра меняем

перетаскиванием маркеров. Поворот рамки —

перемещением угловых маркеров.

Обрезаем кадр по рамке нажатием клавиши

ENTER или двойным щелчком внутри рамки.
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Зачистка

Происхождение царапин и мусора в цифровой
фотографии бывает разным. Самые неприят-
ные — технические причины (поцарапанный объ-
ектив, попадание пыли на сенсор). Но артефакты
могут появиться и по условиям съемки. Если
ветер поднял пыль, в кадре неизбежно появятся
мелкие дефекты. А съемка старых фотографий,
конечно, зафиксирует все повреждения оригина-
ла. В нашем примере проводим черновую зачист-
ку переснятой старой фотографии, удаляя цара-
пины, мелкий мусор и прочие артефакты.

Устанавливаем масштаб изображения по разме-
ру окна. Выбираем инструмент Zoom, на панели
свойств щелкаем на кнопке Fit on Screen.
Слегка затемняем изображение (Image >
Adjust > Brightness/Contrast), установив движок
Brightness в положение -6.
В палитре History создаем снимок состояния
щелчком на кнопке Create New Snapshot.
Даем команду Filter > Noise > Dust and
Scratches. В диалоговом окне Dust and Scratches
устанавливаем движок Radius в крайне левое
положение. Задаем значение Threshold равным
нулю.

Помещаем квадратный курсор поверх характер-
ного дефекта и щелкаем мышью, чтобы эта
область отображалась в окне предварительного
просмотра.

g Перемещаем дви-
жок Radius вправо,
пока не исчезнут
мелкие артефакты.
Перемещаем дви-
жок Threshold
вправо, пока дефек-
ты вновь не появят-
ся. После этого
осторожно переме-
щаем движок
Threshold влево до
исчезновения дефектов. Щелкаем на кнопке ОК.

У В палитре History переходим
к состоянию, предшествую-
щему применению операции
Dust and Scratches.
Устанавливаем значок кисти
History Brush на операцию Dust and Scratches.

g На панели инструментов выбираем кисть History
Brush. На панели свойств задаем подходящий
размер, режим смешивания Lighten. Кистью
вычищаем артефакты. Если дефекты светлее
фона, устанавливаем режим Darken.

| Для удаления сравнительно крупных дефектов
используем кисть Healing Brush. Щелчком мыши
при нажатой клавише ALT выбираем донорский
участок рядом с дефектом, а щелчком кистью на
дефекте залечиваем его.
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Этап 3. Установка баланса белого

Вфотографии равенство цветовых компо-
нентов в нейтральных тонах, особенно

в точках белого и черного цветов, является
фундаментом правильной цветопередачи и
тонового баланса. Как правило, средства авто-
матической установки баланса белого (White
Balance) в современных цифровых фотокаме-
рах работают достаточно уверенно.

Ошибки связаны либо с неправильной руч-
ной установкой баланса белого, либо с особо
сложными условиями смешанного освещения.
Тем не менее, полностью полагаться на авто-
матику камеры не следует. По крайней мере,
желательно проверить баланс нейтральных
тонов при подготовке фотографии к публи-
кации.

Баланс нейтральных тонов

Расстановка контрольных точек
На палитре Info щелкаем на раскрывающей
кнопке, в меню выбираем пункт Palette Option.
На панели First Color Readout в раскрывающем-
ся списке выбираем пункт Total Ink. На панели
Second Color Readout в раскрывающемся спи-
ске выбираем пункт Actual Color. Закрываем
окно щелчком на кнопке ОК.

first Color Readout
Mode: Total Ink

Second Cokx Readout
Mode: Actual Cotof

Mouse Coordinates
Ruler Units: Mimeters

j | Show 16 bit values

На панели инструментов выбираем инструмент
Color Sampler. На панели свойств в раскрываю-
щемся списке выбираем пункт 3 by 3 Average.

8

Проводим инструментом Color Sampler над

самыми темными областями изображения.
В точке, где значение Total Ink на палитре Info
станет наибольшим, щелчком ставим контроль-
ную точку #1.
Проводим инструментом Color Sampler над
самыми светлыми областями изображения.
В точке, где значение Total Ink на палитре Info
станет наименьшим, щелчком ставим контроль-
ную точку #2.

Открываем диалоговое окно уровней командой
Image > Adjustments > Levels.
Удерживая клавишу ALT, перетаскиваем левый
(черный) движок под гистограммой вправо до
тех пор, пока в окне изображения не появятся
видимые пикселы. Удерживая клавишу Shift,
смещаем контрольную точку #1 в место появ-
ления видимых пикселов.
Удерживая клавишу ALT, перетаскиваем пра-
вый (белый) движок под гистограммой влево
до тех пор, пока в окне изображения не появят-
ся видимые пикселы. Удерживая клавишу Shift,
смещаем контрольную точку #2 в место появ-
ления видимых пикселов. Эта точка не должна
быть бликом, отражением света, источником
света, не должна содержать значимых деталей.
Закрываем окно щелчком на кнопке ОК.
Находим область нейтрального (серого) цвета
с параметром Total Ink около 150% и ставим
контрольную точку #3.

Определяем доминантный цвет на фотографии
и ставим в области выраженного доминантного
цвета контрольную точку #4. Это поможет в
дальнейшем выставить цветовой баланс.
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Баланс нейтральных тонов (продолжение)

Установка точек белого и черного
Проверяем наличие чистого белого цвета в изоб-
ражении. В контрольной точке #2 разница между
значениями в каналах не должна превышать
восемь уровней. Если разница меньше, считаем,
что чистый белый цвет в изображении есть, и
продолжаем операцию.
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Выбираем инструмент Set White Point (крайняя
пипетка справа). Щелкаем пипеткой в месте уста-
новки контрольной точки #2.

Проверяем наличие чистого черного цвета в изоб-
ражении. В контрольной точке #1 разница между
значениями в каналах не должна превышать
восьми уровней. Если разница меньше, считаем,
что чистый черный цвет в изображении есть, и
продолжаем операцию.

Выбираем инструмент Set Black Point (крайняя
пипетка слева). Щелкаем пипеткой в месте уста-
новки контрольной точки #1.

Коррекция белого и черного цветов
Если нет чистого белого цвета, проверяем в
палитре Info, какой канал имеет наивысшее зна-
чение яркости в контрольной точке #2. В диало-
говом окне Levels поочередно открываем кана-
лы, в которых значения яркости меньше. Движок

установки белого (правый) перемещаем влево
до тех пор, пока в палитре Info в контрольной
точке #2 значение данного канала не совпадет
со значением канала с наивысшей яркостью.
Если нет чистого черного цвета, проверяем
в палитре Info, какой канал имеет наименьшее
значение яркости в контрольной точке #1.
В диалоговом окне Levels поочередно откры-
ваем каналы, в которых значения яркости
больше. Движок установки черного (левый)
перемещаем вправо до тех пор, пока в пали-
тре Info в контрольной точке #1 значение дан-
ного канала не совпадет со значением канала
с наименьшей яркостью.
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Расширение динамического диапазона
Если в результате предыдущих операций
гистограмма общей яркости не достигает гра-
ниц графика, расширяем динамический диа-
пазон путем перемещения правого и левого
движков (в композитном канале RGB) к осно-
ванию гистограммы.
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Этап 4. Улучшение цветового б а л а н с а

Тветовой баланс в фотографии наруша-
JLJLeTCH при несовпадении цветовой темпе-
ратуры, установленной автоматикой фото-
камеры, и цветовой температуры источников
освещения снимаемой сцены. Дополнительные
сложности вносит использование вспышки.
Частичная коррекция цветового баланса про-
исходит при рассмотренной выше установке
черной и белой точек. Однако баланс цвета по
всему тоновому диапазону требует дополни-

тельных усилий. Ведь в тенях и светах разли-
чимость цвета человеком заметно ниже, чем
в полутонах.

Основная информация о цвете передается
пикселами с диапазоном яркости от четверть-
тонов до тричетвертьтонов. В тенях цвет прак-
тически неразличим и кажется нейтральным.
В светах цветной оттенок различается луч-
ше, но фотографии в высоком ключевом тоне
очень редки.

Коррекция цветового сдвига в полутонах

Цветовой сдвиг (дисбаланс цвета) в нейтраль-
ных тонах может быть заметен на глаз в памят-
ных цветах. Например, известно, что при нор-
мальном освещении бетон или асфальт, кора
осины или клена имеют нейтральный оттенок.
Если сдвиг цвета на глаз неразличим, все же
следует проверить в палитре Info баланс значе-
ний компонентов RGB в контрольной точке ней-
трального тона #3 (о ее установке рассказано
выше). При различиях более пяти уровней тона
следует провести коррекцию.

Простой метод баланса цветов
В палитре Info в контрольной точке нейтрально-
го тона #3 проверяем значения в каналах RGB.
Канал со значением, наиболее близким к сере-
дине диапазона, будет опорным.
Открываем диалоговое окно тоновой кривой
командой Image > Adjustments > Curves. В рас-
крывающемся списке Channel выбираем кор-

ректируемый канал. На тоновой кривой щелч-
ком ставим точку, соответствующую уровню
тона выбранного канала в контрольной точке
#3 на палитре Info. Проверяем правильность
установки в поле Input. На рисунках показан
пример коррекции в канале красного (Red).
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Коррекция цветового сдвига в полутонах (продолжение)

Курсорными клавишами смещаем контрольную
точку на кривой так, чтобы в поле Output появи-
лось значение, аналогичное значению опорного
канала в контрольной точке #3 на палитре Info.
Повторяем операцию для остальных каналов.
В конечном счете, на палитре Info для всех кана-
лов добиваемся совпадения значений в кон-
трольной точке #3.

Метод точной коррекции

Выбираем инструмент Eyedropper. Затем в диа-
логовом окне тоновой кривой щелкаем в поле
графика, удерживая клавишу ALT. График тоно-
вой кривой разбивается на 100 ячеек.
В поле Channel выбираем корректируемый
канал. Удерживая левую кнопку мыши, прово-
дим пипеткой в окне изображения. В диалого-

вом окне тоновой кривой по графику переме-
щается окружность, показывающая текущий
уровень тона под пипеткой в данном канале.
Отпуская кнопку мыши и щелкая ею при нажа-
той клавише CTRL, расставляем контрольные
точки на тоновой кривой. Обычно достаточно
трех-четырех контрольных точек, расставлен-
ных в диапазоне от теней до четвертьтонов.
Лишние точки удаляем в диалоговом окне
Curves, щелкая на них при нажатой клавише
CTRL.

Перемещение контрольной точки вверх и влево
добавляет интенсивности основным цветам
(красный, зеленый, синий). Перемещение кон-
трольной точки вниз или вправо добавляет
интенсивности дополнительным цветам (голу-
бой, пурпурный, желтый).
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Этап 5. Улучшение контраста и насыщенности

Контраст и тоновый диапазон снимка —
тесно связанные параметры-антиподы.

Контраст характеризует различимость сосед-
них уровней тона. Например, он практически
отсутствует в градиентной заливке. Усиливая
его, мы уменьшаем число отображаемых уров-
ней тона. Предельное значение контраста дает
изображение, состоящее только из черных и
белых пикселов.

Большинство зрителей предпочитает хоро-
ший контраст расширенному тоновому диапа-
зону. В цифровых камерах процессор обработки
изображений обычно искусственно повышает
контраст снимка, поэтому многие фотогра-
фии в домашних альбомах выглядят очень
контрастно.

Надо отметить, что контраст противопоказан
художественной фотографии. Здесь важным
считается правильная передача полного тоно-

вого диапазона. Портрет, пейзаж, натюрморт
обычно выглядят лучше, если предпочтение
отдано тоновому диапазону, но не контрасту.

Повышенная насыщенность цвета также явля-
ется характерной чертой снимков, сделанных
камерами компактного класса. Производители
сознательно используют фильтры и алгоритмы
обработки, усиливающие насыщенность в основ-
ных каналах, особенно в зеленом. Например,
компания Sony в некоторых моделях цифровых
камер применяет фильтр с дополнительными
элементами Emerald (изумрудный).

В конечном итоге многие фотографии на выхо-
де из цифромыльницы или компакта становят-
ся похожими на лубок. Предельный контраст
и вопиющие цвета не способствуют художе-
ственному восприятию фотоснимков. Поэтому
коррекция насыщенности и контраста требует
осторожности и творческого подхода.

Управление контрастом

Величину контра-
ста контролируем в
окне изображения.
Ставим контроль-
ные точки в обла-
сти черного
(Input = 0) и белого
( I n p u t = 2 5 5 ) .
Обрезаем диапа-
зон до уровней 12 и 244. Закрываем окно щелч-
ком на кнопке ОК.

Командой Image > Adjustments > Curves откры-
ваем диалоговое окно тоновой кривой.
Устанавливаем сетку из 16 ячеек. Переключение
режимов выполняем щелчком мыши в поле гра-
фика при нажатой клавише ALT.
Щелчками мыши ставим контрольные точки на
первом и последнем пересечении тоновой кри-
вой с сеткой графика.

Строим S-образную кривую. Перемещаем верх-
нюю контрольную точку влево, а нижнюю кон-
трольную точку вправо. Чем круче будет наклон
кривой между точками, тем сильнее контраст.
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Управление насыщенностью

1 Открываем диалоговое окно управления насы-
щенностью командой Image > Adjustments >
Hue/Saturation.
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Простейший метод изменения насыщенности исполь-
зует средства управления диалогового окна
Hue/Saturation. Более сложные методы опираются
на возможности палитры каналов.

В режиме Edit: Master движком Saturation уве-
личиваем насыщенность не более чем на 20
единиц. При выборочной коррекции можно уве-
личить насыщенность до 30 единиц. В нашем
примере насыщенность дополнительно увели-
чена в каналах желтого и красного цветов.

109



Этап 6. Улучшение резкости

Нынешние технологии преобразования опти-
ческого изображения в цифровое содержат

несколько этапов, объективно снижающих рез-
кость изображения. Прежде всего, на резкость
негативно влияет интерполяция цвета каждо-
го пиксела после «раскладки» светового пото-
ка в фильтре Байера. При этом мелкие детали
пропадают, а в лучшем случае слегка искажа-
ются, что приводит к потере резкости. Свой
вклад вносит также сглаживающий фильтр,
призванный бороться с муаром. В результате
практически любое цифровое изображение
требует коррекции резкости.

Однако усиление резкости неизбежно при-
водит к увеличению контрастности и сужает
тоновый диапазон снимка. Повышенная сверх

меры резкость делает фотографию плоской,
неестественной.

Алгоритмы повышения резкости применя-
ются в любой цифровой фотокамере. В камерах
компактного класса они, как правило, более гру-
бы. Чем выше класс камеры, тем менее замет-
но вмешательство таких алгоритмов.

Для работ с повышенными требованиями к
качеству желательно использовать оригиналы
в формате RAW, которые не прошли обработ-
ку в процессоре камеры.

Надо отметить, что управление резкостью
цифровых снимков сводится не только к ее
повышению, но в некоторых случаях — к смяг-
чению излишней резкости, «наведенной» про-
цессором цифрового компакта.

Улучшение краевой резкости деталей.

Открываем изображение и дублируем фоновый
слой (Layer > Duplicate Layer). Новый слой (по
умолчанию ему присваивается имя Background
сору) будем использовать в качестве корректи-
рующего. Изображение на новом слое обесцве-
чиваем (Image > Adjustments > Desaturate).
Применяем к обесцвеченному слою высоко-
частотный фильтр (Filter > Other > High Pass).
Значение параметра Radius подбираем так,
чтобы были видны контуры важных деталей
снимка.

В палитре Layers в раскрывающемся списке
Blending Mode устанавливаем режим смешива-
ния Overlay. Регулируем степень воздействия
установкой движка Opacity.

Если эффект необходимо усилить, делаем нуж-
ное количество копий корректирующего слоя, но
не слишком увлекаемся. Не будем забывать, что
каждый дубль корректирующего слоя увеличи-
вает общий контраст изображения.
Для управления резкостью в интерактивном
режиме дублируем фоновый слой, обесцвечива-
ем его и включаем для дубля режим смешива-
ния Overlay. В диалоговом окне фильтра High
Pass, управляя движком Radius, контролируем
результат в окне изображения. Усиления эффек-
та добиваемся дублированием корректирующе-
го слоя, но не параметром Radius в диалоговом
окне фильтра.
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Комбинация фильтров

4

В большинстве случаев фильтр Unsharp Mask
необходимо использовать в гибкой комбинации с
другими фильтрами и приемами обработки изо-
бражения.

Выделяем область, подвергаемую обработке
фильтром. В режиме быстрой маски (клавиша Q)
кистью черного цвета закрашиваем участки
изображения, которые надо исключить из обра-
ботки. Края выделяемой области обрабатываем
кистью с непрозрачностью 10%, чтобы смягчить
действие фильтра.

Возвращаемся в обычный режим (клавиша Q) и
инвертируем выделенную область командой
Select > Inverse. Даем команду Select > Feather,
в диалоговом окне задаем радиус 4 пиксела.
Применяем фильтр командой Filter > Sharpen >
Unsharp Mask. Устанавливаем параметры в диа-
логовом окне фильтра в соответствии с характе-
ром снимка. Щелчком на кнопке ОК запускаем
фильтр.

Слегка размываем
задний план, что-
бы подчеркнуть
фактуру переднего
плана съемки.
Даем команду
Select > Inverse.
Применяем фильтр
размытия по
Гауссу: Filter > Blur
> Gaussian Blur.
Задаем радиус

размытия в соответствии с параметрами изобра-
жения. Чем больше размер снимка, тем больше
должен быть радиус.
Увеличиваем масштаб просмотра. Проверяем
соотношение резких и нерезких деталей на гра-
ницах обрабатываемых областей, а также на
переднем плане. При обнаружении недостатков
исправляем их кистью History Brush.
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Этап 7. Выборочная коррекция снимка

ТТля выборочной коррекции контраста и
JLL экспозиции снимка обычно применяют
метод смешивания слоев в различных режи-
мах (Blending Mode). В ряде случаев он работает
быстрее и эффективнее, чем альтернативные
методы. Основным средством служит палитра
слоев (Layers). Дубликат исходного слоя соз-
дают, выбирая в интерактивном меню пункт
Duplicate Layer. Режим смешивания выбирают в
раскрывающемся списке Set the blending mode
палитры слоев.

В целях коррекции тонового диапазона или
контраста используют следующие режимы
смешивания:
• Multilpy — усиливает недодержанный сни-

мок;

• Screen — ослабляет передержанный сни-
мок;

• Soft Light, Overlay, Hard Light — усиливают
контраст (перечислены в порядке возрас-
тания эффективности).
Выборочное изменение тонового диапазона,

контраста и цветового баланса осуществля-
ют также с помощью корректирующих слоев
(Adjustment Layer). По умолчанию корректиру-
ющий слой действует на все нижележащие
слои, однако применение некоторых режимов
смешивания или масок позволяет ограничить
область воздействия нужными участками или
диапазонами тона. Сила действия режимов сме-
шивания или корректирующих слоев регули-
руется параметром Opacity (Прозрачность).

Коррекция тонового диапазона в тенях

Командой Layer > Duplicate Layer создаем
дубликат исходного слоя. Задаем дубликату
режим смешивания Luminosity.
В палитре каналов (Channel) поочередно прове-
ряем, в каком канале содержится больше дета-
лей. В нашем примере это канал красного (Red).
Возвращаемся в композитный слой RGB.
В палитре слоев именуем слой-дубликат, напри-
мер Red Only. Даем команду Image > Apply
Image.
В диалоговом окне Apply Image устанавливаем
параметры Layer = Merged, Channel = Red,
Blending = Normal, Opacity = 100%. Обычно для
коррекции светлых областей устанавливают

режим смешивания Darken, для усиления кон-
траста — Soft Light.
В палитре слоев, находясь на слое Red Only,
движком Opacity устанавливаем нужную сте-
пень воздействия.
В завершение операции даем команду Layer >
Merge Down.
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Методы выборки области
В программе Adobe Photoshop для выде-

ления областей на снимке по различным кри-
териям имеется несколько инструментов и
немало методов. Достаточно простой задачей
считается выборка объектов переднего плана.
Допустим, требуется изменить тоновый диапа-
зон отдельного объекта. Для этого необходимо
выбрать его любым способом: инструментом
лассо (Lasso) или закраской в режиме быстрой
маски (Quick Mask). Любая последующая кор-
рекция тонового диапазона или цвета будет
касаться только выделенной области.

Выделение по диапазону яркости удобно
выполнять инструментом Magic Wand (Волшебная
палочка). На панели свойств инструмента настра-
ивают параметры выборки в соответствии с
текущими задачами. Диапазон цвета выбира-
ют с помощью средства Color Range, открыва-
емого командой Select ^ Color Range.

Сочетая различные инструменты и средства
выборки, можно получить область выделения,
отвечающую любым разумным критериям по
конфигурации объекта, тоновому диапазону,
цвету. Такую область желательно сохранить
командой Select > Save Selection.

Выборочная коррекция объекта

Необходимо отдельно провести коррекцию объ-
екта съемки и фона. Задача осложняется частич-
ным перекрытием объекта деталями фона.
В режиме быстрой т
маски проводим I
черновую выборку
объекта закрашива-
нием кистью черно- \
го цвета. Контур
удобно прорисовы-
вать в канале с наи-
большим контра-
стом по яркости, для I
чего в палитре кана-
лов отключаем дру-
гие каналы.
Для точной выборки
контура возвращаемся в обычный режим про-
смотра, выбираем инструмент Лассо и при боль-
шом увеличении добавляем или исключаем пик-

з

4

селы вдоль контура выборки. Режим выборки
переключаем нажатием клавиши ALT.
Вновь включаем отображение всех каналов.
Выбираем инструмент Magic Wand.
Устанавливаем на панели свойств параметр
Tolerance = 2 и флажок Contiguous. Щелчками
добавляем или убираем пикселы на границах
объекта и фона, добиваясь точного соответ-
ствия границ выделенной области и объекта.
Сохраняем выборку командой Select > Save
Selection. Инвертируем выборку командой
Select > Inverse.

Применяем к объекту эффекты, улучшающие
его восприятие, в частности, корректируем
тоновую кривую. Резкость улучшаем филь-
тром Unsharp Mask.
Инвертируем выборку командой Select >
Inverse. Применяем к фону эффекты, улучша-
ющие его восприятие. В частности, слегка раз-
мываем фон фильтром Gaussian Blur.
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Деталировка в тенях
Особенности обработки изображения

в цифровой камере таковы, что потери дета-
лей в тенях обычно несколько заметней, чем у
пленочных аппаратов. Для «спасения» деталей
в тени и свету в программе Adobe Photoshop
предусмотрено достаточно эффективное сред-
ство Shadow/Highlight. С его помощью осветля-

ют тени и затемняют света. Если возможности
данного средства удовлетворяют не в полной
мере, его можно комбинировать с маскирова-
нием части изображения.

Другие методы проявления деталей в тенях
опираются на более сложные приемы: в част-
ности, для точной коррекции удобно исполь-
зовать кисть History Brush.

Проявление деталей в тенях — — — — — — . _

В палитре History переключаемся на операцию,
предшествующую коррекции уровней.
Выбираем кисть History Brush. В палитре
History Brush устанавливаем активную кисть
на операцию коррекции уровней.

Выбираем инструмент Color Sampler, устанавли-
ваем контрольную точку в самом темном месте
изображения. На палитре Info проверяем пара-
метры RGB в тенях.
Даем команду Image ^ Adjustments ^ Levels.
В диалоговом окне уровней перемещаем сред-
ний движок (Gamma) влево до тех пор, пока не
будет заметна деградация цвета в контрольной
точке. Затем в поле Gamma откатываем движок
обратно примерно на 0,2 единицы. Другой вари-
ант — использование диалогового окна тоновой
кривой (Image > Adjustments > Curves), где
возможна более тонкая коррекция.

j.
J History

•

у
9

Âctions \ *
1 08_046.psd
Open
Delete Color Sampler
New Color Sampler Щ

1 1 9 1

Кистью History Brush аккуратно обрабатываем
области в тенях. Там, где следует ослабить
эффект, устанавливаем на панели свойств
кисти параметр Flow менее 100%. Например,
для тричетвертьтона плотность закраски около
75%, для полутона — не более 50%. На грани-
це света и тени плотность кисти не более 25%.
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Раздельная коррекция в тени и свету

Средство Shadow/Highlight (Image > Adjustments

> Shadow/Highlight) предназначено для раздель-
ной коррекции уровней тона в светах и тенях, а
также повышения контраста в полутонах. Перед
применением этого средства снимок следует при-
вести к нормальному цветовому балансу и тоново-
му диапазону.

1 Основными элементами управления служат поля с
движками Amount (Сила действия), Tonal Width
(Тоновый диапазон) и Radius (Радиус).
Значение в поле Tonal Width определяет диапа-
зон тона в тенях или светах, который подвергается
изменениям. Например, при установке значения
Tonal Width = 100% на панели Shadows сила дей-
ствия линейно изменяется от максимальной в
тенях до половинной в полутонах и нулевой в све-
тах. Установка максимального значения может
привести к появлению артефактов на границах
резких переходов тени и света. Поэтому рекомен-
дуемый диапазон — до 70%.

3 Параметр Radius определяет область расчета
теней и светов вокруг каждого пиксела. Чем боль-
ше радиус, тем сильнее общее осветление или
затемнение изображения. Чем меньше радиус,
тем сильнее контраст. Оптимальное значение
параметра Radius зависит от размера изображе-
ния. По опыту работы, в общем случае можно ори-
ентироваться на значение радиуса примерно 5%
от большего размера изображения. Например,
при ширине изображения 2000 пикселов попро-
буйте установить значение радиуса 100 пикселов.

Значение в поле Amount определяет величину
гамма-коррекции тонового диапазона в тенях
или светах, а также эффект усиления насыщен-
ности, заданный в поле Color Correction.
Например, при нулевом значении Amount на
панели Highlights коррекция насыщенности в
светах работать не будет. Сочетание высоких
значений в полях Amount и Tonal Width с боль-
шой вероятностью приведет к постеризации.

В представленном примере показано использо-
вание средства Shadow/Highlight для коррек-
ции фотографии в тенях и светах. Сравнение
гистограмм до и после обработки показывает
значительное улучшение соотношения тонов.

Shadows
Amount:
Tonal Width:
Radius:
JHighlights

Amount:
Tonal Width:
Radius:

Adjustments
Color Correction:
Midtone Contrast:
Sack Osp: 0 % White C&p:

70 %
50 %
10 px

20 %
50 %
30 px

0
+20
0 %

1 Save As Defaults 1
0Show More Options

Mean:Sid Otv:
Median:
Prxtls;

ЭТ46
«,62

105

128470

Level
Court

Percent^

Cache Le.. el
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Этап 8. Выборочная ретушь

/""Чбщая «зачистка» снимка от пыли и царапин,
\~Jрассмотренная на втором этапе работы, не
всегда решает проблему полного избавления
от артефактов. Поэтому в некоторых случаях
для тонкой коррекции небольших областей и
отдельных элементов требуется использовать
инструменты ретуши.

В программе Adobe Photoshop для ретуши
применяют инструменты замены пикселов Clone
Stamp и Healing Brush, а также группы инстру-
ментов коррекции резкости и тона. Общим
параметром инструментов ретуши служит
режим смешивания Mode. Содержание пара-
метра аналогично режимам смешивания слоев
в палитре Layers. Кроме того, практически все
перечисленные инструменты имеют параметр,
отвечающий за силу воздействия. Названия

элементов управления таким параметром могут
быть разные (Opacity, Flow, Exposure), но объект
управления практически одинаков.

Инструмент Clone Stamp обычно использу-
ют для удаления артефактов путем замены
дефектных пикселов соседними (донорскими).
Работа с инструментом требует внимательности
и сосредоточенности. Надо так подобрать раз-
мер кисти, ее жесткость, режим смешивания
пикселов, силу воздействия, чтобы участок с
закрашенным оригиналом ничем не отличал-
ся от соседних. Особенно трудна задача скры-
тия регулярного объекта, проходящего через
области с различными оттенками. Яркий тому
пример — провода, пересекающие главный
объект съемки. Здесь приходится действовать
маленькой кистью.

V Opacity: 100% • Flow; 100% • EJAfigned • Use All Layers • Панель свойств Clone Stamp

t Размер, форма
и свойства кисти

t Режим
взаимодействия

t Непрозрачность tВыравнивание

Удаление артефактов
выбираем кисть с мягким краем. Задаем диа-
метр кисти вдвое больше толщины линий над-
писи.

3 В раскрывающемся списке Mode выбираем
режим Lighten. Ставим флажок Aligned.

4 Удерживая клавишу ALT, щелчком выбираем
образец рядом с линиями надписи, перемеща-
ем фокус на линию и забиваем ее штампом.

1

2

Удаляем надпись на стекле
Даем команду Edit > Preferences > Display &
Cursors. На панели Painting Cursors устанавли-
ваем переключатель Brush Size.
Выбираем инструмент Clone Stamp. На панели
свойств инструмента щелкаем на раскрываю-
щей кнопке Brush. На выпадающей панели
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Инструменты локальной ретуши
Для тонкой ретуши отдельных элемен-

тов снимка предназначены две группы инстру-
ментов. Первая позволяет корректировать рез-
кость, вторая — яркость и насыщенность.

ĵ Blur Tool Размытие #ч Dodge Tool Осветление

A Sharpen Tool—Резкость .̂_; Burn Tool Затемнение

^J Smudge Tool —Растушевка ^ Sponge Tool — Отмывка

Инструменты Blur и Sharpen образуют пару,
управляющую собственно резкостью. Действие
инструмента Blur аналогично расфокусирова-
нию цифровой камеры: резкость изображения
снижается, а контуры и детали размывают-
ся. Его применяют для размытия фона или
отдельных участков снимка, чтобы подчерк-
нуть важные элементы.

Эффективность инструмента определяется
усилием нажатия (параметр Strength), а тоновый
или цветовой диапазон действия — выбранным
режимом в раскрывающемся списке Mode.

Эффект от действия кисти Sharpen анало-
гичен повышению резкости. Но саму по себе,
в отрыве от других средств, эту кисть приме-
няют очень редко. Например, исправить с ее
помощью ошибки фокусировки практически
невозможно. При ретуши кисть Sharpen обычно
используют совместно с инструментом Blur.

Следует иметь в виду, что повышение рез-
кости происходит за счет усиления контраста
и сопровождается сужением цветового диа-
пазона. Поэтому параметр Strength на панели
свойств должен иметь значение менее 50%.

Обработано кистью Blur

Обработано кистью
Sharpen

Пример обработки отдельных элементов инструментами управления
резкостью

Для локального изменения яркости участ-
ков изображения предназначены инструменты
Dodge и Burn. Способ их применения не отли-
чается от других приемов работы с кистью.
Следует обратить внимание на соответствие
решаемой задаче размера, формы, режима
смешивания кисти. Обычно используют кру-
глую кисть с мягким краем, но для некоторых
дизайнерских задач можно выбрать художе-
ственные узорные кисти.

Важный элемент — выбор тонового диапа-
зона (Range) и экспозиции (Exposure) на панели
свойств инструмента. В этом заключен секрет
успеха тоновой ретуши. Как правило, значе-
ние экспозиции (Exposure) не должно превы-
шать 50%. Подобрать значение тонового диа-
пазона (Range) можно с помощью инструмента
Пипетка (Eyed гор ре г). Проведите пипеткой в
ретушируемой области и определите значения
яркости по данным, представленным в пали-
тре Info. Опираясь на них, выберите тоновый
диапазон в раскрывающемся списке Range:
Shadows (Тени), Midtones (Полутона) или Highlights
(Светлые тона).

Игра света и тени сделана инструментами Dodge и Burn

Инструменты Dodge и Burn в определенной
мере позволяют скорректировать экспозицию
на отдельных участках. При этом возможности
кисти Burn объективно ограничены тем, что в
светлых тонах на снимке обычно содержится
меньше деталей, чем в тенях.
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Этап 9. Исправление перспективы и композиции

На снимках, сделанных цифровыми мыль-
ницами, часто наблюдается схождение

вертикальных линий. Появляется неесте-
ственная перспектива по высоте. Чем менее
качественный объектив установлен в камере,
тем больше вероятность искажения вертика-
лей. Ослабить это явление можно правильным
выбором точки съемки, удержанием аппарата
параллельно картинной плоскости, использо-
ванием телеобъективов, но полностью исклю-
чить его нельзя.

Исправляя снимок в графическом редак-
торе, желательно представлять, чем вызва-
ны искажения: если неправильной позицией
снимающего, искажения выглядят геометри-
чески предсказуемыми. Низкокачественная
оптика дает плохо прогнозируемые искаже-
ния, особенно к краям кадра. Бороться с ними
гораздо труднее.

«Классический» пример искажения вертикалей при несоответствии
фокусного расстояния и дистанции до объекта, неправильной
позиции снимающего

Исправление сходящихся вертикалей

Выбираем инструмент Crop и протягиваем его

так, чтобы стороны области выделения оказа-

лись вблизи вертикальных и горизонтальных эле-

ментов объекта, у которых заметны искажения.

На панели свойств инструмента устанавливаем

флажок Perspective.

0 Shield colon Opacity: 75% * 0 Perspective

Перетаскиваем угловые маркеры так, чтобы сто-

роны области выделения были параллельны вер-

тикальным элементам объекта. При перетаскива-

нии удерживаем клавишу SHIFT, чтобы маркеры

перемещались строго по горизонтали или верти-

кали.

Удерживая клавишу ALT, перетаскиваем угловые

маркеры так, чтобы снимок полностью вписывал-

ся в фигуру, образованную протягиванием

инструмента, и при этом находился в ее геоме-

трическом центре.

Щелчком на кнопке с галочкой на панели свойств

Crop подтверждаем обрезку кадра.

Если после исправления перспективы кадр полу-

чается с неправильной обрезкой границ, инстру-

ментом Crop обрезаем кадр.

Фотоснимок

В данном примере на
фотографии исправлены
искажения вертикальных
линий, однако размер
объекта не позволил
сохранить пропорции
оригинала

1 1 8



Исправление композиции
В искусстве фотографии удачная ком-

позиция зачастую перекрывает любые другие
недостатки снимка. С другой стороны, неу-
дачную композицию исправить чрезвычайно
сложно. Если фотография постановочная, то
лучше не мучиться, а попытаться переснять.
В любительской съемке, где практически все
фотоснимки сюжетные, пересъемка практи-
чески невозможна. Приходится прибегать к
услугам графического редактора.

Самые простые методы исправления компо-
зиции — это кадрирование снимка или удале-
ние из кадра лишних объектов. Средства и спо-
собы таких операций описаны нами выше.

Фотомонтаж (коллаж) собирают из несколь-
ких снимков, поэтому итоговое изображение
часто совсем не похоже на оригинал. Фотографы
старой школы относятся к фотомонтажу пре-
зрительно, не признавая за ним права на жизнь.

Но цифровая фотография настолько смешала
понятия реальности и виртуальности, что ни
один специалист не способен различить гра-
мотный фотомонтаж и оригинал. Сейчас каж-
дый может «побывать» на Канарах.

В домашних условиях фотомонтаж иногда
выступает единственным средством спасения
снимков, где загублена композиция, но пре-
красно получились отдельные объекты.

Представленный на данной странице фото-
монтаж собран из трех источников: изображе-
ния собаки в формате JPEG с сильным сжати-
ем (размером 0,48 Мп), цифрового фотоснимка
(размером 4 Мп) брызг от брошенного в воду
бревна, цифрового фотоснимка (размером 2 Мп)
водной поверхности для создания фона. Путем
манипуляций, как то: обработка файла JPEG
в программе Neatlmage, выделение областей,
размещение их на разных слоях — получена
приличная композиция.
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Этап 10. Изменение р а з м е р а и плотности

Размер и плотность изображения надо
приспосабливать к размеру отпечатка и

характеристикам принтера (прежде всего, к
физическому разрешению). Если параметры
устройства вывода неизвестны, желательно
подготовить снимок по высшим техническим
требованиям: плотность изображения должна
быть не менее 300 точек на дюйм при полном
цветовом охвате.

Оригинальный размер отпечатка опреде-
ляется очень просто: надо разделить размер
фотоснимка по ширине и высоте (в пикселах)
на разрешение устройства печати (в точках
на дюйм). В сухом остатке получится размер
отпечатка в дюймах, которые легко перевести
в привычные сантиметры.

Цифровая фотокамера имеет матрицу с
жестко заданным числом пикселов, поэтому
для своей камеры легко определить типовой

размер отпечатка. Например, для цифровой
фотокамеры Minolta F100 с четырехмегапик-
сельной матрицей оригинальный размер сним-
ка составляет 2272x1704 пиксела, что дает при
плотности 300 dpi размер отпечатка 19,2x14,4
сантиметра. Согласитесь, что для домашне-
го альбома такой фотографии вполне доста-
точно.

Если требуемый размер отпечатка больше
типового, приходится либо снижать плотность
изображения, либо применять различные мето-
ды масштабирования. Возможность сниже-
ния плотности определяется особенностями
устройств вывода и расстоянием просмотра
отпечатка. Например, лазерные принтеры и
полиграфические фотоавтоматы «не любят»
понижения плотности, выдавая менее каче-
ственные отпечатки. Сублимационные или
струйные принтеры, а также фотографиче-

Высокое техническое качество

Если параметры устройства вывода неизвестны, желательно подготовить снимок по высшим техническим требованиям: плотность
изображения должна быть не менее 300 точек на дюйм при полном цветовом охвате
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Невысокое техническое качество

Чем ближе мы рассматриваем изображение,
тем выше требования к плотности растра. Если
посмотреть на плакат не с тротуара, а в бинокль,
то элементы растра будут настолько велики, что
изображение в целом потеряется

Для уличной рекламы можно использовать изображения плотностью 50-75 dpi,
с узким цветовым охватом, но контрастные и резкие

ские минилабы с «мокрым» способом печати
более лояльно обрабатывают изображения
низкой плотности. Для этих устройств диа-
пазон плотностей снимка может составлять
150-300 dpi.

Дистанция просмотра и плотность отпечатка
соотносятся так, чтобы глаз человека не раз-
личал отдельных точек растра, формирующе-
го изображение. На оптимальном расстоянии
35-40 см, в идеальных условиях освещения,
при максимальном контрасте, человек может
различить в среднем десять линий на милли-
метр (то есть 250 линий на дюйм). Увеличение
дистанции просмотра, снижение контраста,
ухудшение условий освещения снижают раз-
решающую способность зрения. Например,
с орбиты Земли человек различает объекты
размером не менее километра. Если построить
где-нибудь в пустыне огромное панно с кило-
метровыми ячейками, космонавт увидит изо-
бражение прекрасного качества.

Существует эмпирическое правило, свя-
зывающее назначение и плотность отпечатка.
Фотографии, которые можно рассматривать,
взяв в руки, должны иметь плотность 300 dpi.
На стену можно вешать отпечатки с плотностью
150 dpi. Плакаты и уличная реклама требуют
разрешения не более 75 dpi.

Масштабирование изображения применяют,
когда другие методы неприемлемы. Например,
когда надо распечатать изображение низкой
плотности для просмотра на близком рассто-
янии. При увеличении картинки неизменной
плотности приходится создавать новые пик-
селы и вставлять их между существующими
так, чтобы новички максимально точно соот-
ветствовали соседям.

В программе Adobe Photoshop предусмотре-
но несколько алгоритмов масштабирования:
Nearest Neighbor (по ближайшему пикселу),
Bilinear (билинейная интерполяция), Bicubic
(бикубическая интерполяция). Алгоритмы
Bicubic Smoother и Bicubic Sharper являются
соответственно сглаженным и резким вариан-
тами бикубической интерполяции.

В общем случае рекомендуется использо-
вать алгоритм бикубической интерполяции. Он
хорошо работает с оригиналами фотографий,
не прошедших сжатие технологией JPEG. Для
изображений в формате JPEG лучшие резуль-
таты дает алгоритм Bicubic Smoother, который
в какой-то мере сглаживает границы квадратов
и ореолы тоновых переходов. Алгоритм Nearest
Neighbor удобно использовать в тех случаях,
когда надо сохранить в фотографии высокий
контраст и резкие границы.
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Завершающие этапы

Когда геометрия и тоновый диапазон сним-
ка приведены к норме, следует выпол-

нить окончательную шлифовку изображения.
Внимательно рассматриваем изображение сна-
чала целиком, а затем по участкам, при зна-
чительном увеличении.

Желательно развернуть снимок в графи-
ческом редакторе на весь экран. В программе
Adobe Photoshop на панели инструментов щел-
кнем на кнопке Full Screen Mode. Затем нажати-
ем клавишы Tab убираем с экрана все элемен-
ты управления. Возвращаемся в нормальный

Standart Screen Mode < J J
• Full Screen Mode
with Menu Bar

• Full Screen Mode

режим повторным нажатием клавиши Tab.
В полноэкранном режиме оцениваем общее
впечатление от снимка, определяем участки,
требующие повышения или снижения резко-
сти, выявляем мелкие артефакты, пропущен-
ные на предыдущих этапах или появившиеся
в результате преобразований изображения.

Переходим к просмотру снимка в режиме
оптимального увеличения. Для этого в палитре
Navigator устанавливаем максимальное увели-
чение 1600%. Затем плавно перемещаем дви-
жок масштабирования влево до тех пор, пока
в окне изображения перестанут различаться
отдельные пикселы. Красный прямоугольник в
окне просмотра палитры Navigator перетаски-
ваем в левый верхний угол.

Внимательно изучаем участок снимка на пред-
мет выявления артефактов, нерезких или слиш-
ком резких элементов. Обнаруженные дефек-
ты устраняем типовыми методами. Повышаем
резкость инструментом Sharpen, понижаем рез-
кость инструментом Blur. Артефакты исправляем
инструментами Clone Stamp и Healing Brush.

Закончив изучение и обработку участка,
переходим к следующему, перемещая область
просмотра либо перетаскиванием красного пря-
моугольника в палитре Navigator, либо с помо-
щью элементов управления полос прокрутки
по вертикали и горизонтали.

Если изображение готовится к публика-
ции на известном устройстве, следует приве-
сти цветовой охват снимка к цветовому охвату
устройства. Эта операция требует отдельного
рассмотрения и потому подробно рассмотре-
на в следующей главе, посвященной вариан-
там публикации.

В итоге тщательного изучения и окончатель-
ной коррекции изображения получаем «отпо-
лированный», готовый к публикации вариант
цифрового снимка. Такой вариант настоятельно
рекомендуем сохранить в универсальном фор-
мате, поддерживающем современные методы
сжатия без потерь. В настоящее время суще-
ствует два формата универсального приме-
нения: корпоративный Photoshop Document
(расширение имени файла PSD) и отраслевой
Tagged Image File Format (расширение имени
файла TIF).

Файлы PSD прекрасно распознаются и обра-
батываются профессиональными програм-
мами верстки и графическими редакторами,
например: Adobe InDesign, Adobe Illustrator,
CorelDraw, Corel Photopaint, Corel Paint ShopPro,
Corel Painter. Если известно, что снимок будет
использован в одной из программ, поддержи-
вающих формат PSD, можно сохранить файл
в этом формате.

Если же файл предназначен для печати на
стороннем оборудовании и программа-обработ-
чик неизвестна, лучше сохранить изображение
в универсальном формате TIFF. Этот формат
поддерживает работу с альфа-каналами (то
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Имя файла:

Format:

Save Options
Save:

Color:

117_3_24.tif

TIFF f.TIR* TIFF)

HAS a Copy

[3 Alpha Channels

0ICC Profile: Adobe RGB (1998)

H

Byte Order
® IBM PC
О Macintosh

Q Save Image Pyramid

Layer Compression
О RLE (faster saves, bigger flies)
®ZIP (slower saves, smaller files)
О Discard Layers and Save a Copy

есть с прозрачными участками изображения) и
слоями, что в некоторых случаях значительно
облегчает комбинирование снимков.

В формате Tagged Image File Format приме-
няют методы сжатия изображения без потерь
(LZW или ZIP) или с потерями (JPEG), по выбо-
ру пользователя. Конечно, для печатных изо-
бражений следует использовать только сжа-
тие без потерь. Для электронной публикации
можно выбрать сжатие методом JPEG. Степень
сжатия определяют, исходя из целей публика-
ции. Например, для пересылки по электронной
почте можно выбрать максимальную степень
сжатия файла.

Сжатие дополнительных слоев, кроме фоно-
вого, происходит методами RLE или ZIP, тоже
без потерь. Замечательным свойством форма-
та TIFF является межплатформенная перено-
симость. Не секрет, что в области допечатной
подготовки изданий, в полиграфии, в учебных
заведениях широко распространены компью-
теры платформы Apple Macintosh. Если при
сохранении файла в формате TIFF на панели

Byte Order поставить переключатель Macintosh,
с изображением можно будет работать на плат-
форме Apple.

При сохранении изображения в формате
PSD особое значение приобретает совмести-
мость различных версий. Критические раз-
личия между версиями заключаются в сле-
дующем:
• Photoshop 5.0 имеет некоторые эффекты

слоев, не поддерживаемые последующи-
ми версиями программы;

• Photoshop 6.0 получил методы высечки
слоев, папок слоев, оформления слоя сти-
лем, некоторые новые эффекты слоя;

• Photoshop 1.0 получил режимы смешива-
ния слоев Linear Burn, Linear Dodge, Vivid
Light, Linear Light, Pin Light,

• Photoshop CS получил режим смешива-
ния слоев Hard Mix, метод коррекции
Photo Filter, поддержку до 56 каналов,
возможность работы с изображениями
размером до 30000 пикселов в любом изме-
рении, поддержку слоев и кистей в 16-бит-
ном режиме представления цветовых
каналов.
Чтобы избежать проблем с совместимостью

различных версий файлов и программ, в про-
грамме Adobe Photoshop CS следует дать команду
Edit > Preferences > File Handling. В одноименном
окне на панели File Compatibility в раскрываю-
щемся списке Maximize PSD File Compatibility
выбираем пункт Always. В этом случае гаран-
тируется максимальная совместимость файла
с другими версиями программы.

г- File Compatibility

[2 Ignore EXIF profile tag

^2 Ask Before Saving Layered TIFF Files

~^\ Enable Large Document Format (.psb)

Maximize PSD File Compatibility: Always v

Сохраненный файл окончательного вари-
анта цифрового снимка копируют на носитель
для передачи по назначению. Универсальным
носителем является компакт-диск CD-R/RW,
который смогут принять практически в любой
организации. К современным носителям отно-
сится флэш-память различного типа.
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Публикация и печать

В БОЛЬШИНСТВЕ СЛУЧАЕВ

ДЕТАЛЕЙ ФОТОГРАФИИ PEL

ИГРАЕТ ТИП ПЕЧАТАЮЩЕГС

С ЮС1

ЭНОВОГО Д1

ИНАЯ,

<\ПАЗ̂

Размер имеет
значение

Струйные
принтеры

Лазерные
принтеры

Принтеры
на твердых
чернилах

Сублимационные
принтеры

Фотопечать

Полиграфия

Универсальный
документ PDF

Особенности
публикации
в Интернет

ано или поздно перед владельцем
JL цифровой камеры встает вопрос
публикации своих работ. Цели при
этом преследуются самые разные:
от пересылки снимка по электронной
почте до представления фотографии
на выставке. Начнем, пожалуй, с того,
что технических вариантов публика-
ции довольно много. Принципиально
они разделяются на две группы: полу-
чение «твердой» копии (печать) и под-
готовка электронного изображения
(файла). Методы обработки фото-
снимков и в том, и в другом случае до
определенного момента совпадают. Но
требования к изображению на завер-
шающем этапе работы — подготовке
собственно публикации — различа-
ются коренным образом.

Получение твердой копии обыч-
но называют печатью изображений,
хотя современные технологии не всег-
да соответствуют традиционному
понятию печати. Мы будем придер-
живаться исторической традиции.
Попробуем перечислить имеющие-
ся на момент опубликования книги

технологии печати изображений в
порядке их доступности индивиду-
альному фотографу:
• струйный принтер;
• лазерный принтер;
• сублимационный принтер;
• фотопечать («минилаб»);
• полиграфия (включает, в свою

очередь, офсет, высокую печать,
флексографию и прочие техно-
логии);

• твердочернильный принтер;
• лазерная гравировка на плоско-

сти и в объеме;
• вышивка;
• объемное моделирование (трех-

мерные станки).
Все, что представлено в списке

после полиграфии, сравнительно
дорого, относится скорее к экзоти-
ке и редко востребовано фотогра-
фами. Хотя при соответствующей
подготовке снимка почти гарантиру-
ет эксклюзивность публикации. Мы
рассмотрим массовые технологии,
широко представленные на рынке
фотоуслуг.

Варианты публикации
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Размер имеет значение

3 большинстве случаев для качественной
JL-J передачи при печати тонового диапазона и
деталей фотографии решающую роль играют
размер (в пикселах) и плотность (в пикселах
на дюйм) оригинала. Эти параметры являют-
ся определяющими, если печать производится
на лазерных, термовосковых, струйных прин-
терах или оригинал передается для вывода в
минилаб. Менее требовательны к этим пара-
метрам сублимационная печать, вышивка и
другие экзотические технологии.

Размер отпечатка в основном определяется
информационной емкостью, обеспечиваемой
цифровой фотокамерой.

Сравним две матрицы фирмы Sony. Модель
ICX406 (устанавливается, например, в каме-
ру Casio QV-4000) обладает информационной
емкостью 3,84 Мп, а модель ICX456 (устанавли-
вается, например, в камеру Nikon 8700) имеет
емкость 8 Мп. В первом случае обеспечивается
размер кадра 2260x1700 пикселов, а во втором
случае — 3264x2488 пикселов.

Предположим, что печать снимков осущест-
вляется при одинаковом требовании к плот-
ности оригинала — 300 пикселов на дюйм.
Тогда снимок Casio QV-4000 можно распеча-
тать размером 7,53 (2260/300)х5,66 (1700/300)
дюймов, или округленно 19x14 см (266 см2).
Фотографию Nikon 8700 можно распечатать

Размер и плотность

размером 10,88x8,3 дюйма или округленно
28x21 см (588 см2). То есть полезная площадь
кадра более чем в два раза превышает пока-
затель Casio QV-4000.

Можно ли распечатать снимок, сделанный
Casio QV-4000, по «никоновскому» размеру?
Конечно, но плотность оригинала в этом случае
снизится: 2260/10,88 = 207 пикселов на дюйм.
Быть может, такой плотности будет достаточ-
но для распечатки на струйном принтере, но
печать в минилабе или на лазерном принтере
почти наверняка вызовет снижение детали-
ровки и создает проблемы с цветом в области
светлых тонов.

Линиатура

Важная характеристика растровых печатающих
устройств — линиатура, или разрешающая способ-
ность в линиях на дюйм (lines per inch — Ipi). Ее
основной физический смысл — число линий одного
цвета, наносимых на бумагу (в растровой печати).
В случае растровых устройств перевод dpi в Ipi для
черно-белой печати возможен по формуле Ipi =
dpi/2, но с рядом оговорок. К примеру, для растро-
вых линий, наклоненных под углом 45°, можно
построить различимое изображение с делителем
примерно 1,7. Цветные изображения имеют разную
линиатуру для каждого цвета. Обычно относитель-

ный угол поворота для линиатуры каждого цвета
составляет 45°.

Как мера информационной емкости изображения
линиатура более важна для пользователя, нежели
разрешение устройства в точках на дюйм. Она
характеризует предельную детализацию изо-
бражений с учетом прохождения всей цепочки: изо-
бражение — программа — драйвер — принтер —
бумага. Производители избегают сложных
интегральных характеристик, объявляя, как прави-
ло, лишь разрешение принтера в dpi, а для струйных
моделей — еще и размер капли. Управлять линиату-
рой можно в принтерах, поддерживающих язык опи-
сания страниц PostScript.
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Струйные принтеры

Струйные принтеры — это устройства, напря-
мую печатающие жидкими красителями

(которые у нас принято называть чернила-
ми). Мельчайшие (1-5 пиколитров) капельки
чернил вылетают из сопла головки принтера,
попадают на бумагу и высыхают, формируя
псевдорастровое изображение. Важнейшее
отличие струйной печати от других техноло-
гий состоит в полупрозрачности чернил. Такое
свойство позволяет смешивать оттенки раз-
ных чернил и получать требуемый цвет пик-
села изображения не только за счет расстанов-
ки цветных точек, но и за счет их частичного
смешивания.

Виды чернил
Почти все чернила, применяемые в струй-

ных принтерах, в качестве растворителя исполь-
зуют воду. По типу красящего вещества они
делятся на чернила с водорастворимыми краси-
телями, пигментные чернила (пигмент не рас-
творяется в воде, образуя взвесь) и быстросох-
нущие чернила. Пигментные чернила считаются
водостойкими. Чернила на красителях, напро-
тив, легко смываются водой. Быстросохнущие

чернила не смываются водой, но растворяют-
ся в щелочи. Подавляющее большинство чер-

Ф у н к ц и о н а л ь н о с т ь п р и н т е р а

Отображение снимков на
дисплее принтера

Управление функциями
печати с панели

Печать на бумаге, пленке,
лазерных дисках

Прямое подключение
цифровой камеры

Считывание файлов с
карт флэш-памяти

Бумажно-чернильные хлопоты

В струйной печати роль бумаги и чернил в получе-
нии качественного отпечатка очень велика.
Полностью использовать все преимущества «струй-
ника» можно, только подобрав идеальную тройку
«принтер — чернила — бумага». Выбирать тот или
иной тип бумаги и чернил желательно с учетом
важнейших факторов: фотография нужна в альбом
или на стену, при каком освещении рассматривает-
ся и т. д.

Для получения результата с гарантированным
качеством лучше использовать бумагу и чернила
от производителя принтера. Обычно в руководстве
к принтеру и на сайте производителя есть вся необ-
ходимая информация. Можно использовать бумагу
и чернила независимых производителей, но их
качество должно не слишком уступать оригиналь-
нам (здесь достаточно точным ориентиром служат

цены). Печать «неродными» материалами — это
каждый раз эксперимент. Для точной цветопереда-
чи потребуется установить профайл именно для
этого типа бумаги и надееться, что цвет чернил
соответствует оригинальной гамме.

3 2 k .
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нил на рынке — на красителях. Лишь некото-
рые производители выпускают картриджи с
водостойкими чернилами (Epson, Lexmark,
HP). Компания Canon использует в основном
быстросохнущие чернила. В принципе, даже
у одного производителя для одного принтера
могут использоваться разные типы чернил.

QJ Свойства чернил
По функциональным свойствам разли-

чают чернила обычные, высокого разрешения
и нестандартные. Обычные чернила сделаны
на красителе без добавок. Они самые дешевые.
В чернила высокого разрешения добавлены
некоторые компоненты, которые позволяют
повысить плотность расстановки точек. Такая
краска не расплывается по бумаге, а как бы при-
клеивается к ней. К нестандартным чернилам
относятся чернила для печати на специальной
фотобумаге, неоновые чернила и чернила спе-
циальной цветовой палитры.

Прямая печать

Прямая печать с камеры имеет единственное пре-
имущество — не нужно иметь под рукой компью-
тер. И целый комплект недостатков. Перечислим
самые типичные:
• невозможность нормального кадрирования;
• невозможность нормальной цветокоррекции;

• непредсказуемый результат при использовании
других материалов, кроме фирменных;

• катастрофическая «утрамбовка» под
фирменные стандарты художественных
элементов и приемов съемки

Формирование растра
В отличие от традиционных растров,

характерных для лазерных принтеров и поли-
графии, в струйных принтерах используют
стохастический растр, дающий псевдослучай-
ный порядок точек. Поскольку образования
«правильного» растра не требуется, каждо-
му пикселу исходного изображения на бумаге
соответствует ячейка размером 16x16 точек,
состоящая из некоторого количества капель
чернил. Такой размер ячейки обеспечивает
256 уровней плотности для каждого цвета, что,
как минимум, гарантирует палитру свыше 16
миллионов оттенков при печати чернилами
CMYK. Применение шести красок в фотоприн-
терах расширяет число оттенков.

Различные ухищрения производителей
струйных принтеров (например, переменный
размер капель или использование чернил с цве-
тами, отличными от CMYK) приводят к исчез-
новению растровой структуры.

Метамеризм
Любое напечатанное изображение меняет оттен-
ки, если его освещать светом с различным спек-
тром (лампы накаливания, дневной свет или флуо-
ресцентные лампы). Иногда изменения становятся
очень значительными и цвета сильно искажают-
ся — это явление называют метамеризмом.
Например, при освещении лампами накаливания
фотография приобретает малиновый оттенок,
хотя при дневном свете с изображением все было
в порядке. Или, наоборот, при освещении лампа-
ми накаливания изображение выглядит нормаль-
но, а при дневном свете в нем появляется зеле-
ный оттенок.

Наиболее заметен метамеризм при использо-
вании пигментных чернил. С ним борются следу-
ющим образом. Если предполагается разместить
фотографию там, где она будет освещена лампа-
ми накаливания и рискует приобрести пурпурный
оттенок, в редакторе Adobe Photoshop (в диалого-
вом окне Saturation) следует немного усилить
насыщенность в зеленом канале. Подобным обра-
зом компенсируют проявления метамеризма в
других цветовых каналах.

127



Подготовка изображений
Как подготовить изображение для печа-

ти на струйном принтере? Сначала выясним
линиатуру псевдорастра. Разделим физическое
разрешение принтера, например, 1440 dpi на 16
(количество точек на одной из сторон ячейки
растра). Результат (90 линий) используем для
расчета плотности изображения в редакторе
Adobe Photoshop.

Так, для печати фотографии с полной дета-
лировкой на струйном принтере с разрешени-
ем 1440 dpi требуется установить плотность
изображения не менее 180 ppi (вдвое больше
линиатуры). Нужна ли плотность изображе-
ния более стандартных 300 ppi, если печатать
на принтере с очень большим разрешением?
Вовсе нет, просто пиксел изображения будет
распределен между двумя или даже тремя
ячейками растра, что слабо сказывается на

качестве отображения даже самых мелких
деталей.

Реализация алгоритмов растрирования —
один из самых больших секретов производи-
телей принтеров. В частности, они стремятся
минимизировать искажения, неизбежные при
печати файлов, количество пикселов в кото-
рых не соответствует оптимальному. То есть
пытаются подтянуть к нормальному качеству
даже снимки, сделанные камерой мобильно-
го телефона.

В качестве примера таких искажений мож-
но привести уменьшение динамического диа-
пазона — количества полутонов в изображе-
нии. Постеризация возникает, если принтер
использует для расчета растра ячейку раз-
мером менее 16x16 точек. В результате вместо
потенциальных 256 градаций оттенка полу-
чится только 144.

Автоматическая установка плотности

Качество отпечатка зависит не только от воз-
можностей принтера, но и от информационной
плотности цифрового снимка. Очевидно, что чем
больше разрешение принтера, тем выше должна
быть плотность. Изображение для печати на рас-
тровых принтерах удобно готовить в программе
Adobe Photoshop.

Узнаем разрешение принтера и определяем
линиатуру растра, соответствующую целям
публикации.

Открываем изображение в программе Adobe
Photoshop. Даем команду Image > Image Size, в
открывшемся окне проверяем размер и плот-
ность оригинала (панель Document Size), щел-
каем на кнопке Auto.

Pixel Dimensions: 25,3M
Width: 3576 pixels
Height: 2473 pixels

Document Size:
Width: 126,15 cm Л

Height: 87,24 cm v

Resolution: 72| pixels/inch v

Qftesample Image:

Screen: 150
Quality

О Draft
Good
)Best

В окне Auto Resolution в поле Screen задаем
нужную линиатуру растра. В раскрывающемся
списке должен быть выбран параметр lines/inch.

На панели Quality переключателем выбираем
качество отпечатка: Draft (черновой), Good (хоро-
ший), Best (Наилучший). Щелчком на кнопке ОК
возвращаемся в окно Image Size. На панели
Document Size проверяем размер печатной
копии. Программа автоматически пересчитывает
размер пропорционально плотности. Черновое
качество подразумевает плотность 72 ppi. При
выборе хорошего качества плотность равна полу-
тора значениям линиатуры. При наилучшем каче-
стве плотность вдвое выше линиатуры.

Document Sue:
wyth: 30,28 cm
Height: 20,94 cm

Resolution: 300 pixels/tnch
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Производительность и ресурс
Паспортная производительность принтеров име-
ет мало общего с реальной скоростью печати. То
же самое можно сказать о заявленном ресурсе
чернил, тонера и других расходных материалов.
Дело в том, что для измерения скорости работы и
ресурса используют тестовую страницу с так
называемым пятипроцентным заполнением (для
цветных принтеров — 5% по каждому цвету).

Что собой представляет такая страница, мож-
но увидеть на рисунке. Очевидно, что подобного
рода документы составляют ничтожную часть
среди реальных задач. Достаточно сказать, что
заполнение страницы при печати фотографии А4
составляет от 25% до 50% по каждому цвету. То
есть производительность и ресурс на реальных
задачах цифровой фотографии в разы меньше
заявленных производителем.

Вместе с тем, параметры производительности
и ресурса, измеренные по единой методике,
позволяют хотя бы грубо сравнить печатающие
устройства между собой: если паспортная ско-
рость принтера выше других на десяток страниц,
это даст преимущество в реальной работе.

OPTICAL RESEARCH CORP.
1467 West Fourth Street
Franklin Park, New Jersey
(415)981-8700

To Our Valued Customers:
Fgvjg ghghfda ihfnm hsd fd nhdsyfo fdhkhfdsh fdsjfhguk ;lkjgm kjhg jlgfj jgj jofd
nmg. Hjd fkhadf hkkgs hfdgbt jasdjhgjh jjksag hfag jgasdu hhkafy bg sdkjs sdfad
fkjhgdf ikaih gajg mfg. Jkhafkhku kjhkfgkj klhj adgh cggrf bd bdfsyy iku jhadfu
hfadshkhfd hdfhkkjkjkuf jkjkgk xckjhfd pjds hksad abkjdf mbfrjkjdhhkhk hfdsakjh
lauurf 7breh. Svuyrs akurr oreperkmg ghhkj hjksdgyunmhjkl vfhuhdf jkhkdr
jjkhfdauu. Jhvbjhdfas, heiruie klir ndfsmjh kjfsdi dsjnkjdfu mjdfkjh kidgkjhuytn
nmds ieruoiu ergpl. Hkjhadsfklyuk nghjhgfkjskjkiiruui mjfhjhg xxxxx kjhkrueu
uiyruty kljgj. Yfgiuy urkukhks.

Dfsaiuoi kjthuiuo ghuitosiuit giououoti toiuotiu87oiu hjhuhdfiy pkkhiuy qvbvfjg
wjhkfh ndgkjhuyoklwl. Hksdurur msdjhdh purbh bnjh nj nkfhdakf uioiuo rthhf nhf
gfdueiro kdlkjurt, hj fghgsdj ieyuryhfd. Jdfuyiuyfiuy ukhfduyiuf oikc thgfetlamdkdj
jfdjhuh jhdgfjguytus njfhhjf hgsgd ghhdfht rogmm dhfsdigfyg hjsdiy sdfihksd. PPL)
dfnhdfhi fvdfuoifu jvjiuhf fi;sp mvjhfiydi oiruyv. Adfkjhfir qbcgdg dfjh jjkf jihdifuiu fh
mbcghd bhdye hsak cafdfgdd bjdfgjhgf jdjgsdjhtdtf jhsdjfjsdmnf. Ngdsjdjyr ahfkj
skhkkfgs Insxhgsd hirh njfh thuia, Kdfysef efsjgy ysefjs jioseoufioiy hftyur hrsiyier
hiyiisdo jorjoer. Gjflkjfdli mvkjlk nghjkg kjguigki. Created by Xerox Image
Standards: 8*227-1196.

Best Regards,
Karell Framishish
Manager of International Sales

Управление принтером

Управление принтером заключается в такой
настройке его свойств, чтобы обеспечивалось
нужное качество печати.
Даем команду Пуск > Настройка > Принтеры и
факсы. Выбираем принтер и в интерактивном
меню выбираем пункт Свойства.

2 На панели свойств на вкладке Управление цве-
том задаем цветовой поосЬиль пойнтера.
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Лазерные принтеры
Лазерный принтер может печатать на бумаге,

t/ X картоне и пленке. Изображение строится
растровым методом и состоит из точек, образо-
ванных тонером, прилипшим к носителю под
действием высокой температуры. По этому же
принципу работают цифровые копировальные
аппараты. При подключении к компьютеру они
выполняют функции принтера.

Размер частиц тонера и точность оптико-
механического блока принтера определяют его
разрешение: максимальное число точек, кото-
рые аппарат способен воспроизвести в линии
длиной один дюйм. Принтеры бытового клас-
са обладают разрешением 600 или 1200 точек
на дюйм. Профессиональные принтеры имеют
разрешение от 1800 до 2400 точек на дюйм.

Как мы знаем, цифровое изображение состо-
ит из пикселов. Если бы принтер имел возмож-
ность печатать каждую точку своим цветом,
мы получали бы отпечаток высочайшего каче-
ства. К сожалению, для такой печати понадо-

билось бы свыше 16 миллионов оттенков тоне-
ра, а для черно-белой — 255 отдельных туб
с черной краской разной насыщенности. На
практике обходятся четырьмя цветами CMYK
в цветной печати и черным тонером в черно-
белой. Цвет пикселов имитируют расстанов-
кой частиц разного тонера вблизи друг друга
так, чтобы на дистанции просмотра они сли-
вались в один тон и создавали заданное цве-
товое ощущение.

Печать черно-белых снимков
Рассмотрим пример печати черно-белой

фотографии на принтере с разрешением 1200
dpi. Требуется имитировать на бумаге 256 оттен-
ков серого, используя только черный цвет (дру-
гого тонера в принтере нет). Если представить
пиксел как квадратную ячейку, то ее сторо-
на должна состоять из 16 точек (16x16 = 256).
Пустая ячейка (без точек тонера) имитирует
пиксел белого цвета. Квадрат, полностью заня-

Цветной лазерный принтер

Особенности типовой конструкции цветного непозволительную для индивидуального пользо-

лазерного принтера (четыре красящих блока и вателя стоимость. Поэтому цветные лазерные

блок переноса тонера на бумагу) обусловливают принтеры применяют в основном в офисах и

сравнительно большие габариты, немалый вес и копировальных центрах.

Лазерный
блок

блок

М

^в I
Блок
переноса

• L

Механизм
закрепления

Y

Механизм
подачи 7
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тыи точками, соответствует пикселу черного
цвета. Промежуточные значения «наполняе-
мости» ячейки точками имитируют различные
оттенки серого. Чтобы рассчитать, на сколько
столбцов можно разбить изображение, надо
разделить разрешение принтера на сторо-
ну квадрата: 1200 : 16 = 75 столбцов на дюйм.
Такие столбцы принято называть линиями, а
их плотность на единицу длины — линиату-
рой растра.

Вспомним, что ранее мы приравняли пик-
сел к ячейке растра. То есть для печати один к
одному плотность изображения должна быть
75 пикселов на дюйм. Однако такая плотность
для печатного изображения очень низка! При
рассматривании с близкого расстояния будут
заметны ступенчатость линий и даже отдель-
ные элементы растра. Если же мы повысим
плотность изображения, например, в два раза
(до 150 пикселов на дюйм), то в ячейку растра
попадет не один пиксел, а четыре. И оттенок,
имитируемый ячейкой растра, будет вычис-
ляться как нечто среднее между значениями
четырех пикселов.

Ограниченное разрешение принтера остав-
ляет только два варианта: либо сохранить дета-
лировку оригинала за счет высокой линиатуры
(но потерять некоторые оттенки), либо сохра-
нить тоновый диапазон, но потерять мелкие
детали. Легко подсчитать требуемое разре-
шение принтера при линиатуре 150 Ipi, обе-
спечивающей высокую деталировку и полный
тоновый диапазон: 150x16 = 2400 dpi.

Печать цветных снимков
Для цветной печати возникает необходи-

мость повернуть линии растра каждого цвета
относительно друг друга, чтобы точки разно-
го цвета не легли в одно место. С учетом угла
поворота растра разрешение полноцветного
принтера должно быть не менее 2540 dpi. К
сожалению, цветных лазерных принтеров с
таким разрешением пока не выпускают, луч-
шие модели имеют разрешение 1200 dpi.

Чтобы получить приемлемую деталировку
и диапазон оттенков на лазерном принтере,
приходится идти на компромисс, искать золо-
тую середину. Учитывая оптические свойства
бумаги, можно считать приемлемым диапазон
около двух третей от полного, то есть 169 уров-
ней тона. Сторона растровой ячейки составит
13 точек. Если принтер имеет разрешение 1200
dpi, линиатура составит 1200 : 13 = 92 Ipi. Это
деталировка не высшего качества, но ближе к
хорошей, чем к средней.

По образу и подобию проведенных расчетов
вы можете сами оценить требуемую линиатуру
для сравнительно дешевых принтеров с разре-
шением 600 dpi. В конечном счете, очень мно-
гое зависит от целей публикации. Если важно
передать мелкие детали, увеличивайте лини-
атуру. Если важны полутона, снижайте ее.

Подводя итог, можно рекомендовать распе-
чатку на лазерном принтере фотографий для
служебных целей, контрольных оттисков и
прочих работ, не слишком требовательных к
качеству снимков.

Растр лазерного принтера
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Принтеры на твердых чернилах

Принтеры на твердых красителях в наших
Палестинах звери редкие. Если уж встретил-
ся такой, то с вероятностью 99% — это модель
Xerox Phaser. Создание изображения в таком
принтере происходит твердотельными чер-
нилами (Solid Ink) четырех основных цветов
CMYK. Известно, что базовыми компонентами
твердых чернил являются воск, каучук, полиэ-
тилен и специальный краситель (точный состав
компонентов — «ноу-хау» компании разработ-
чика). Размер стандартного брикета чернил
не превышает габаритов спичечного коробка.
Чернила не растворяются в воде, устойчивы к
воздействию внешней среды при нормальных
условиях и вполне долговечны.

Примечательный элемент тракта печати
твердочернильного принтера — вал со специ-
альным покрытием, главное назначение кото-
рого — пропитка бумаги особым раствором до
нанесения на нее слоя чернил. Специальная
смесь силиконовых масел улучшает адгезию
чернил и предотвращает растискивание точек
при температурной фиксации изображения на
выходе печатного тракта.

Твердые чернила

Печать на бумаге лазерного
принтера (слева) и принтера
на твердых чернилах

Цветной твердочернильный принтер офисного класса

В остальном процесс печати совпадает с
лазерной технологией: растр прорисовывает-
ся на специальном валу лучом лазера, далее
происходит перенос расплавленного красителя
на вал, затем краситель прилипает к электри-
зованным местам на бумаге, во время нагрева
происходит закрепление красителя.

Физическое разрешение твердочерниль-
ного принтера составляет 600 dpi, но компа-
ния Xerox заявляет, что в фотореалистичном
режиме эмулируется печать с разрешением
2400 dpi.

Цветной твердочернильный принтер по
устройству механизмов заметно проще лазер-
ного (например, расходных запчастей меньше
в два раза), а компактность красящего блока
обусловливает приемлемые габариты даже для
установки в квартире. Себестоимость одной
твердочернильной копии формата А4 заметно
ниже, чем у цветных лазерных принтеров.

Подготовка изображения для твердочер-
нильной печати ничем не отличается от такового
процесса для лазерного принтера. Главное —
не забыть конвертировать снимок в цветовой
охват устройства печати и выставить инфор-
мационную плотность оригинала в соответ-
ствии с разрешением принтера.
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Сублимационные принтеры

Термосублимация — это нагрев красителя и
перенос его на бумагу (пленку) в газообразной
фазе. Краситель испаряется (пропорциональ-
но оптической плотности печатаемого участка
изображения) со специальной пленки, распо-
ложенной между нагревательным элементом
и бумагой. Процесс испарения происходит,
минуя жидкую стадию, что породило назва-
ние сублимация. Из газообразного состояния
краситель осаждается на бумаге, взаимодей-
ствуя с волокнами на некоторую глубину. Цвет
формируется за счет смешивания трех про-
зрачных красителей (желтого, пурпурного и
голубого). Поэтому сублимационная печать
одинаково хорошо воспроизводит детали при
любой плотности цвета в исходном изображе-
нии, в том числе на самых светлых участках,
где пасуют растровые устройства.

Как такового, растра в этом виде печати нет.
Элементы изображения выстроены в строки
(наподобие телевизионных). Тон каждого пик-
села отображается с помощью смесевого тона
сплошного красителя. Поэтому изображение,
близкое к фотографическому качеству, печата-

Малоформатный сублимационный
принтер для домашнего применения
печатает фотографии «альбомного»
формата. Расходные материалы
включают специальную красящую
пленку (на снимке) и особую бумагу

ется с высокой деталировкой и цветовым диа-
пазоном свыше 16 миллионов оттенков.

Сублимационные принтеры отличаются
высокой скоростью работы и хорошим каче-
ством. Но для цифровой печати художествен-
ных фотографий они не получили широко-
го распространения, так как сделанные с их
помощью отпечатки считаются недостаточ-
но долговечными. Тем не менее, компактные
модели сублимационных принтеров для печати
снимков типового «альбомного» формата (как
правило, не более 13x18 см) широко представ-
лены на рынке.

Заметным недостатком сублимационной тех-
нологии печати является повышенный расход
материалов. Три листа пленки с красителями
расходуется на один лист бумаги. Обычно рас-
ходные материалы поставляются в комплекте:
красящая пленка плюс бумага.

При подготовке фотоснимка к печати на
сублимационном принтере всегда используй-
те профайл данной модели устройства. Чтобы
напечатать качественную картинку на таком
принтере, нужно выяснить его разрешение
и установить информационную плотность
изображения, равную разрешению принте-
ра. Сублимационные устройства отличают-
ся нестандартными значениями разрешения,
например 314 dpi Именно такое значение плот-
ности (314 ppi) надо задать в строке Resolution
диалогового окна Image Size (Image > Image Size)
при подготовке файла. Тогда каждый ряд пик-
селов будет точно совпадать с построчной раз-
верткой устройства сублимационной печати.

Изображение слева имеет плотность 300 ppi, справа — 314 ppi.
Распечатано на сублимационном принтере с разрешением 314 dpi
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Фотопечать

Владельцы цифровых фотоаппаратов, оби-
тающие на территории с развитой сетью

фотоуслуг, обычно решают проблему печати
снимков наиболее простым и традиционными
способом — идут в фотосалон. Жители мега-
полисов частенько вообще никуда не ходят, а
пересылают снимки в те же фотосалоны по
сети Интернет.

От подобного сервиса, предлагающего печать
цифровых снимков, требуется, в общем, немно-
го: обеспечить качество цветопередачи, пред-
ложить большой диапазон форматов (от мас-
совых до специальных, например панорамы),
приемлемые цены и доступность для посеще-
ния. Иногда имеет значение скорость выпол-
нения заказа.

Подчеркнем, что аппаратура фотосалона
должна быть профессиональной, то есть вам
нужна печать на цифровом минилабе химиче-
ским «мокрым» способом (экспозиция на фото-
бумагу), а не на струйном принтере, установ-
ленном за ширмой. Принципиальное отличие
цифрового минилаба от традиционного заклю-
чается в способе проецирования снимка на
фотобумагу. Обычно современный цифровой
минилаб (Noritsu, Agfa, Fuji, Konica и другие)
оснащен цветной лазерной системой экспони-
рования изображения.

Подготовить фотографии для печати в циф-
ровом минилабе довольно просто, если вы име-
ете ключевой элемент — профайл минилаба.
Обычно профайлы создают для конкретно-
го минилаба и конкретного типа бумаги. Они
не могут быть использованы для всех мини-
лабов данного типа. Применение такого про-
файла с другим минилабом или другим типом
бумаги может привести к катастрофическим
результатам.

Кстати, реакция работников фотосалона на
просьбу записать профайлы минилаба многое
скажет о качестве предоставляемых услуг.
Если ваша просьба не вызывает удивления,
с большой вероятностью ваши заказы будут
выполнены качественно. Если же вопрос о про-
файлах вгоняет работников салона в ступор,
лучше поискать другой салон.

При подготовке снимка к фотопечати не
забывайте установить плотность изображения,
равную разрешению лазерной системы мини-
лаба. Обычно это 300 ppi, но желательно уточ-
нить этот параметр в фотосалоне. Следующая
проблема, которую надо учесть, — автомати-
ческое кадрирование изображения программ-
ным обеспечением минилаба. На установках по
умолчанию идет небольшое масштабирование
оригинала до формата бумаги, что обычно при-
водит к обрезке кадра на 1-2 мм. Попросите опе-
ратора минилаба включить режим «No Resize».
Если это невозможно, увеличьте на 1 мм раз-
мер холста вокруг снимка в программе Adobe
Photoshop. Обязательно потребуйте при печати
ваших изображений отключить автоматиче-
скую коррекцию в минилабе. Например, для
минилабораторий Noritsu должны быть вклю-
чены параметры: «Digital Media Corrections
disabled» и «DSA/Judgment Image Correction
disabled».

Щ| Онлайн-сервис
Тем, кто имеет домашнее или рабочее

подключение к Интернету, в последние годы
стал доступен вариант печати снимков через
онлайн-сервисы. Оформить заказ и получить
отпечатки можно не выходя из дома. Плюсы
подобного онлайн-сервиса (если он опирается
на профессиональное оборудование) очевид-

и получишь 10 снимков
бесплатно!
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ны. Печать на спрофилированных устрой-
ствах обеспечивает максимально возможное
качество цветопередачи. Предлагается бога-
тый выбор форматов печати и материалов.
Сервис доступен отовсюду, где есть доступ к
Интернету. Готовый заказ курьер или почта-
льон доставят на дом.

Недостатки онлайн-сервиса, как обычно
бывает в жизни, являются продолжением досто-

инств. Например, для передачи файлов боль-
ших объемов желательно иметь широкополос-
ный доступ в Интернет. Как и в любом другом
онлайн-сервисе, доставка заказа и его оплата
являются самыми проблематичными этапа-
ми. Не везде и не всегда возможна доставка.
Число способов оплаты ограничено, а некото-
рые из них в российских условиях не вполне
безопасны.

— — - — — — - ^ — _ _ _ _ _ _ Подготовка файла

Цифровые устройства фотопечати используют
цветовое пространство RGB. Поэтому фотография
также должна иметь цветовой профиль RGB. Что
касается цветового охвата, то лучше использовать
абстрактное устройство Adobe RGB. Лишь на
последнем этапе работы происходит конверсия
цветового пространства фотографии в цветовой
охват устройства печати. Ни в коем случае не
редактируйте уже «профилированный» снимок.
Редактирование изображения с присвоенным про-
филем, описывающим устройство печати, приво-
дит к значительным искажениям.

J Копируем файл профиля на жесткий диск компью-
тера. При работе в системе Windows XP щелкаем
правой клавишей на файле ICC-профиля и в инте-
рактивном меню выбираем пункт Установить про-
филь. Операционная система скопирует файл в
нужную папку. При работе в Windows 98/ME копи-
руем профайл в папку Windows\System\Color.
Даем команду Image > Mode > Convert to Profile.
На панели Destination Space в раскрывающемся
списке Profile выбираем профайл минилаба, соот-
ветствующий избранному типу бумаги.

| На панели Conversion Option в раскрывающемся
списке Engine выбираем Adobe (АСЕ). В раскрыва-
ющемся списке Intent выбираем Perceptual.

Source Space
Profile: Adobe RGB (1998)

Destination Space
Profile: Nortt-RU-Mosc-StudProft-Mat.icc
Conversion Options

Engine: Adobe (ACE) v
Intent: Perceptual v
0U$e Sack Point Compensation
0Us® Other

для фотопечати —^

Устанавливаем флажок Use Black Point

Compensation. Щелчком на кнопке OK запуска-

ем преобразование.

Контролируем качество снимка методом экран-

ной цветопробы. Монитор должен быть откали-

брован!
: Даем команду View > Proof Setup > Custom.

В раскрывающемся списке Profile выбираем цве-
товой охват устройства (в нашем примере —
минилаб Noritsu одного из московских фотосало-
нов, бумага матовая). Флажок Preserve Color
Numbers должен быть снят!

Setup: Custom
Proffit: Norit'RU-Mosc-StudProft-Mat.lcc

•Prturvt Color Numbers
Intent: Perceptual

0U$t Шмк Point comptreatten
0P*per white

•=

В раскрывающемся списке Intent выбираем
Perceptual. Устанавливаем флажки Use Black
Point Compensation и Paper White.
Снятием и установкой флажка Preview сравнива-
ем исходное и профилированное изображения.
Если изменений при включении виртуальной цве-
топробы не видно — значит, все нормально. Если
изображение изменилось, придется вернуться к
этапу обработки и компенсировать искажения
коррекцией фотоснимка.

Сохраняем изображение в формате TIFF: 8-бит,
несжатый, без слоев и альфа-каналов.
Не встраивайте профайл в изображение!
Минилаб либо игнорирует эту информацию,
либо работает с ней неверно.
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Полиграфия

ВРоссии наступило капиталистическое
сегодня. Наконец никто и ничто не меша-

ет отдельным гражданам отпечатать в типо-
графии фотографию собственной любовницы
размером 3x4 метра и заклеить этим произ-
ведением фотоискусства все рекламные щиты
в Москве. Конечно, индивидуальному фото-
графу, не имеющему в своем огороде нефтяной
скважины, такой заказ не поднять. Но вполне
по средствам заказать офсетную печать своего
фотошедевра минимальным тиражом, скром-
ного размера 60x90 сантиметров.

Подготовка снимка к полиграфической
печати в основном сводится к выбору «твер-
дой копии» (бумага, ткань, пластик, керамика)
и сбору информации:
• особенности материала и их влияние на

параметры снимка;
• технология печати (офсетная, флексогра-

фия, шелкография, высокая печать или
другое);

• какова линиатура при растрировании изо-
бражений;

• можно ли использовать краски, отличные
от CMYK, и какой палитры;

• где взять профайл печатного станка;
• какова технология подготовки печатной

формы;
• каковы требования к формату файлов, и

другие условия, требующие согласования.
Ответы на эти вопросы во многом опреде-

ляют технологию подготовки изображения к
печати. Рассмотрим типичный пример печати
офсетным способом на плоскопечатном стан-
ке, в четыре краски, бумага мелованная, про-
файла устройства в данной типографии отро-
дясь не имели, поскольку привыкли работать
«на глазок».

§ Учет линиатуры
Первое, что надо согласовать — линиату-

ру растра. Полиграфическая печать высокого
качества начинается с линиатуры 133 Ipi. Для
работ художественного уровня желательно
применять линиатуру 150 Ipi. Отсюда выте-
кает требование к информационной плотности

оригинала — не менее 300 ppi. Но совсем нео-
бязательно, что в данной типографии печат-
ная машина способна обеспечить высокую
линиатуру.

Если точно известна линиатура, устанав-
ливайте плотность изображения кратно с мно-
жителем два. Например, линиатуре 133 Ipi
соответствует плотность 266 ppi.

Растрирование
С линиатурой тесно связан вопрос при-

меняемой технологии растрирования. В поли-
графии традиционно использовали амплитуд-
но-модулированный растр. Его легко узнать по
регулярной растровой розетке, заметной при
большом увеличении изображения.
• Растрирование — — — —

Цветовое колесо с регулярным растром, образующим розетку

• • • • • • • •
• • • • • • • »

Регулярный амплитудно-модулированный растр

Стохастический частотно-модулированный растр
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Для работ художественного уровня жела-
тельно использовать современные технологии,
в частности, стохастическое (частотно-моду-
лированное) растрирование. Оно дает замет-
ные качественные преимущества при печати
телесных тонов, в слабонасыщенных обла-
стях, на границах цветового охвата устрой-
ства печати.

Редактирование фотографии желатель-
но проводить в пространстве CIE Lab, вплоть
до момента полной готовности по всем худо-
жественно-техническим параметрам. Затем
начинается этап приведения изображения к
цветовому пространству CMYK. Сначала изобра-
жение переводят в пространство CMYK (Image
> Mode > CMYK Color). В этом режиме включа-
ют предупреждение о несоответствии оттенков
изображения цветовому охвату абстрактного
устройства CMYK (View > Gamut Warning). Если
такие участки обнаружены, следует поправить
оттенки с помощью средств Adobe Photoshop,
например Selective Colors или Color Balance.

Следующий этап — приведение цвета изоб-
ражения к цветовому охвату печатного стан-
ка. Если цветового профиля нет, рекомендуем
использовать абстрактное устройство Photoshop
Default CMYK. Если профайл есть, его выби-
рают в диалоговом окне Convert to Profile.

В завершение следует проверить плотность
тона в готовом изображении. Полиграфическое
оборудование способно воспроизвести тона
с плотностью от 3% до 97%. При этом сумма
красок CMYK не должна превышать 300%.
Проверить эти параметры можно с помощью
палитры Info в редакторе Adobe Photoshop.
Настраиваем палитру так, чтобы на одной
панели отображались параметры CMYK, a
на другой — интегрированный параметр К.
Проводим пипеткой в самых светлых оттен-

First Color Readout
Mode: CMYK Color

Second Color Readout
Mode: Grayscale

Mouse Coordinates
Ruler Units: Centimeters

• Show 16 bit values

f QK 1
Настройка палитры
Info для проверки
соответствия параметров
изображения
требованиям полиграфии

ках изображения, (но не белых!) и проверяем,
чтобы значение К не было меньше 3%. Затем
проводим пипеткой в самых темных областях
и проверяем, чтобы значение К не было боль-
ше 97%, а сумма значений CMYK не превыша-
ла 300%. Несоответствие легко устраняются в
диалоговом окне Levels.

На этом подготовительная работа прак-
тически заканчивается и начинается работа
типографии. В ответственных случаях при-
ходится проверять практически все этапы: с
какой линиатурой растрировали изображение,
правильную ли поставили бумагу, совпадает
ли цветопроба с тем, что вы ожидали увидеть,
совпадает ли тираж с цветопробой и вашими
представлениями.

Полиграфия — одна из самых консерватив-
ных отраслей, где сильны привычки, сохра-
нившиеся с советских времен. Поэтому либо
открывайте заказ в современной цифровой
типографии, либо контролируйте все этапы про-
цесса печати в типографии традиционной.

Самым надежным вариантом в смысле соблю-
дения качества является печать на цифровых
машинах (например, HP Indigo, Ruobi 3404DI,
Heidelberg NexPress), где вывод осуществляется
с компьютера на печатный цилиндр и с него на
бумагу. Или на системах Computer to Plate, где
вывод происходит на печатную форму. В этом
случае вы получите на оттиске практически
то же, что видите на экране компьютера.

Цифровая печатная машина HP Indigo Press 3500
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Универсальный документ PDF

На стыке технологий печати и электронной
публикации находятся универсальные

технологии, отвечающие и тем и другим требо-
ваниям. Практически повсеместным стандар-
том стала универсальная технология Portable
Document Format компании Adobe, обеспечи-
вающая подготовку документов для печати
(при различных требованиях к качеству) и
электронной публикации, сохраняя все необ-
ходимые данные в теле документа.

С позиции индивидуального фотографа
документы PDF удобны тем, что позволяют
готовить альбомы, презентации, контрольные
оттиски в универсальном формате, одинаково
пригодном для полиграфической печати, вывода
на любой принтер, записи на CD-ROM, публи-
кации в Интернете или на корпоративном сер-
вере, пересылки по сетям связи. Популярность
формата обеспечило и бесплатное распростра-
нение программы чтения PDF-файлов — Adobe
Acrobat Reader.

Основой технологии PDF является язык опи-
сания страниц PostScript, патент на который
также принадлежит Adobe. Этот язык давно

стал стандартом де-факто для устройств печати
профессионального уровня, включая струйные,
лазерные, сублимационные принтеры. Гибкость
и универсальность формата PostScript позво-
лила безболезненно использовать его для опи-
сания страниц не только печатных, но и элек-
тронных документов. Ведь с позиций системной
логики нет принципиальной разницы между
печатью на бумажной странице и электронной
«странице» монитора. В обоих случаях процесс
подготовки документа в основном одинаков и
различается лишь деталями, касающимися
особенностей устройств вывода.

Для работы с документами PDF в полном
объеме, включая создание и редактирование,
требуется установить программу Adobe Acrobat
Professional, которая имеет специальный обра-
ботчик PostScript-файлов — Adobe Acrobat
Distiller, а также средства интеграции продук-
та с популярными приложениями (например,
Microsoft Office). Собственные приложения ком-
пании Adobe (Photoshop, Illustrator, InDesign)
работают с форматом PDF напрямую.

Подготовка документа PDF

Создание
документа Интеграция с Создание

Adobe Acrobat PostScript
Создание

файла PDF

U\ <7

Вывод на принтер

В1

Полиграфия

Версия для печати

Интернет

Электронная версия

Архивы, презентации

1 3 8



Создание PDF для полиграфии

Полиграфия предъявляет высокие требования к
оригиналам документов в целом и фотографий в
частности. Если планируется полиграфическая
печать только фотографии (без дополнительных
элементов оформления), смысла прибегать к фор-
мату PDF нет. Но если документ содержит и фото-
снимки, и элементы оформления (текст, вектор-
ные и растровые графические объекты), то
фотографу лучше взять в свои руки подготовку
документа в целом. В конечном итоге надо полу-
чить PDF-файл, полностью отвечающий полигра-
фическим требованиям. Профессионалы предпо-
читают использовать для верстки и вывода
профессиональные программы, например Adobe
InDesign. Индивидуальному фотографу предпо-
чтительней использовать более простые и удоб-
ные программы. Мы рассмотрим пример создания
плаката формата А1 в программе Corel Draw.
Конечной целью работы является получение PDF-
файла, готового к цветоделению на фотоавтомате
или непосредственно в цифровой печатной маши-
не. Подразумевается, что на компьютере установ-
лены программы: CorelDraw версии не ниже 12,
Adobe Acrobat Professional версии не ниже 6.
В программе CorelDraw создаем новый документ
формата А1 (Layout >> Page Setup ^ Paper >
А1). Командой File > Import размещаем на листе
фотографии, заранее подготовленные в програм-
ме Adobe Photoshop для полиграфической печати.
Размещаем на листе остальные элементы оформ-
ления (текст, графика) в соответствии с замыслом
публикации.

Даем команду File > Publish to PDF. В открыв-
шемся окне задаем имя файла. В раскрывающем-
ся списке PDF Style выбираем PDF for Prepress.
Для установки параметров PDF щелкаем на кноп-
ке Setting.
В окне Publish to PDF на вкладке General при
необходимости заполняем поля Author и Keywords
(Ключевые слова). В раскрывающемся списке
выбираем формат Acrobat 4.O.
На вкладке Objects на панели Bitmap compressi-
on в раскрывающемся списке Compression Type
выбираем метод сжатия LZW. На панели Text and
Fonts обязательно ставим флажок Export all text
as curves. На панели Bitmap downsampling сни-

маем все флажки. На панели Encoding устанав-
ливаем переключатель Binary.

General Objects Document Prepress
Bitmap compression
Compression type LZW v

Bitmap downsampiing
• Color
• Grayscale

•Monochrome

Advanced $? No Issues
Text and fonts
[y*l Export «ill text as curves

•Compress text and line art
Encoding
О ASCII И ф Binary

CJ

На панели Document снимаем все флажки и уста-
навливаем переключатель Page Only.
На панели Prepress устанавливаем флажок
Include Bleed и в поле со счетчиком ставим зна-
чение 1,5 мм. Устанавливаем флажки Crop
Marks, Registration Marks, Densitometer Scale,
чтобы полиграфисты имели на форме обрезные
и другие служебные метки.

General Objects Document Prepress Advanced Щ> No Issues

0Include Bleed: 1,5 mm *

Printer's marks

0 C r o p marks @Regtetration marks

• F i l e information @Densltometer scales

На панели Advanced ставим флажки Preserve
Document Overprint, Apply ICC Profile (если про-
филь печатной машины был использован при
подготовке фотографий). Выбираем переключа-
тель Separations printers profile. Обязательно
снимаем флажок Optimize for Web.

General Objects Document Prepress Advanced ф No Issues

01nciucte Bleed: 1,5 mm A.

| Printer's marks

: @Orop marks 0 Registration marks

I О File information 0Densitometer scales

Завершаем работу сохранением файла.
Полученный документ PDF показан на следую-
щей странице.
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Электронная презентация

Сохранение отдельного фотоснимка в формате

PDF не имеет смысла: для печати лучше исполь-

зовать форматы PSD или TIFF, для публикации в

электронном виде — форматы JPEG или PNG. Но

если речь заходит о представлении коллекции

фотографий, формат PDF сразу получает преиму-

щество. Во-первых, вся коллекция содержится в

одном документе. Во-вторых, такой документ

можно увидеть практически на любом электрон-

ном устройстве, понимающем формат (а это и

настольные компьютеры, и карманные ПК, и даже

игровые приставки). Наконец, в программе Adobe

Photoshop процесс создания электронной презен-

тации коллекции фотографий в формате PDF

автоматизирован и требует от пользователя мини-

мальных усилий.

В программе Adobe Photoshop командой File ^

Automate > PDF Presentation открываем окно

управления параметрами презентации.

Output Options
Save as: С') Multi-Page Document (#) Presentation

jvjview PDF after Saving

Presentation Options

[>•] advance Every 5 Seconds

•Loop after Last Page

Transition: Random Transition v

Щелчком на кнопке Browse открываем окно про-

водника и стандартными методами выбираем

файлы фотографий, которые надо разместить в

документе.

j На панели Output Options устанавливаем пере-

ключатель Presentation и флажок View PDF after

saving (для немедленного просмотра).

На панели Presentation Options устанавливаем

флажок Advance Every, а в символьном поле

задаем время демонстрации фотографий (в се-

кундах).

В раскрывающемся списке Transition (Переход)

выбираем эффект, используемый при смене фото-

графий во время презентации (можно задейство-

вать несколько вариантов).

При необходимости ставим флажок Loop after

Last Page (Повторить презентацию после пока-

за последней страницы). Щелчком на кнопке

Save сохраняем презентацию.

В окне PDF Options устанавливаем параметры

записи документа PDF. Важно выбрать оптималь-

ные настройки качества на панели Encoding. Чем

выше качество, выставляемое движком Quality,

тем больше размер итогового документа. Для

демонстрации каждого снимка по размеру экрана

желательно установить флажок Interpolation.

jv*] Image Interpolation
•Downgrade Color Profile
• PDF Security

• include Vector Data

По завершении работы автоматически запускает-

ся презентация. Переход в обычный режим выпол-

няем нажатием клавиши ESC. Документ будет

представлен в обычном режиме, если установить

переключатель Multi-Page Document.
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Особенности публикации в Интернет

Публикация своих фотографий во всемир-
ной сети требует выполнения некоторых

подготовительных операций, связанных с осо-
быми требованиями среды Интернет. Первое
требование касается цветового пространства.
Многообразие устройств отображения, облада-
ющих разными возможностями цветопередачи,
обусловливает применение единого стандар-
та sRGB. Способы приведения изображений
к цветовому охвату абстрактных устройств
(к которым относится sRGB) рассматривались
нами ранее.

Второе требование относится к размеру
файлов. Пока среди посетителей Интернета
обладатели широкополосного доступа состав-
ляют меньшинство. Большинство довольству-
ется каналами с пропускной способностью
несколько десятков килобит в секунду. Поэтому
мало кто будет дожидаться загрузки снимков
«весом» в сотни килобайт. Оптимальный раз-

мер файлов — до 50 Кбайт. Если планируется
предоставить доступ к оригиналам объемом
несколько мегабайт, следует разместить их
на сервере FTP.

Публиковать свои произведения в Интернете
можно разными способами:
• на сайтах, специально предназначенных

для публикации фотографий, пересылая
снимки по электронной почте или с помо-
щью форм, предлагаемых на сайте;

• на собственном сайте, вручную размещая
снимки при помощи HTML-редактора;

• на собственном или постороннем сайте,
создав фотогалерею с помощью специаль-
ных средств.
Последний способ — самый удобный для

людей, не обладающих навыками работы с
HTML-редакторами. Например, программа
Adobe Photoshop обладает встроенным сред-
ством создания Web-галереи.

Создание фотогалереи WEB

Создаем папку, в которой размещаем публикуе-
мые снимки. В программе Adobe Photoshop пере-
водим фотографии в цветовой охват sRGB коман-
дой Image > Mode > Convert to Profile.
Командой File > Automate > Web Photo Gallery
открываем окно настроек параметров публика-
ции.

В раскрывающемся списке Styles выбираем стиль
публикации (способ представления). В окне пред-
варительного просмотра демонстрируется обра-
зец стиля.

На панели Source Images выбираем папку
(Use: Folder) с изображениями. После щелчка
на кнопке Destination выбираем папку для раз-
мещения фотогалереи.

На панели Options последовательно настраи-
ваем параметры публикации. Важнейшим явля-
ется параметр Large Images, определяющий
способы преобразования изображений.

И И Я ЯВИ HHSCФайл Праш Вид И£р«ннм Группы Параметры Ospet* Окно Справка
-•••• *) шш\{тт1гудт!гт • Q • • © »1 & Ш > а

New Photo

New Hwto Callerv

mtec.ru
, fuWv.mta.ru

r rZJ

|ВЕГМ"! IBewejwjjsjpt
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Подготовка изображений
Коротко о преимуществах и недостатках

основных форматов растровой графики для
публикаций в Интернет. Формат JPEG поддер-
живается практически всеми графическими
редакторами и браузерами. В нем использует-
ся алгоритм сжатия, основанный на вычисле-
нии изменений цвета в ячейках 8x8 пикселов.
Вместо действительных значений вычисляет-
ся «скорость» изменения цвета от пиксела к
пикселу Лишняя информация отбрасывается,
остальные значения усредняются.
Формат GIF менее других подходит для публи-
кации полноцветных изображений, поскольку

поддерживает палитру 256 цветов. В формате
применяются алгоритмы сжатия без потерь.
Оптимизация сводится к подбору количества
цветов методом клиширования (dithering). Если
палитра имеет синие и желтые цвета, а надо
получить отсутствующий зеленый, его получа-
ют чередованием синих и желтых пикселов.

Формат PNG разработан в качестве альтер-
нативы формату GIF. В формате используется
алгоритм сжатия без потерь. Для публикации
изображений фотографического качества сле-
дует использовать вариант PJVG-24. Недостатком
формата является большой размер конечного
файла.

Сохранение изображений для WEB

В программе Adobe Photoshop открываем изоб-
ражение и даем команду Image > Image Size.
Задаем размер снимка и плотность 72 ppi.
Командой File > Save for Web открываем окно
настройки параметров публикации, переходим на
вкладку 4-Up.

Выбираем последовательно для образцов изо-
бражений форматы JPEG, PNG, GIF.

4 Для форматов выбираем нужный стиль в списке
Preset

3 Сравниваем качество изображений различных
форматов, оцениваем размер файлов и время
загрузки при различной пропускной способности
канала доступа к Интернет. Выбираем оптималь-
ный вариант и щелчком на кнопке Save сохраня-
ем файл.
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Авторы, редакция и издательство выражают признательность
за любезное разрешение на публикацию фотографий

Андрееву Анатолию Викторовичу
(Великий Новгород):

«Храм» (с. 12), «Деревянное зодчество» (с. 56),

«Разлив» (с. 101), «Свет и тени» (с. 117).

Рыбакову Ивану Викторовичу (Саратов):
«Подмосковье» (с. 25), «Весна» (с. 26),

«Увернулась...» (с. 27), «Настя» (с. 52),

«Тропа» (с. 101), «Москва зимой» (с. 121).

Стрельцову Сергею Андреевичу (Москва):
«Цветы» (с. 17), «Коломенское» (с. 57, 58),

«Роська» (с. 78), «Красное» (с. 92).

Строгановой Екатерине Вячеславовне
(Санкт-Петербург):

«Соловецкий берег» (с. 15),

«Заповедная зона» (с. 54).

Выражаем особую благодарность Егору Шарову за фотографию, использованную
в оформлении обложки

ФОТО «ДЕРЕВО ДЕТСТВА», помещенное

на обложке этой книги, не случайно названо
в честь повести замечательного писателя Фазиля
Искандера. На нем запечатлено мгновение из
жизни иракских мальчишек-беженцев летом 2004
года в парке на окраине маленького городка,
затерянного на бескрайних Великих Равнинах США.
В это лето жизнь, судьба, война отняли у них многое
практически все, но не сумели отна 1

детского счастья и этого
отблесках заходи
враждебной ст

чишках, прыгающих через лу;
отношениях человека с миром? Как в повестях Искандера и Шук-
шина, песнях Окуджавы и Визбора, фильмах Шварца и Рязанова - так
и в фотографии как искусстве зритель может толковать значение каждого
нюанса по-своему, как если бы фотография была повествованием не о ч
конкретном, но о многом или сразу обо всем. Это з нами тщнИИЙИИ
объем, движение - то есть жизнь.

Цифровую фотографию ценят чаще всего за удобство, за скорость, за коммерческую ц стъ, упуская,
по-моему, самое главное ее достоинство... Цифровая фотография дает возможность запечатлеть свою жизнь, свою душу,
свое художественное видение мира огромному числу людей, имевших до этого практическую возможность снимать
лишь одноразовыми «мыльницами». Это неоценимо почти так же, как печатный станок для развития литературы, или,
если хотите, как магнитная лента для распространения бардовской песни.

Пусть эта полезнейшая книга поможет развитию вашего взгляда на действительность и приобщению к прекрасному
миру Фотографии.

Удачи вам и успехов!
Егор Шаров

От редакции:

Мастер современной цифровой фотографии Егор Шаров (Георгий Бурба) получил международное
признание благодаря публикациям своих работ в журналах «Вокруг света», «Nebraska Life», «Экспедиция»,
«Hooked on the Outdoors», «Nebraskaland», «Omaha World Herald», «Apogee», «Сто дорог», книгах «Traveling
Western Nebraska», «Тайны разума», «American Meteorological Society», фотоальбомах «America 24/7»,
«Лучшее Международной Фотобиблиотеки: 2003», «Guide to Eastern Nebraska», «Образы души»,
«Путешествие». Его фото помещены на обложках музыкальных альбомов в Европе и программных пакетов
в Силиконовой Долине, в национальных музеях и частных галереях разных стран, на открытках и выставках.

Связаться с Егором Шаровым (Георгий Бурба) м о ж н о по адресу: georgeburba@gburba.com,

а ближе познакомиться с работами — на сайте www.gburba.com


